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Chapter 1: Overview

LeCroy’s SASSuite expert application software package provides a powerful and flexible
means for recording, decoding and displaying communications traffic on SAS and SATA
links. The SASSuite application supports the following major products to assist
engineers in designing, developing and validating SAS- and SATA-based products.

+ The Avalanche Protocol Analyzer allows users to record and display all communica-
tions traffic on SAS or SATA links at data rates of 1.5, 3 and 6 Gb/s. As with all
LeCroy analyzers, hardware-based pre-capture filtering is supported for efficient
memory management. The system provides full decoding of STP traffic moving
between SAS expanders and SAS initiators. Full SATA-II analysis support is
included for users interested in using Avalanche to test Serial ATA environments
(1.5, 3 or 6 Gb/s).

* The SASTracer Protocol Analyzer allows users to record and display all communi-
cations traffic on SAS or SATA links at data rates of 1.5 and 3 Gb/s. Full SATA-II
analysis support is included for users interested in using SAS Tracer to test Serial
ATA environments (1.5 or 3 Gbps). An important option for the SAS Tracer Analyzer
is the SASTracker Command Analyzer option. SAS Tracker monitors commands
issued over SAS or SATA networks to track all commands, measure execution time,
identify slow commands or commands that fail to complete, and optimize overall
system performance.

» The SASTrainer Exerciser is a traffic generation system that can initiate SAS or
SATA traffic (emulating either an initiator or target device) for testing of SAS/SATA
designs and products. The system can be programmed to transmit valid and invalid
SAS or SATA traffic. It can send specific 10 operations or customized data payloads.
The exerciser can “play-back” any previously recorded trace as a stimulus file and
also offers a text-based API for creating scripts from the ground up.

These products, used either separately or in combination, provide fast, efficient and
accurate debug, test and verification of Serial Attached SCSI semiconductors, devices
and systems. They allows designers and validation engineers to quickly and easily
transmit valid and invalid SAS or SATA traffic, selectively record the exchange and
display the results using the SAS Suite expert analysis software. The SASSuite software
supports all LeCroy SAS and SATA products, allowing this all-in-one test platform to play
an important role at every phase of the SAS product development process.

The Avalanche protocol analyzer uses LeCroy’s newest and most advanced hardware
platform, providing support for all SAS and SATA data rates up to 6 Gb/s.

The SASTracer and SASTrainer systems operate on a common modular hardware
design, based on the LeCroy CATC 10K chassis. The different product functions are
supported by hardware modules which plug into the chassis, by LeCroy’s unique
BusEngine firmware cores, and by the SASSuite Application Software.

The heart of the LeCroy SAS platform is the revolutionary LeCroy BusEngine™. This
state-of-the-art, field-upgradeable, technology core incorporates a real-time
non-intrusive recording engine and configurable tools to trigger and filter SAS and SATA
traffic. It can intelligently monitor SAS and SATA frame headers and addresses, and start
or stop recording based on user-defined events.
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The modular LeCroy SAS products allow users to expand and upgrade systems as their
needs change. Adding new modules, or adding new BusEngines to existing modules,
can economically expand the system capabilities while maintaining a common software
interface through the integrated SASSuite Application Software.

For complete product information, please visit www.LeCroy.com.

Please refer to the Serial Attached Specification for details on the Serial Attached SCSI
protocol. The Serial Attached SCSI specification is available at the web site www.t10.0rg.

Avalanche System SAS Tracer/ Trainer System

General Description

The LeCroy SAS analyzer systems are intended to operate while inserted in the data path
between SAS or SATA initiators and targets, non-intrusively passing all data traffic while
capturing and recording the traffic of interest to the user.

The analyzer, in turn, connects to a PC over a high-speed USB cable. The PC functions
as the host controller for the analyzer. SASSuite software on the PC controls and
configures the products and retrieves and displays recorded data.

The SASSuite trace viewing software runs on any personal computer using the Windows
98SE, Window 2000, Windows ME, or Windows XP operating systems and equipped
with a functional USB interface.

The CATC 10K chassis supports up to two plug-in modules that can support tracing,
traffic generation and/or command analysis. The common hardware design allows users
to obtain muliple functions at economical prices, and to upgrade existing systems to new
functions by adding the appropriate modules, BusEngines or software licenses.
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Serial Attached SCSI Trace
Universal Serial Bus

(Host Connection) I
Windows PC (Host Computer)

AC Power
Analyzer Module

Non-Intrusive
Taps

(Under Analysis)

The protocol analyzer is capable of on-the-fly detection of and triggering on such events
as Primitives, Bus Conditions, SSP and SMP Frames, Data Patterns, and Errors.
Whether recording manually or with a specified trigger condition, the analyzer
continuously records the link data in a wrap-around fashion until manually stopped or until
the Trigger Event is detected and a specified post-Trigger amount of link data is recorded.

Upon detection of a triggering event, the analyzer continues to record data up to a point
specified by the user. Real-time detection of events can be individually enabled or
disabled to allow triggering on events as they happen. This includes predefined exception
or error conditions and a user-defined set of trigger events.

Recorded data is presented as a "trace" in the trace viewer as rows of color-coded
graphics. Users can then search this trace for errors and other events using advanced
search utilities, and then hide from the display all but only the most interesting and
relevant data.

The SASSuite software provides powerful search functions that enable investigation and
highlighting of specific events. In addition to immediate analysis, you can print any part
of the data. Use the Save As feature to save the data on disk for later viewing. The
program also provides a variety of timing information and data analysis reports.

LeCroy Corporation
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Avalanche Features

» High-Performance Protocol Analyzer System

+ Available with one, two or four analysis ports, each supporting 1.5 Gb/s, 3.0
Gb/s and 6.0 Gb/s data rates

*  SAS and Serial ATA Recording at 1.5, 3.0 or 6.0 Gb/s
« Sophisticated Triggering

* Hardware Filtering

+ DWORD Display

+ External 4-lane MiniSAS Connectors

» Traffic Summaries

*  Collapsible / Expandable Headers

+ Automatic Decoding at Transport Layer; SCSI, ATA and Management
Application Layers

* Field Upgradeable BusEngine Technology

*  Dynamically Allocated Memory Pool (4 GB)

* 13-month Hardware Warranty

* All-in-one platform transmits, records, and analyzes SAS protocols

*  Monitor, trigger and record up to 4 Serial Attached SCSI links simultaneously
* Isolate areas of interest with real-time hardware triggering

* Extend capture window and data by removing non-essential primitives

« Chronologically display all DWORDs on all channels synchronized to a
common clock

* Flexible platform for testing host and end-device behavior

* Automatically bring SAS device under test through power up / reset and
speed negotiation sequence

»  Statistical reports provide high level abstraction of events, operations, errors
and throughput for each |_T_L Nexus

+ Easy “drill-down” on field structures for individual Frames, Commands and
Tasks

* View high-level Serial Attached SCSI protocol events
« Easily upgrade firmware to support new features
*  Protect your investment with industry-leading warranty

4 LeCroy Corporation
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SASTracerl/Trainer Features

* Integrated Analyzer, Generator and Command Analyzer System

* Available with One, Two or Four 1.5 or 3.0 Gbps SAS analysis ports
»  SAS and Serial ATA Recording at 1.5 or 3.0 Gbps

« Sophisticated Triggering

* Hardware Filtering

+ DWORD Display

* Internal Single-lane or External 4-lane Connector Option

» Exerciser offers Initiator and Target Emulation

»  Exerciser automatically responds to incoming OOB

+  Command Analyzer tracks all commands issued in SAS matrix of up to 8
initiators and 128 targets

*  Traffic Summaries
» Collapsible / Expandable Headers

» Automatic Decoding at Transport Layer; SCSI, ATA and Management
Application Layers

* Field Upgradeable BusEngine Technology

*  Dynamically Allocated Memory Pool (2 GB)

* 13-month Hardware Warranty

* All-in-one platform transmits, records, and analyzes SAS protocols

* Monitor, trigger and record up to 4 Serial Attached SCSI links simultaneously
* Isolate areas of interest with real-time hardware triggering

+ Extend capture window and data by removing non-essential primitives

»  Chronologically display all DWORDs on all channels synchronized to a
common clock

* Flexible platform for testing host and end-device behavior

»  Automatically bring SAS device under test through power up / reset and
speed negotiation sequence

« Statistical reports provide high level abstraction of events, operations, errors
and throughput for each |_T_L Nexus

» Easy “drill-down” on field structures for individual Frames, Commands and
Tasks

* View high-level Serial Attached SCSI protocol events
+ Easily upgrade firmware to support new features
*  Protect your investment with industry-leading warranty

LeCroy Corporation 5
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LeCroy BusEngine

LeCroy’s BusEngine™ Technology is at the heart of the SAS Product Line. The
revolutionary BusEngine core uses FPGA technology and incorporates both the real-time
recording engine and the configurable building blocks that implement data/state/error
detection, triggering, external signal monitoring, and event counting and sequencing.
Like the flash-memory-based firmware that controls its operation, all BusEngine logic is
fully field upgradeable, using configuration files that can be downloaded from the LeCroy
Website.

Connection to Host PC System

The Avalanche and the SASTracer/Trainer are USB 2.0 Certified Hi-Speed Devices. To
upload traces from the analyzer to an attached PC at Hi-Speed, the PC must have a USB
2.0 Certified Host Controller and be running Windows 2000 SP3 or Windows XP.

Note: The analyzer products include 2.0 USB hubs. You might see the
drivers for these generic hubs being installed upon the initial plug-in.

LeCroy Corporation
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Chapter 2: Installation

This chapter describes how to set up the SAS Analyzer and create your first recording.

System Components

* One stand-alone SAS/SATA Analyzer system

*  One USB cable

*  SASSuite software program CD-ROM

*  SATA(SAS) cables approriate to analyzer system and devices under test
*  Breakout board

Note: Specific components included with the analyzer system vary based
on model and configuration ordered.

Warning! Do not open the analyzer enclosure. There are no user serviceable parts
inside. Refer servicing to LeCroy.

Analyzer PC Requirements

The SAS Analyzer connects to a Host PC via USB line.

Please consult the readme file on the installation CD for the latest PC requirements.

Analyzer Hardware Description

Avalanche The LeCroy Avalanche system is a compact package that provides ports on the front to

System connect to SAS or SATA initiators and targets, and rear connections including power and
USB (to host PC). The front panel also contains arrays of indicator LEDs, both for the
status of the four initiators and four targets, and also for the analyzer functions.

The SAS/SATA ports are "MiniSAS" connectors that can use either MiniSAS-to-MiniSAS
cables or can use an "octopus" cable that breaks out the MiniSAS connector to individual
device connectors. Up to four links are supported between targets and initiators.

LeCroy Corporation 7



Version 6.25

SASSuite User Manual

Avalanche LED Descriptions
The Status and Speed LEDs indicate the status of each link, as follows:
* The STATUS LED is green when receiving a frame, red when errors are

found, and mixed color (1/2 green, 1/2 red) during OOB. Otherwise, the LED
is off.

* The SPEED LED is green for 6Gb/s traffic, mixed color (1/2 green, 1/2 yellow)
for 3 Gb/s traffic, and yellow for 1.5 Gb/s traffic (or off if no traffic is detected
on that link)

The System LEDs indicate the status of the protocol analyzer, as follows:

¢ The TRIG/ERR RIGHT LED is green if the system is triggered, red if either
Link 1 or Link 2 have a system error; and off otherwise.

¢ The REC/UPLOAD RIGHT LED is red if either Link 1 or 2 is recording, green
if either Link1 or Link 2 are uploading, and off otherwise.

The TRIG/ERR LEFT LED is green if the system is triggered, red if either Link
3 or Link 4 have a system error, and off otherwise.

* The REC/UPLOAD LEFT LED is red if either Link 3 or Link 4 is recording,
green if either Link 3 or Link 4 are uploading, and off otherwise.

Note: Inthe descriptions above, "Link 1" refers to the link between Initiator
1(11)and Target 1 (T1), "Link 2" refers to the link between 12 and T2,
etc. The designation "Left" or "Right" is used since the Avalanche
system includes dual BusEngines, one of which (right side)
processes traffic from Link 1 and Link 2, while the other (left side)
processes traffic from Link 3 and Link 4.

Avalanche Rear Panel Connectors
The rear panel of the Avalanche System provides the following connectors:

* POWER IN (to be supplied using the Adapter provided with the Avalanche
System)

* USB (to provide a connection to the host PC system running the SASSuite
application software)

¢ DATA IN/OUT (This connector links a 25 pin RS-232 cable to an external
breakout board. The breakout board allows signals to be sent from the
analyzer to an external device such as an oscilloscope or from an external
device to the analyzer for the purpose of triggering on an external input. You
configure input/output signalling through the Recording Options dialog box.
Breakout board use is described at the end of this chapter.)

¢ SYNC OUT and SYNC IN (provides the capability to link up to 8 Avalanche
Systems together to form a single system supporting up to 32
time-synchronized links)

e EXT OUT and EXT IN (SMA connectors which provide signal connections to
the Avalanche system from an external device, or to cause the Avalanche
system to signal an external device)
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SASTracerl LeCroy’s SASTracer/Trainer System is based on the CATC 10K (or "UPAS 10K")

Trainer platform. Plug-in modules for SAS are available with either the Internal SATA style cable

System connector (SS002MAA-X & SS003MAA-X) or the External "Infiniband style" connectors
(SS004MAA-X) below.

SASTracer Analyzer Systems

univensal Protocol Analyzer System 3 g odkl [0
12Croy wooeL ssoous SASTrcen SATrcer
RRCIOV P 50 e
R e (e R s el L

[ Universal Protocol Analyzer Syslem 3 Model 10000
[ SATA An

Module Part # SS002MAA-X & SS003MAA-X Module Part # SS004MAA-X

SASTracer/Trainer Analyzer LED Descriptions
When powered on, the SAS Analyzer activates the user-accessible controls and LEDs
on the front and rear panels of the CATC 10K.

Front Panel (Internal single lane connector - SS002MAA & SS003MAA-X)

Unlversal Pr-olocol Analyzer System SRR S I T e e
\ A 7% MODELSASO0IMA SAS / SATA Analyzer cAaAT MODEL SASO0IMA  SAS / SATA Analyzer

\/
1 1
—~ A 7 INITIATOR  TARGET INITIATOR  TARGET INITIATOR  TARGET INITIATOR  TARGET
SR = = = (SN S —
¥ A L
Q 4

[a] [b] [e] [d] [e] 1 [al [l
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Front Panel LEDs (from left to right)
A PWR (power) - Green indicator LED for CATC 10K. Lights when the unit
power is switched on.

B Status indicator - Red indicator LED for CATC 10K. Lights during
initialization/power up of CATC 10K base unit. Blinks if a self-test fails.

REC (recording) - Green LED. Lights when the unit is recording.
TRG (triggered) - Orange LED. Lights when the unit triggers on an event.

E UPLD (Upload) - Green LED. Lights when trace is being uploaded from the
analyzer to the PC.

F Manual Trigger - Push-button. Allows a manual Trace capture.

G 1-4(Link Channels 1 -4) - Green LEDs. Lights when a connection is
established on the corresponding link. Blinks during OOB or when only one of
the two connected devices is transmitting.

OO0

Connectors on the SASTracer Analyzer Module
*  Plug-in Modules SS002MAA-X & SS003MAA-X use single-lane Serial ATA
Connectors (4).

*  Plug-in Module SS004MAA-X use 4 port Infiniband style connectors (1).

SASTracerlTrainer Rear Panel Description
From left to right, the CATC 10K rear panel contains the following components:

£= 2.5A 250V

Computer Access Technology Corporation /\ www.cat-.com

DATA IN/ OUT EXTIN EXT OUT

., | oo I

USB type “B” host computer connector

This connector links the analyzer to the Host PC. for the purpose of transmitting
commands from the PC to the analyzer and uploading traces from the analyzer’s
recording memory to the SASSuite software for viewing and analysis.

RS-232 25 pin "Data Output” Connector

This connector links a 25 pin RS-232 cable to an external breakout board. The breakout
board allows signals to be sent from the analyzer to an external device such as an
oscilloscope or from an external device to the analyzer for the purpose of triggering on
an external input. You configure input/output signalling through the Recording Options
dialog box. Breakout board use is described at the end of this chapter.

10 LeCroy Corporation
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BNC Connectors "Ext. In" and "Ext. Out"

These connectors allow BNC cables to be attached to the analyzer for the purpose of
triggering on external input signals or for sending an output signal from the analyzer to
another device. These connectors have the same function as the 25 pin RS-232
connector - i.e., they channel input and output signals but do not support the use of a
breakout board.

Wide range AC connector module
— Power socket
— Power on/off switch
— Enclosed 5x20 mm 2.0A 250 V fast acting glass fuse

Warning! For continued protection against fire, replace fuse only with the type and
rating specified above.

11
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Setting Up the Analyzer

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Remove the analyzer from its shipping container.

Connect the analyzer unit to a source of compatible AC power
using the provided power cord (and, for Avalanche, the provided
external power supply).

Note: The analyzer is capable of supporting supply voltages
between 100-volt and 240-volt, 50 Hz or 60 Hz, thus
supporting all known supply voltages around the world.

Turn on the power switch (on the front of the Avalanche or on the
rear of the CATC 10K).

Note: At power-on, the analyzer initializes itself in approximately
ten seconds and performs an exhaustive self-diagnostic
that lasts about five seconds. If the diagnostics fail, call
LeCroy Customer Support for assistance.

Insert the CD into the CD ROM drive of the PC that will be
controlling the analyzer.

Connect the USB cable between the USB port on the back of the
analyzer and a USB port on the PC.

The operating system detects the analyzer and begins to install the USB
driver.

Follow Windows on-screen Plug-and-Play instructions for the
automatic installation of the analyzer as a USB device on the
Host PC (the required USB files are included on the SASSuite
CD). Step through the Windows hardware wizard. The wizard
will see that the analyzer has an internal USB hub and will begin
loading hub drivers. Afterwards, the wizard will automatically
install the system as a USB device on the PC. When the wizard
prompts you for driver information, point it to the CD which
should be in your disk drive and install the following files

* For Avalanche systems, install Avalnche.sys and CTCDragn.sys

* For SASTracer systems, install CATCupa.sys and SasTracer.sys.

12
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Connecting SAS/SATA Devices to the Analyzer

Avalanche
Connectors

SASTracer
Connectors

Depending on the model of your analyzer, you will have different SAS/SATA connectors
on the front panel, as follows:

* Avalanche systems provide MiniSAS connectors.

* SASTracer systems provide either SATA-style connectors or Infiniband
connectors, depending on the module installed in your SAS Tracer.

Avalanche systems provide MiniSAS connectors, each of which can be connected to up
to four devices. Devices can be connected using either MiniSAS-to-MiniSAS cables, or
using "octopus" cables, which provide connections from one MiniSAS connector to up to
four SATA-style connectors.

Depending on the module installed in your SASTracer chassis, you will have either
SATA-style connectors or Infiniband connectors..

Model SS004MAA-X incorporates the SAS external "Infiniband style" connector which
includes both a non-intrusive as well as a repeater style front-end. This allows users to
selectively switch between these two probing techniques based on their specific
application. Only one pair of connectors may be used at a time.

Note: Users with model SS004MAA-X must switch between "repeater”
and "non-intrusive" using the SASSuite software. Go to Setup >
Probe Control to enable "repeater” or "non-intrusive" mode.

Non-intrusive Repeater

SASTracer/ SATracer

REPEATER

LeCroy Corporation
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Non-intrusive

Tap

Also known as passive tapping, this approach silently samples the signal without
re-driving the differential lines (high value resistors contribute to reduction in amplitude

~15%).
Analyzer Conditioning
Circuitry
440% 2440
kY
I')
Initistar Target

Repeater Tap

In repeater mode, the analyzer reproduces the exact patterns it receives on the inbound
(RX) line. While the repeater does not re-time the signal—it does "clean-up" normal
reflections that can occur over a full length cable when the analyzer is not in the line.

Aralyzer Conditioning
Circuitry

Btive

Repester

Initiatar

Target

14
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When using the External Connector Module (SS004MAA) to probe between devices that
utilize single lane SATA connectors, the special octopus cable must be used. The SATA
side of the octopus cables would be attached to the devices under test.

Note: The initiator side must be a "cross-over" cable.

Note: When using new External Connector Module (SS004MAA) with
standard 4X External InfiniBand style cables, there is no need to use
"cross-over" cable. Both cables above are straight.

LeCroy Corporation 15
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SASTracer Analyzer with Internal SATA Connectors (SS002MAA &
SS003MAA)

When using the original single-lane "SATA-style" module (SS002MAA & SS003MAA)
with devices that utilize single-lane SATA style connectors, the standard SATA-style
single-lane connector cables must be used.

Test Setup With DUT Requiring External 4 Lane Connector

Intitiator
4X External .

Single-lane Tracer Plug-in

Target
4X External .

Single-lane Tracer Plug-in

Target cable 1
is cross-over

Note: The target side must be a "cross-over" cable.
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Installing the SASSuite Software

Once the SAS Analyzer has been recognized as a USB device, install the SASSuite
software on the Host PC.

Step 1 On the PC, run setup on the installation CD and follow the
on-screen instructions.

The SASSuite software will install on the PC hard disk.

Step 2 To start the application, launch the LeCroy SASSuite program
from the Start menu:
Start > Programs > LeCroy > LeCroy SASSuite.

The SASSuite program opens.

Fle Setup Record Generate w@ck&r View Tools Help |
EEE[YE e nt[aa[E]82 @m|. [Ba]]0050 0 e S o
JHdEr ] |BRblos|t[omuwmoure|| 5 @ §# |
[OHG06000[E®6®®H 6O 66|65 6H®HHH6®| 66666 ® )
opeeoeee 6eode06eo |6nHH0De® 600000

T eardured g

Note: The software may be used with or without the analyzer. When used
without an analyzer, the program functions as a viewer to view,
analyze, and print recorded files.
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Making a Recording on the SASTracer Analyzer

After installation, the software is configured to make a 16 or 32 MByte snapshot recording
of your Serial Attached SCSI traffic (16 MByte for SAS Tracer, 32 MByte for Avalanche).

To make this recording, follow these steps:

Step 1 Connect a cable to each of the two connectors on the analyzer
module, then connect the other ends to the Serial Attached
SCSI device under test and Serial Attached SCSI host system.

Step 2 From the Setup menu, select Recording Options.
Step 3 Select the General tab.

The following window displays the factory default settings such as
“Snapshot” and 16 or 32 MBytes buffer size are displayed. For your first
recording, you can leave these settings unchanged. The window
displayed below is for the SAS Tracer system, the Avalanche window is
virtually identical except for the default buffer size and the image of the

system.
x
General |Channel5ettings| Recording Hulesl Ehamnelsl
i Recording Typ Optior — Mizsc Infarmation
* Snapshot [~ Truncate Data Payload Dwords: IT UP&S 10000 Analyzer Platform

@ [l Tiee [~ Beep'when Trigger Occurs

€~ Ewent Trigger

r— Recording Scop

¢ Carwentional Single Buffer Recording

16.000 ME Mot used with snapshat

[~ Save&s Multisegment Trace I 10 j B seaments [4-128]

LeCroy 3Gbps SA5/SATA Analyzer

—Buffer Size————————— " Trigger Position

e
s

¢ Spooled Recording

i~ Recording S

& Recodfor [ 0Dayi) 12:38. 50 =

€ Record [T 120000 1B

& Wniti Triggered, glus lm
€ Uril Triggered. plus [ 720000 1E

Optians Mame Trace Filename & Path
’7 Default ’7 C:A\Program FilesiLe...\data.sas Browse..

Usze the Recaording Rules tab ta specity Filkering and.ar Triggering conditions.

Save... | Save Az Default | Load... I Cancel

Step 4 Click OK to close the Recording Options window.

Step 5 Click ® | on the Tool Bar. After 16 (or 32) MBytes of traffic is
recorded, the analyzer uploads the data and displays the
Frames.

Stopping a You can stop the recording process at any time by pressing LI Afterwards, the trace
Recording will automatically upload from the analyzer to the PC.
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Interrupting
the Upload
Process

You can interrupt the upload process by pressing the Stop Ll button. Pressing Stop
will cause the following dialog box to open:

Adjust Uploading x|
- Select new upload range within the recarded buffer
0 KT
0 16.0
From | 1.3 o (133 Total upload |12.0 ME
Full putfar | { Upload Sslection’ | Carncal |

—aAbort Upload?

Select an option:

Stap . but preserve existing uploaded data

Continue  |as if Abort not initisted

[l

Flush data and cancel frace completely

This dialog presents options for stopping, continuing, or aborting the recording:
* Select New Upload Range within the Recorded Buffer

*Slide Bar - Adjust arrows at either end of the slide bar to select the
range of buffer you want uploaded. The color in the slide bar
indicates pre- and post-trigger traffic.

*Full Buffer - Uploads entire buffer to the PC.

*Upload Selection - Uploads whatever range you have selected via
the slide bar.

* Abort Upload?
*Stop - Stops the recording and then displays the trace on screen.
*Continue - Resumes the recording.
*Flush - Cancels the recording without saving or displaying the trace.

Once you have interrupted an upload, a new button will appear on the toolbar: .| This

button ("Re-upload") opens a dialog box with a slide bar for re-selecting the range of the
trace that you would like to upload.

Upload again with new buffer settings ]
—Select new upload range within the recorded buffer

]
From | 2.6 o | 52 Total upload | 26 MB

Ful bufter | {"Upload Selection |

16.0

Cancel |

LeCroy Corporation
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Saving the

When the recording session is finished, the bus traffic is uploaded to the PC and is
Trace

automatically saved to the hard drive as a file named data[sn].sas where [sn] is the serial
number of the analyzer chassis; or the name you assign as the default filename.

Frame
170

0xB4D463

CRC EOF TimeDelta i
0xFFFF 000000000 28 bytes || Ox50CO3F1B - 1.372 ps 00000.133 12330

T Frame ALK TimeDelta

Tirne Starmp
171 K28.5 DO1.4 DO1.4 DO1.4 1.023 ms 00000.133 12679

Step 1 To save a current recording for future reference, select
Save As from the File menu.

Step 2 Give the recording a unique name and save it to the appropriate
directory.

20
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Probe Control Settings

LeCroy analyzers are designed to interface with the communications channel in a
non-intrusive manner, to minimize any distruption of traffic or error conditions due to
insertion of the analyzer. In some cases, the user may desire to adjust the probe settings
to achieve a more optimum balance of complete data capture with minimal traffic
disruption, and for that reason direct user access is provided to the probe control settings.

The probe control dialog provides several user adjustable settings for the probe
performance, which vary depending on the model (Avalanche or SAS Tracer).
Modification of these settings occur in real-time and do not require cycling the power or
uploading new firmware.

Avalanche To access probe control setting for an Avalanche System, select Probe Control from the
Systems Setup menu.

@Letroy SASSuite Application Software

JEiIe Setup Record Genmerate Tracker Wiew Tools Help

J » B3 Display Options. .. | |J £ Ly e
”@[ 8 Recording Options (UPAS 10K)... : |m|®|®|® | ®|®|(

nﬁ Recording Options {(Avalanche). ..
[uﬂ Tracker Options, ..

Update Device 3

Probe Contral SA5Tracer SN400

Channel Settings SASTracker SK:a00

!_Zﬂ: Analyzer Metwork, ..

== all Connected Devices. .

Switch SASTracer SN:400 ko SASTracker

Switch SASTracker SM:600 o SASTracer
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Selecting this option displays the Probe Control Setting dialog:
Awvalanche's Probe Control Setting k
—Chip Selection
[~ apply To Both ' Initiatar " Target IMiniSF'.S j
—Port Selection
[~ apply To &l Ports i+ p1 i pz i p3 i p4

—Input ISE (0x10) —Input Skate (0x11)

Shart .—J— Min [ Terminate To ¥OD

IMedium I— CFff —Input LOS (0x12)
1 [ [ 1 1 [ [ 1
Long ,I_J—I Min L35 threshold —J— 2

—Output Pre Lang {0x20) —Dutput Pre Short (0x21)

Lo poooo L O R I B B R A |
Level J— off Level -—J— 13
R T T B B

1 1 1 1 1 1 1 1 I:l 1
Decay J— Decay .—J— 4

—Cukpuk Power (0x22) — Cukput Skate (0:x23)

[~ Terminate To ¥DD W Enable LOS Farwarding

Level ] _  B0s Mode E— ]— g
'

K I Aol | Cancel Restore Factory Defaults |

Allowed adjustments include chip selection, port selection, applying input signal
equalization, output pre-emphasis, output power, input state, input LOS, and output state.

You can Restore Factory Defaults.

Chip Selection

In the Avalanche System, the probes can be controlled separately for initiator traffic and
for target traffic. For separate adjustments, first adjust one probe, click Apply to apply the
settings, then select the other probe and make adjustments there.

Probe Control Settings can be set for Initiator, Target, or Apply to Both. You can select
the Target from a list.

Port Selection
Probe Control Settings can be set for P1, P2, P3, P4, or Apply to All Ports.

22
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Input Signal Equalization

Input signal equalization can be adjusted within a matrix of three time values, with four

settings for each time value. The time settings are relative: Short, Medium, and Long. The
available levels, from left to right, are Off, Min(imum), Mod(erate), and Max(imum). The
default setting is Min for Short. The default setting is Off for Medium. The default setting
is Min for Long.

—Input ISE (0x10)

Output Pre-emphasis

Output pre-emphasis is controlled within a matrix of two time values, with 15 settings
within each time value. The time values are Output Pre Long and Output Pre Short. The
settings for each are from Off (0) to Max (15). The default setting is Off for

Output Pre Long. The default setting is 13 for Output Pre Short.

Output Pre Long (0x20% Cutput Pre Shork (0x21%)

[ [l [ ] [ I O R R B R |
Lewvel ]— OfF Lewvel — |— 13
1 [ [ [ 1 [ 1

1 [ [ [ [ 1 [
Decay — o Decay — ¢

For short cables, Short Level is more important than Long Level. For long cables,
Long Level is more important than Short Level. Use cable length to set pre-emphasis:

+ Forlong cables, set Long Level at the middle and Short Level to OFF or at a pre-
defined value that you derive by trial and error in the lab.

» Forshort cables, set the Long Level at the middle and set Short Level to a value that
you derive by trial and error in the lab.

For Output Pre Long and Output Pre Short, you can set the Decay from 0 to 7. The
default setting is "Off" for Output Pre Long. The default setting is 4 for Output Pre Short.

Output Power
The output power is available in eight steps from 626 mV to a maximum of 1294 mV. The
default setting is 808 mV.

Cukput Power (0x22)

[ Terminate To VDD

Level 1 1 1 1 1 1 1 j 1294
'

You can Terminate to VDD.

LeCroy Corporation
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Input State
You can Terminate to VDD.

Input State (0x11)
|7 |_ Terminate To ¥DD

Input LOS
You can set LOS Threshold from 0 to 7. The default value is 2.

L5 threshald v—J— 2

|'In|:|ut LS (0x12)

Output State
You can set the Mode from 0 to 15. The default value is 5.

You can Enable LOS Forwarding.

Qukput State (Dx23)

¥ Enable LOS Forwarding

Made —J 15
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SASTracer Toaccess probe control settings for a SAS Tracer System, select Probe Control from the
Systems Setup menu.

If there’s more than one analyzer ] Ele | Satup Record Generate  Wew Tools  Help
connected, the user will have an | G2 |ME Dsplay options...
option to select Probe Control

Settings for each device individually

J ¥ i Recordng Opbons [

B(_wee=r 0000606

SASTracer SH:5D0

CASTracer SM:501

Ma} Analyzer petwork.

The Port Settings and OOB Idle Sensitivity are only available when the SAS analyzer
system is operating in Repeater mode.

The Plug-in Mode options provide an additional control for the SAS Tracer External
Connector Module (SS004MAA) only. These controls will be disabled when attached to
the Internal SATA-style module (SS002MAA) because this module operates in Repeater
mode only.

Break Link - Checking this box for a specific channel takes the link to electrical idle. It
has the same effect as manually detaching a single connector from the device to "break
the link". Unchecking the Break Link box for a specific channel brings the link up. It has
the same effect as attaching a connector to a powered-on device.

Probe Control Settings E]

Links

1 2 3 4
Paort Settings

Break Link I I I
High Swing ([ I

Q0B Idle Senzitivity
Marmal f+ f+

Decrease 30m i i
Decrease BOmb F F

Plugin Maode
" Fepeater Plugin Mode

f* Maon-intrusive Plugin bode

ok | Cancel
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High Swing - Alters the repeaters differential output swing to accommodate for PCB /
connector loss. By default, the repeater uses "Normal" swing. "High" swing may be
required when tapping between long backplanes or extended cable distances:

¢ Normal Swing: 440 mV min and 660 mV max (peak to peak)
¢ High Swing: 800 mV min and 1200 mV max (peak to peak)

OOB Idle Sensitivity - Alters the repeaters OOB detection behavior to accommodate for
marginal OOB signal amplitude in SAS devices under test. The OOB idle sensitivity offers
an adjustable threshold for detecting an inbound OOB sequence. If two PHYss fail to
complete OOB, users may find lowering the OOB idle sensitivity provides a mechanism
for establishing the link even when the OOB signals from the DUT are marginal.

* Normal - 100mV to 200mV
* Decrease 30mV

* Decrease 60mV

26
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Chapter 3: Software Overview

SASSuite is an application that may be used with or without an analyzer unit. When used
without an analyzer, the program functions as a viewer to view, analyze, and print
captured traces (from Avalanche or SAS Tracer analyzers) or command log files (from the
SAS Tracker option on the SAS Tracer).

Starting the SASSuite Program

To start the SASSuite program from the Start menu,
Step 1 Click Start.
Step 2 Select Programs.
Step 3 Select LeCroy.
Step 4 Click LeCroy SASSuite.

@Letroy SASSuite Application Software -0l x|

JEHE Setup  Record  Generate wrgcker view Took Help |
EEEEE TR R P R E e E= o
[ «E > 2| |8 B8 o P [Fo Me goivet A g Tie| | | |

[OOPRODOD PHBEROOAAR VNI RIIEBR PDODGEH® ®|
Doeenen® 0d0de0ed en®ndde® doodod®D

Search: Pud -

Opening Sample Traces

A good way to gain familiarity with SASSuite is to open some of the provided sample files
and explore the menus, pop-up menus, and reports.
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Opening "Older" Trace Files

If you have recently installed a newer version of SASSuite and have existing data files
recorded in older versions, when you try to open these files you may be prompted to
update the files to the newer file format. In most cases, you simply need to click on the
"Update file" button to update the file.

If you expect to need to use the older version of SASSuite to open these files (perhaps
on a different computer system), you can select to make a backup copy of the file which
retains the older file format.

The file ‘smp_general zaz' last modified by LeCrop S&45T racer
2.80 [Build 180] iz about to be updated.

The changed file might nat be readable by the older versions of
the application than S455uite B.00 [Build 217].

IJpdate file I Skip update Update file, backup old version

Tool Tips

Throughout the application, Tool Tips provide useful information about buttons on the
toolbar.

To display a Tool Tip, pause the mouse pointer over an item of
interest such as part of the trace or a button. | " J K/ QE|
Skart Recording (ChrlHR)

Trace Tool Tips

Many fields within the Trace will display tool tips when the mouse pointer is suspended
over them. These tips may provide a simple legend for the cell or may give substantial
added details about the field.
OFPEMN_ACCEPT TimeDelts Time Stamp
@85 D1E|_"' D']E}" D kG T 1 99E - T T O

SAS Primitive OPEN_ACCEPT I
m Description: Indicates the acceptance of a connection request.
SMP Request | Rl e ing: K28.5 D16.7 D16.7 D16.7 (OxBCFOFOFD) i
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The Menu Bar

While some of the analyzer’s main display window options are familiar, many contain
options specific to the analyzer program. Depending on the particular analyzer function
in use, not all of the options shown here may be displayed.

Table 1: Main Display Pull-Down Menus

Menu Function
File
New GenFile Creates a new (and empty) traffic generation file. To add text,
click the Edit as Text button on the toolbar.
Open... Opens a trace file or traffic generation file.
Close Closes the current trace or generation file.
Save As... Saves all or a specified range of Frames from the current file with
a specified name.
Print. .. Prints part or all of the current trace or traffic generation file.
Print Preview Produces an on-screen preview before printing.
Print Setup... Sets up your current or new printer.
Edit Comment... Opens a dialog for entering a brief comment about the trace.
Export>> Packets to Text (Packet View Format) - Saves all or part of a
trace to a text file. Useful for saving traces to floppy disk and for
emailing.

to Generator File Format ... - Creates a traffic generation file
based on the open trace. This is a fast and easy way of creating
a traffic generation file.

Packets to EAS Format ... - Creates an EAS file based on the
open trace. Running this command opens a dialog prompting
you for a file name, path, and a range of Frames to be exported.

Transport to CSV Format ... - Creates a structured .csv file from
all or part of the trace data. This file may be imported into
external databases or spreadsheet programs (e.g., Microsoft
Excel).

Convert>> Convert .stg to .ssg - Converts SATA traffic generation files
created by SATracer (.stg) to the SASTracer generation format
(.ssQg).

Merge Trace Files | Merges files which have been recorded as multitrace files (e.g.,
when using cascaded analyzers)

Exit Exits the SASSuite program.
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Menu Function
Setup
Display Options... | Opens a dialog for customizing trace colors, formats, and filters.

Recording Options
(UPAS 10K)...

Configures the SAS Tracer analyzer’s recording behavior. Opens
a dialog for selecting event triggers and filters, and for setting the
size of the recording buffer and other recording options.

Recording Options
(Avalanche). ..

Configures the Avalanche analyzer’s recording behavior. Opens
a dialog for selecting event triggers and filters, and for setting the
size of the recording buffer and other recording options.

Tracker Options

Configures tracking type, memory, triggering, channel settings,
and tracker sweeping.

Update Device

Opens a dialog for updating the BusEngine and Firmware of the
selected device.

Probe Control

Provides a dialog to adjust the probe settings of the selected
device.

Channel Settings

Allows renaming of the channels - ie the establishment of aliases
for each channel.

Analyzer Network

Opens a dialog box for browsing to local and networked
analyzers. Within the dialog, click Add to browse. The dialog
lists PCs that are on the LAN. If a PC has an analyzer attached
to it, and if DCOM permissions have been set on the selected
PC, clicking Select establishes a connection.

All Connected

Opens a dialog box with a list of analyzers connected to the host

Devices ... PC. Lets you select an analyzer and update the BusEngine,
Firmware, and licensing information.

Switch ... to... Switches between SASTracer and SAS Tracker capabilities for
systems with dual-function licenses.

Record

Start Causes the Analyzer to begin recording.

Stop Causes the Analyzer to stop recording.

Recording Options | Configures the SAS Tracer analyzer’s recording behavior. Opens

(UPAS 10K)... a dialog for selecting event triggers and filters, and for setting the

size of the recording buffer and other recording options.

Recording Options
(Avalanche)...

Configures the Avalanche analyzer’s recording behavior. Opens
a dialog for selecting event triggers and filters, and for setting the
size of the recording buffer and other recording options.

Generate

Start Generation

Starts traffic generation. This command requires that a traffic
generation file (.ssg) be open.

Stop Generation

Stops traffic generation.

Resume
Generation

Resumes traffic generation if generation has been stopped.

Connect Link

Establishes a link between SAS/SATA Exerciser and the DUT.

Disconnect Link

Breaks the link between SAS/SATA Exerciser and the DUT.

Generation
Options

Opens a dialog for configuring traffic generation. The dialog
looks like the Recording Rules dialog (Setup > Recording
Options > Recording Rules). See Generation Options in the
Traffic Generation chapter.
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Menu Function

Tracker
Start Tracking Initiates tracking of all commands issued and completed.
Stop Tracking Stops command tracking.

Tracker Options

Opens a dislog box to allow the user to establish settings to
control command tracking and set the timeout trigger.

Report

FEile Information

Displays information about the recording such as the number of
Frames and triggering setup.

Error Summary

Summarizes the errors throughout the recording. Allows for fast
navigation to errors.

Timing
Calculations

Calculates timing between two Frames.

Traffic Summary

Summarizes the numbers and types of Primitives, Frames,
SCSI Operations, and errors that occurred in the open Trace.

Bus Utilization

Displays graphs of various types of events that occurred in the
open trace.

Run Verification
Scripts

Opens a dialog that allows you to select and run verification
scripts

Link Tracker »

Opens a window for displaying a detailed chronological view of
bus activity on a Primitive-by-Primitive basis.

Frame Tracker

Opens a window for displaying a detailed chronological view of
traffic on a Frame-by-Frame basis.

Search
Go to Trigger Positions the display to show the Trigger event.
Go to Event... Positions the display to the indicated Packet, Frame, Primitive

etc. The menu is context-sensitive and depends on the decode
level that you are currently displaying.

Go to Marker »

Positions the display to the selected marked Frame.

Go to » Enables quick searching for specific events using a cascade of
pop-up windows.

Find ... Allows searches by multiple criteria.

Find Next Looks for the next instance of an event specified with Goto or

Find.

Search Direction

Allows the search direction to be changed from forward to
backwards or backwards to forward.
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Menu Function
View
Toolbars Displays list of available Tool bars.

Analyzer Network
Chat Bar

Opens a dialog that allows users to conduct chat sessions over
an IP LAN. In order to send and receive electronic text
messages, each user must be working with a PC that is on an IP
LAN and also attached to an analyzer.

Assignments

Status Bar Switches display of the Status Bar on or off.

Zoom In Increases the size of the displayed elements.

Zoom Out Decreases the size of the displayed elements.

Wrap Wraps displayed Frames within the window.

Compact Changes view mode to the compact view.

Decoding Decoding scripts set the values of the display and recording

options for optimum views of trace information from specific
vendors or classes of data.

Link Layer

Displays Link Layer traffic in the trace.

Transport Layer

Decodes and displays Transport Layer transactions.

SCSI Application
Layer

Decodes and displays SCSI Application layer transactions.

Management
Application Layer

Decodes and displays Management Application layer
transactions.

ATA Application
Layer

Decodes and displays ATA Application layer transactions.

Hide Hides packet types, SATA FIS types, SATA FIS ports,
transport level (FIS types or FIS ports), SCSI commands or
initiators-targets, management function codes, ATA commands,
ATAPI commands, and ATA ports.
Tools
Hash Address Opens a dialog for calculating a Hash address from the SAS
Utility address. Enter an 8 byte value into the lower box to see its Hash
value.
Window

New Window

Switches display of the Tool bar on or off.

Cascade

Displays all open windows in an overlapping arrangement.

Tile Horizontal

Displays all open windows as a series of strips horizontally
across the display.

Tile Vertical

Displays all open windows as a series of strips vertically down
the display.

Arrange Icons

Arranges minimized windows at the bottom of the display.

Windows ...

Displays a list of open windows.
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Help
Help Topics ... Opens online help.
Update License ... | Opens a dialog box for entering license key information for the
analyzer.
Register Product Register at the LeCroy website.
Online
Check for Updates | Use the Internet to analyze your system for licensed updates.
Display License Opens a dialog box with information about the current status of
Information ... the analyzer's license
About... Displays version information about SAS Suite.
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Toolbar
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The Tool Bar provides quick access to most of the SASSuite software functions. You can
learn the function of each button by pausing the mouse pointer over them. Descriptions

of the buttons appear on the status bar at the bottom of the window and as tooltips above
each button.

ﬁl Open File - | Stop Recording
| = | Save As et | Start Recording

» Edit as text - opens a text editor for Re-upload. This button appears in the
editing traffic generation files. él toolbar if Stop has been pressed
during an upload. Causes analyzer to
re-upload trace from analyzer buffer
to the PC. Gives options for selecting
which part of the trace you want

QAT | L2 S|t M| || E
S o | e |[Fa ma sosl Mgt i oo Te| | [ [a |
BHHRODH®
BHOHRGDB®

1

uploaded.
i . =
0 Setup Record Options for SASTracer o Zoom In
s Q
A Setup Record Options for Avalanche |L~ Zoom Out
ﬁl Setup Display Options IE Wrap

Find Next - repeats last Find or Go To

Find - Opens a dialog for conducting
!! | operation

complex searches

=

Trace Panes. Allows multiple traces
to be locked together and scrolled in
tandem. This option only works with
.mlt traces created by multi-analyzer
cascades in a single recording
session.
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Reports Buttons

£

B

File Information Report. Opens a
summary of the trace file including
when it was made, the Recording
Options used to create the file, and
data on the analyzer that recorded
the trace.

Error Report. Opens the Traffic
Summary window and displays a
summary of errors in the trace.

Timing and Bus Usage Calculations.
Opens a calculator for measuring
timing between Frames.

Show Data Block. Opens a dialog for
navigating to data blocks within
Frames and Transactions. Once a
data block is located, the window can
display the data in a variety of
formats.

Opens the SAS-Auditor dialog.

Decode Buttons

Fra

Decode & display Link Layer (Frames
& Primitives)

Decode & display Transport Layer
(SSP, SMP, & STP)

Decode & display SCSI Application
Layer (SCSI Commands)

Decode & display OOB Layer.

Hide Buttons

2

4
£
LS

Hide Align and Notify Primitives

Hide RRDY Primitives

Hide SATA Sync Cont Primitives

Hide Unassociated Traffic

|

=

fim

EIIII

2

TrE‘

&

Traffic Summary. Opens a window
displaying a table summary of traffic
recorded in the trace.

Bus Utilization. Presents a graphical
summary of traffic in the trace.

Show Link Tracker. Opens window
with detailed chronological view of
traffic on a Primitive-by-Primitive
basis.

Show Frame Tracker. Opens window
with detailed chronological view of
traffic on a Frame-by-Frame basis.

Opens a dialog that allows you to
select and run verification scripts.

Decode & display Management
Application Layer (Management
Transactions)

Decode & display ATA Application
Layer Transactions

Decode & display TrC Layer

Hide Initiator Channel 1

Hide Target Channel 1

Hide Raw Data

LeCroy Corporation

35



Version 6.25

SASSuite User Manual

Floating the

Multisegment Trace File Buttons

These buttons become active if a multi-segmented trace file has been opened.
Multi-segment traces are traces that have been recorded as a series of small segments
rather than as a single, large recording. Multi-segmenting was developed to make it
easier to work with large recordings where navigation can sometimes be difficult.
Multi-segmenting is enabled in the General page of the Recording Options dialog.
Multi-segmenting produces two kinds of files: segments and an index file that
summarizes the recording and keeps tabs of the various segments.

The buttons below allow multi-segmented traces to be navigated.

4

4

Show first multisegment file

Show previous multisegment file

Show multisegment index file

Traffic Generation Buttons
These buttons become active if a traffic generation file (.ssg) is open.

.1

%l
ol

Start Traffic Generation. This button
activates if a traffic generation file
(.ssg) is open and an SATrainer is
attached.

Stop Traffic Generation. This button
becomes active if a traffic generation
is underway.

Resume Traffic Generation.

Command Tracking Buttons

@

You can float any of the toolbars by dragging them from their current

Start Tracking. Initiates tracking of all
commands issued and completed.

Tracker Options. Opens a dialog
window to allow the user to establish
settings for controlling command
tracking, including setting a timeout
trigger.

>

g

Show next multisegment file

Show last multisegment file

Connect link. Establishes a link
between SATrainer and the DUT.
When a Connect is built into the traffic
generation script, this button will give
status on the connection (it will
depress when a connect occurs and
undepress when disconnected.)

Disconnect link

Generation Options. Opens a dialog
for configuring traffic generation.

Stop Tracking. Stops command
tracking.

Decode location at the top of the screen. If you float the decode toolbar, it will
Toolbar arrange the decode buttons so they reflect their hierarchical order.
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Pop-Up Menus

Pop-up menus within the trace provide options for formatting the trace.

Left Mouse Button - Opens a menu for expanding fields, viewing data fields, and
formatting the trace.

The menu is context-sensitive and changes depending on what field of the data file has
been clicked.

A menu similar to the following appears:

" Frame CRC
118540
Frarme ACK E Wigw Diata Block,
T
118543 K235 001.4 D014 D014 a25 Expand Data
i Feme RRDY (NORMAL) E Expand Al Dats Fiekds
118544 k2850014 D24 00167 87 Collapse All Data Fields
Format 3
Color »

Hide

¢ Data Field - Indicates the type of field that you selected. This field is
context-sensitive.

* View Data Block - Allows raw data to be viewed from a data cell.

¢ Expand Data/Collapse Data - Expands or collapses data field. Summarizes
the amount of data displayed in the cell.

¢ Expand All Data Fields - Expands any data fields that are currently
collapsed.

¢ Collapse All Data Fields - Collapses any data fields that are currently
expanded.

* Format - Presents options for changing the numerical formatting of the data
fields throughout the trace.

* Color - Presents options for changing the color of the data fields throughout
the trace.

¢ Hide - Hides data fields throughout the trace. To re-display hidden fields,
right-click anywhere in the trace and select Unhide Cells and then one of the
options from the sub-menu.

Right Mouse Button - If you click a cell in the recording with the

. . % Display Options
right mouse button, a pop-up menu appears and shows the options

for zooming in or out, wrapping the display, and other formatting Unide cells b
options. @ zoomn
EL Zaam Qut

= wer
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Status Bar

The Status Bar is located at the bottom of the main display window. Depending on the
current activity, the bar can be divided into as many as four segments.

Recording When you begin recording on an Avalanche or SASTracer Analyzer, the left-most
Progress segment of the Status Bar displays a recording Progress Indicator:
] Trigger?  [act:([I1111| Search: Fd 2
| Triggered!  [Act:[11[111111[Search: Fud 7
e, |Uploading  |41% done  |Search: Fwd 2
sl |Uploading  |55% dome  |Search: Fwd
As recording progresses, the Progress Indicator changes to reflect the recording
progress graphically:

* In the Progress Indicator, a black vertical line illustrates the location of
the Trigger position you selected in Recording Options.

— Pre-Trigger progress is displayed in the field to the left of the
Trigger Position.

— When the Trigger position is reached, the progress indicator
wiggles as it waits for the Trigger.

— After the Trigger occurs, the field to the right of the Trigger fills in
the post-Trigger color specified in the Display Options.

— When recording is complete, the upper half of the progress
indicator fills in white, indicating the progress of the data upload
to the host computer.

You should be aware of two exceptional conditions:

+ If a Trigger event occurs during the before-Trigger recording, the
before-Trigger color changes to the after-Trigger color to indicate that
not all the expected data was recorded pre-Trigger.

*  When you click Stop before or after a Trigger event, the Progress Bar
adjusts to begin uploading the most recently recorded data.

» If you wish to abort an upload that is in progress, click the Stop button
again.

The Progress Bar fills with color in proportion to the specified size and actual rate at which
the hardware is writing and reading the recording memory. However, the progress
indicator is normalized to fill the space within the Status Bar.
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Recording
Status

Recording
Activity

Search
Status

During recording, the current recording status is displayed in the next segment of the
status bar. (Refer to previous screenshot for examples.) When recording is begun, one
of the following messages flashes (depending on the selected Recording Options):

» Trigger?
» Triggered!
+ Uploading

After recording stops, The following occurs:
* Flashing message changes to Uploading data—x% done (x% indicates
the percentage completion of the data uploading process).

» Traffic data is copied to disk using a file named data[sn].sas where [sn]
is the serial number of the analyzer chassis; or the name you assign as
the default filename. You can also create a file name of your choice by
specifying one in the Recording Options window.

To abort the upload process, press the Stop button.

You are asked if you want to keep or discard the partially uploaded data.

When the data is saved, the Recorded Data file appears in the main display window, and
the Recording Status window is cleared.

» If the recording resulted from a Trigger event, the first Frame following
the Trigger (or the Frame that caused the Trigger) is initially positioned
second from the top of the display.

» If the recording did not result from a Trigger event, the display begins
with the first Frame in the traffic file.

During recording, the fourth segment from the left of the Status Bar displays Recording
activity as a series of vertical bars.

The more vertical bars that are displayed, the greater the amount of activity being
recorded. If there are no vertical bars, there is no recorded activity.

During uploading, the percent of the completed upload is displayed.

The rightmost segment displays the current search direction: Fwd (forward) or Bwd
(backward).

LeCroy Corporation
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Navigation Tools

You can zoom in and out, and wrap the recording to fit within the screen by using the
following buttons:

Zoom In Increases the size of the displayed elements, allowing fewer (but larger) Frame fields per
screen.

Click ‘& on the Tool Bar.

Zoom Out Decreases the size of the displayed elements, allowing more (but smaller) Frame fields
per screen.

Click & on the Tool Bar.

Wrap Adjusts the Trace View so that Frames fit onto the next line if they are longer than the size
of the window. Without Wrap, you can use the horizontal scroll bar to see the hidden part
of a Frame.

Click E on the Tool Bar.
|[Ferasmug @R R GGG G |8 &5 &|H

Identify |[Phy D] SAS Address ][ Initiator Port_ ][ TargetPort || ERC

ENDDEVICE  |[ 0x01 | 500062B0_000002F5  [[SMPiSTP/SSP ][ Not Present|| 0x9A4B1FET |MH:‘|

Trace with Wrap turned off. In this example, the Time Stamp extends
off the right edge of the screen.

| Fra rm g bt mm@l@ CER0O0O00| e | e

Identify |[Phy D] SAS Address |[Initigtor Fort_|[ TargetPort [ GRC | —
EMDDEYICE || 0x01 | 500062B0_000002F5  |[SMP/STP/SSP |[Mat Present|| 0x844B1FE7 |

3 A
405.000 ns 02:01.532 841 842

Trace with Wrap turned on. Entire Frame displays in window.

-

Adding Comments to the Recording
You can create, view, or edit the 100-character comment field associated with each data
file.
Step 1 From the File menu, select Edit Comment.
The Edit Trace Comment Dialog window appears.

Edit Trace File Comment Dialog x|

IThis a recording to a connection ta the new hard drive
QK I Cancel |

Step 2 Create, view, or edit the comment.
Step 3 Click OK.
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Set Marker

The Set Marker feature allows Frames to be marked so they can be navigate back to
events of interest. Markers also provide you with a way of tagging events so you can
perform timing calculations between them.

The Set Marker command works in conjunction with the Go to Marker feature. Once
you have marked a Frame, you can navigate back to it by selecting Search > Go to
Marker, and then selecting the marker of interest from the list.

To set a marker on a Frame, perform the following steps:

Step 1 Click on Frame # for the Frame you wish to mark.

Frame
Frame 115446 6.7 D167 D1B.7
Shows Raw 10b Codes

307 000 ns
T e
Set marker 1.4 0240 D167 28000 ns [
[ — Time From Trigger DR AL
1.4 0240 D167 25 000 ns [
Time From Marker
n (NORMAL)
Farmat 0140240 D1B7 412000 ns
Cal 3
- B e (NORMAL)
Hide 1.4 024.0 D167 53.000 ns [

Step 2 Select Set Marker.

The Edit Market for Frame # comment window appears.

Edit Marker for Frame # 118446

Ix

[—

[

Prezz <Chl - Enter: ta inzert a line break.

[IF I Cancel |
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Step 3 Enter your comment.

Step 4 Click OK.
A marked Frame is indicated by a vertical red bar along the left edge of
the Frame # block:

Frame

IT1

118446

K255 D167 D167 D1B.Y 307.000 ns a0003.t

42
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Edit or Clear Marker

To clear or edit comments associated with a Frame marker,
Step 1 Click on Frame # for the chosen packet.

Frame 115446

|

0167 D167 307.000 ns a

Show Raw 10b Codes

Edit marker D240 D167 28.000 ns Qoao:
’ F Clear marker ORMAL
1 D240 D167 26000 ns Qoao:

Tirne Fram Trigger

y F Time From Marker ORMAL]
1 D24.0 D16.7 412000 ns a
Farmat L4
T1 | F Color y MORMAL]
1 D24.0 D16.7 £3.000 ns

Hide I
C= kA

Step 2 To edit the marker comment, select Edit Marker.

=
=
=
=
'

The Edit Marker for Frame # comment window appears.

Edit Marker for Frame # 118446 x|
[—

Prezs <Chl - Enters toingzert a line breal.

] I Cancel |

Step 3 Edit the comment as desired.
Step 4 Click OK.
Step 5 To clear a marker, click Clear marker.

The vertical red Marker bar disappears.

(3]
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Timing Calculations on Markers

Markers can be used as reference points to calculate timing between events. To perform
a timing calculation, select Reports > Timing Calculations, and then click the Markers
buttons to select the markers you want to use for the calculation. Afterwards, click
Calculate to calculate the timing between the marked events.

|

From beginning of: ToEnd of: ﬂl

Frame - | 22147 Frame - | 22150
tarker - | Frame # 22147 [Host opens co M arker - | Frame # 22150 [Marker #1]
Time - | 1218202517850 secs Time - | 121.8282622425 secs

Total Time: 457,500 Inanosaconds d

Calculate:

You can also calculate timing between markers by clicking the left mouse button on the
first cell of a Frame in the trace window and selecting Time from Marker from the pop-up
menu. The Timing Calculations dialog will open and prompt you to select a marker. Upon
selecting a marker from the list, the calculation will be performed.
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Chapter 4: Avalanche Recording

Options

Recording options provide instructions for the analyzer hardware as to how a trace
recording should be captured. Included in these instructions are items such as how to
start or stop a recording, what information should be recorded, and trigger conditions that
can be used to automatically record certain data events (or sequences of events) when
they occur.

Since these instructions are specific to the hardware platform being used, there are
differences in the way the recording options are set up for the Avalanche system vs. the
SASTracer system. In order to present this information clearly, we have divided the
information into two Chapters in this User Manual.

This Chapter covers recording options for the Avalanche systems only. For
information on the SASTracer systems, see Chapter 5.

General Recording Options

From the Setup menu, select Recording Options (Avalanche)... . The following screen
is displayed:

Recording Options x|

General I Channel Settings I Triggering ¢ Filtering I Channels I

- Recording Type Option: i Mizc Information —————————
{* Snapshot ™ Truncate Data Pavload Dwords: I 14 Avalanche Analyzer Platform
[~ Beepwhen Trigger Docurs

" Manual Trigger

" Event Trigger

— Buffer §ize——————————— Trigger Position
32.000 MB Mot used with snapshot
'._\'. [T
1 ]
LeCrop BGbps SAS/SATA Analpzer
I~ Sawvebs Mulisegment Trace 10 j ME segments [4-128]

IDefauIt C:“Program File...\data.zas Browse... |

Usge the Triggering # Filtering tab to specify Filkering and/or Triggering

— D ptionz Name "TIGCE Filename & Fath

Save... Save Az Default I Load... QK I Cancel
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Options displayed on the General page include the following:

* Recording Type

* (Recording) Options

¢ Buffer Size

* Trigger Position

* Save As Multisegment Trace Option
* Options Name

* Trace Filename & Path

* Misc Information

Recording The Recording Type box presents three options that control how Avalanche begins and
Type ends a recording. The options are Snapshot, Manual Trigger, and Event Trigger.

Snapshot: A fixed-length recording. A Snapshot is a recording whose
size is set via the "Buffer Size" box. Recording begins when the Start
Recording button Ll is clicked and ends when either the preselected
buffer size is filled or the Stop Recording button LI is pressed.

Manual Trigger: A recording whose ending is triggered by pressing the
Trigger button on the front panel. Recording begins when the Record
button *® | is pressed on the Tool Bar. Recording continues in a
circular manner within the limits set by the buffer size. Recording is
ended by the user pressing the Trigger button on the front panel,
although in some cases recording may not stop immediately. Once the
Trigger button has been pressed, recording continues until the
post-trigger buffer has been filled (see Trigger Position below) or the
Stop button LI is clicked on the Tool Bar.

Event Trigger: A recording whose ending is triggered by user-defined
events. Recording begins when the Record button # | is clicked on
the Tool Bar. Recording continues in a circular manner within the limits
set by the buffer size until a trigger event is detected and the defined
amount of data has been recorded after the Trigger event.

Options The option checkboxes appear on the upper right side of the General tab of the
Recording Options window.

Truncate Data Payload Dwords: Allows data payloads to be truncated
to whatever length is specified in the box. Truncating the payload limits
the amount of space each frame requires to be stored in the buffer,
thereby increasing the number of frames that can be recorded.

Beep When Trigger Occurs: When this checkbox is selected, the
computer connected to the Avalanche beeps three times to alert the
user when a Trigger condition is first detected.

46
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Buffer Size

Trigger
Position

The Buffer Size slide bar adjusts the recording buffer size
from 3.2 megabytes to 4096 MB. This option is used for

. . . 16.000 B
setting the maximum memory to be used for a recording.

The option mentioned above for truncating data payloads, -—J—
as well as filtering options which will be discussed later,

determine what information from the raw data stream is

actually recorded into trace memory. Also, although there are 4096 MB of physical
memory in the Avalanche analyzer, there is additional information recorded with each
frame, such as timestamps and other system parameters, so the efficiency of the
recording is at least 60% (ratio of actual SAS or SATA traffic to physical memory).
Filtering and truncation will yield better efficiency. The actual 4096 MB of memory can
only be reached when symmetric data is recorded on all four ports.

Buffer Size

Note: The Buffer Size slider bar is not linear and affords more granularity in the
smaller buffer sizes.

The Trigger Position slider bar allows the user to

define the position of the trigger within the recorded |- Triager Position

traffic. Essentially, this is instructing the system when 40 % post-triggering

to stop recording. If the trigger position is set to the O R B B R
. : . . . "

end of the recording, recording will stop immediately |

when the trigger occurs. If the trigger is set to the

start of the recording, when the trigger occurs the

system will continue to record until the buffer has filled again and then stop (before the
new data overwrites the trigger). Any intermediate setting allows the user to see data
both before and after the trigger occurred. You can adjust the Triggering Position between
1 and 99% post-Trigger. Trigger Position is available only when Manual Trigger or
Event Trigger is selected as Recording Type.

As an example, if the buffer size is set to 16MB, then for the following Trigger Position
settings, the amount of pre- and post-Trigger data is:

* 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger

* 75% post-triggering: 4MB pre-trigger, 12MB post-trigger

* 50% post-triggering: 8MB pre-trigger, 8MB post-trigger

* 25% post-triggering: 12MB pre-trigger, 4MB post-trigger

* 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note: When a Trigger occurs, recording continues until the post-Trigger
amount of the buffer is filled or the Stop Recording button in the GUI is
pressed..

LeCroy Corporation
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Save As
Multi-
segment
Trace

This option causes the analyzer

to segment the trace into W Save Az Mulisegment Trace I_E4|:I| ME segments [4-128]
multiple files and create an

index file called data.mlt that summarizes the starting and finishing frame for each
segment.

This option is useful for very large recordings and for host PCs with limited memory. In
the latter case, multi-segmenting gives a PC with limited memory a way to open
recordings that would otherwise be too large to open.

The only downside to multi-segmenting is that it limits the scope of reports such as Traffic
Summary, Bus Utilization, and Error Summary to each of the segments. You will not be
able to perform summary statistics on the full recording.

The default value for this option is 10 MB. Before attempting large recordings, it is
recommended that you adjust this number to see what value best suits your needs.
based on the capabilities of your host PC.

To create a multisegmented trace,
Step 1 Check the box marked Save As Multisegmented Trace.
Step 2 Set the file size for each segment in the box marked MB Segments.

File Structure for Segmented Files

Multisegmenting produces an index file and subordinate trace files. The default name of
the index file is dataXYZ.smt, where XYZ is the last three digits of the analyzer’s serial
number. (You can see the unit’s serial number by selecting Help > About SASSuite)
Thus, for example, if you had an analyzer with the serial number 111, the index file would
be called data111.smit.

The index file and the segmented trace files are stored in a directory named after the
index file. The directory is named indexfilename _smt _files. For example, if the index
file is named data111.smt, the directory will be named data7111_smt files. Below this
directory additional, sequentially numbered sub-directories (up to 100,000) that house
the segmented trace files. These sub-directories bear simple numerical names: 00000 -
00999. Each of these subdirectories can hold up to 100 sequentially-numbered segment
files. Collectively, the entire directory structure can hold up to 10 million files.

Example

A 1010 MB recording using 10 MB segments and the default file names will create the
following sub-directories and files. The example below uses the serial number 111:

¢ data111.smt This is the index file.
¢ data111_smt_files\00000\segment_00000.sas
¢ data111_smt_files\00000\segment_00001.sas

¢ data111_smt_files\00000\segment_00099.sas
¢ data111_smt_files\00001\segment_00100.sas
¢ data111_smt_files\00001\segment_00101.sas
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The index file looks something like a trace file but contains packet-like entities that
summarize each 10 MB segment.

J File Setup Record Generate Report  Search  Wiew  Tools  Window  Help _|&| X
|zBRaE (b @ milet222 x| 8w JEG 5 @ el 45 =
[rre=wa@REeR00@0] [A 1] [Ean %)
Start Frame # Murn Frames Duration Time Stamp :I
5124584 24032 ms 00 : 00. 000001 192
Statt Frame # Mum Frames Duration Time Stamp
512484 512489 24.029 ms 100 00. 0240331587
Start Frame # Murn Frames Duration Time Stamp
1224973 5124584 24.030 ms :00: 00. 043 052 532
Statt Frame # Mum Frames Duration Time Stamp
1837457 512409 24.029 ms 100 00. 072 093 062
Start Frame # Mum Frames Duration Time Stamp
2449948 512484 24.031 ms :00:00. 095122185 |
KT o
Ready [ [ [ [search: Fwd

When uploading is complete, the index file will be opened. Each "packet" in this file
corresponds to one of the numbered segments. Double clicking on the packet will open
the corresponding segment file.

Multisegment Toolbar
When an index file is opened like the one shown above, the B |
Multisegment Toolbar will display. This toolbar lets you navigate the

index file.

|4 |Open first segmentin
multisegment trace.

4 Open previous
segment in
multisegment trace.

iz |Open index file. This
button becomes active
if a multisegment trace
file is open.

p  |Open next segment in
multisegment trace.

» Open last segment in
multisegment trace.
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Channel Settings

Speed
Settings

Channel
Settings

The Channel Settings page lets you to set speed, descrambling and packing options for
each channel. It also lets you inhibit channel recording.

Recording Options =

General Channel Settings | Triggering / Filteringl Ehannelsl

— Speed Settings
Links

Auto Detect Link Rate
1.5 G5 Link Rate
3.0 G5 Link Rate
B.0 Gz Link Rate

O Te e e e
O Ne e Bl T N
WYY w
O e e i N

— Channel Settings

Channels
11 T 12 72 13 T3 14 T4

Inhibit (I I W I I S i
MoDescrambling [ T [ [ [ [T [T [T

Save... | SaveAsDefauItl Load... | ()8 I Cancel |

The Avalanche systems are designed to support Autodetect Link Rate which is designed
to pass through the speed negotiation signaling allowing the initiator and device to
determine the link speed using the method defined in the SAS specification. In general,
this is the most convenient setting to use because it ensures the traffic will get recorded
at the negotiated rate. Alternatively, users may force the analyzer to record at the 1.5G,
3G or 6G rate. However, if the negotiated link speed is higher or lower than the speed
selected in this tab, analyzer will not decode the traffic properly (there will be errors in the
trace). The user will know if devices are negotiating successfully by getting clean
recordings.

These options allow you to inhibit recording and turn off scrambling on a channel by
channel basis.

Inhibit - Inhibits recording of traffic from selected channels. For example, if you check
the option for T1, it means "record all channels except for Target channel 1 (T1)."

No Descrambling - Turns off the analyzer’s descrambling from the selected channels.
Select this option if your DUTs are not scrambling their traffic.
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Triggering/Filtering

Building
Filters

The Triggering/Filtering page allows the user to define triggers and filters that can be
simple or quite complex.

The SASSuite application provides a menu-driven interface for building triggers and
filters. The interface prompts you for simple decisions and choices from drop-down
menus. As you make your selections, the script takes shape automatically in the scenario
window. The script is in the form of simple English sentences. You need not understand
any formal scripting language.

Selecting the Triggering/Filtering tab brings up the following screen:
x

Generall Channel Settings  Triggering / Filkering | Ehannelsl

Triggering/Filkering Options are walid.

% [Global Filtering]
“Click here to add filter condition=

% [Global Bules]
“Click here to add an event:

“Click here to add a sequencer

Save... | SaveAsDefauItl Load... | ()8 I Cancel |

The top section of the screen, labeled "Global Filtering", is used to build filters. Filters are
definitions of commands or data types that may be present in the traffic, that the user
does NOT want to include in the trace recording. For example, some of the traffic that
takes place in a SAS or SATA link might be simple primitives, and for high-level routines
these primitives simply occupy space in the trace without providing any useful information
to the programmer. Alternatively, a busy link might include traffic between multiple
devices, and if a problem is being experienced with one device, traffic from other devices
simply fills up the analyzer buffer without providing useful information to the user. In such
a case, data recording can be limited to traffic involving only specific devices, although
this capability is accessed in the Channel Settings tab as noted earlier.
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To begin to build a filter, simply click on the link which says "Click here to add filter
condition”. The following screen appears:

Filter Condition Properties

Type Properties

SAS5 Primitive
SATA Primitive
Idle

SATA KRks
QOB Signal

|

This screen displays five filter conditions which can be selected by the user. Selecting
any one of these conditions brings up screens with additional information.

SAS Primitive

Selecting SAS Primitive allows the user to filter on one or more SAS Primitives from the
data stream. Clicking this type brings up a detailed screen as follows:

Filter Condition Properties

Type Properties

543 Primitive Type Event -
SATA Primitive

Idl e -
S,o;,q ey = Priitives <hothing selected:

Q0E Signal ALK Il
AP Il
ALIGH [0 |l
ALIGH 1) ]
ALIGM [2] -
ALIGH [3) -
BREAK |
BREAK REPLY |l
BROADCAST ]
=

=

=

=

=

=

=

=

=

=

Description

| ®

CLOSE
CREDIT_BLOCKED
DONE
EOF
ECAF
ERROR
HARD_RESET
ML
MU O

[==] (s

=
[8]4 | Cancel |
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The user may click on any specific primitive in order to exclude it from the recorded trace.
Primitives are organized in a "nested" hierarchy, so for example the user may click on the
AIP checkbox to exclude all AIP primitives, or may expand the selection by clicking on
the "+" sign next to the AIP, which opens a list of specific AIP primitives and allows the
user to specify only specific primitives such as the AIP (WAITING ON DEVICE).

Note: Clicking on a collapsed set of primitives selects (or deselects) all
primitives in that set, and clicking on the "master" primitive selects
(or deselects) all primitives in that set even if the list is open.

Note: In all screens with multiple checkboxes, a global select or global
deselect option is provided by using CNTL-Click (holding down the
CNTL key while left-clicking the checkbox). So the simplest method
to exclude all SAS primitives is to open the SAS Primitives type, and
then CNTL-Click on any checkbox to select the entire list.

Note: If you wish to edit or delete an event or action while editing Global
Filtering, Global Rules or Sequences, you can right-click on the
event and you will be given the choice to edit or delete the
event/action. You can also edit the event or action by
double-clicking on the event or action.

SATA Primitives

Filtering on SATA primitives is exactly analogous to the SAS Primitives described above,
with the exception that there is no nesting structure provided for the more limited set of
available SATA primitives.

IDLE
Filtering on IDLE characters can be controlled by clicking on "Idle" under the Filter
Conditions Type list. This brings up the following screen:

Filter Condition Properties

Type Properties
Type Event
Description
Charinels M FTiWFe Pz Wie B s Frs

By default, once this condition is selected all IDLE characters are filtered on all channels.
If the user wishes to change this default setting, individual channels can be deselected
(or again, all channels can be deselected with one CNTL-Click on any checkbox).

SATA XXXX

Any SATA traffic which follows a SATA_CONT primitive is "filler" traffic to keep the link
alive and active, until a valid SATA primitive (other than ALIGN) is sent to the receiver.
This filler traffic is referred to as "SATA XXXX". In most cases this traffic is of no interest
and can be filtered out of the recorded trace. Selecting this option brings up a screen
very similar to the IDLE screen shown above, where the user can decide which channels
to deselect.
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OOB Signal

By selecting this option, the user can control the recording of OOB (Out of Band) traffic,
which may not be of interest to some users. Clicking on this item brings up the following
screen:

Filter Condition Propetrties

Type Properties
Tupe Ewent
Description
Chanriels Fin e FrzWiz Wiz Wia Fra
OOB Event COMIMNIT -

By default, OOB traffic (including COMINIT, COMWAKE and COMSAS) is recorded on
all channels. Through changing the checkboxes on this screen, the user can exclude
OOB traffic of certain types of specified channels from the recording.

Additional Filtering Capability

Note that under a broad definition of "filtering" (i.e., any user selections that prevent all
data traffic from being recorded into the trace memory buffer), we have already described
(in other sections) selections which can be made which result in filtering of various types.

For example, under the General screen, data payloads can be truncated after a specified
number of Dwords to limit the amount of data which occupies trace memory.

Also, in the Channel Settings screen, individual channels can be selected to be recorded
or not to be recorded, as the user wishes. This is also a type of filtering.

Global Rules And Sequences

In addition to the filtering functions described above, the Triggering/Filtering screen
provides a means for developing logical sequences of actions based on events that
occur. One example of this is to create conditions that generate a trigger.

Creating a trigger condition can range from an extremely simple exercise that requires
only one condition to be met, to a complex series of multiple events with precise timing
requirements all of which must be met before a trigger is issued. Why would so much
sophistication be needed in developing a trigger? The answer lies in the type of problem
being pursued by the user. For initial development, recordings may be made without
triggers at all. Simply start the analyzer, run the test, and look at the traffic that resulted.
As the system becomes more sophisticated, the user may need to add simple triggers to
enable the analyzer to focus on the data of interest in the midst of continuous, unrelated
traffic. Finally, when pursuing rare or intermittent bugs, the user may need to trigger on
a complex series of events that occurs either shortly before or after the problem of
interest.

The Avalanche system is well equipped to manage all these types of issues, providing
novice users with a simple mechanism to generate simple results, and allowing
engineers the flexibility to develop sophisticated state machines to extract critical data
from heavily loaded communication channels.

The Avalanche system supports three independent state machines, which can be easily
"programmed" using simple menu selections which result in clear and well-defined
instructions which can be read "in simple English".
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The first state machine supports only one state which is always active, and therefore is
referred to as the "Global Rules".

The two remaining state machines allow for multiple states with branching between the
various states, and allow for multiple conditions and/or multiple actions at any stage.
These state machines are called "Sequence 0" and "Sequence 1".

Creating Avalanche sequences is easy, but it requires an understanding of the following
terms: event, combined event, action, global rules, sequence, and state.

Term Definition

Event Condition that is detectable by Avalanche.

Combined Event | Logical OR association of events (for example, event A or event

B).
Action Avalanche response to an event or combined event.
Global Rules A single defined Avalanche test state (always active).
Sequence Single or multiple defined Avalanche test states. More flexible

than the Global Rules, a sequence allows more powerful
scenarios that include branching and looping between test states
(the Global Rules can define only a single test state, so there is
no branching).

State "Behavior" of the Global Rules or a sequence at any point in time.
In terms of Avalanche, behavior is "waiting" for a certain set of
events and responding with a certain set of actions.

You can think of the Global Rules and each sequence as separate test routine or program
operating simultaneously. Each operates independently and in parallel with the others.
The purpose of each is to detect events and then respond with the appropriate action or
set of actions. In essence, they allow you to operate up to three test states simultaneously
within Avalanche.
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Building
Global
Rules

The best way to understand how to use Global Rules is to start with a simple example.
Suppose we wanted to define a trigger that would be issued whenever a CRC error was
detected on any channel.

We would bring up the Triggering/Filtering screen (via the Setup menu, selecting
Recording Options (Avalanche)..., then clicking the Triggering/Filtering tab), as
follows:

Recording Options

Generall Channel Settings  Triggering / Filtering | Ehannelsl

Trigaering,Filtering Options are walid.

[Global Filtering]
=Click here to add filter condition=

[Global Bules]
=Click here to add an ewvent>

=Click here to add a sequencer

Under Global Rules, click on the "<Click here to add an event>" link. A list of available
events appears. Click on the Event Type "Error", and the following screen appears:

Event Properties

Type Properties

A5 Primitive Type Event

SATA Primitive Description

i

S'trgte; Entrance Channels it MtiWe Mz iz Wiz Ve s
FIS = Ermrars <nothing selectad:
ATA Command CRC Emor r

SMP Frame - -

Drata Pattern D'SD‘?”L"' Error C

QOB Signal Irvealid S prbol r

SMA Input Multiples Errar -

BOE Input _TRIG Comma alignment Ermror -

S5 Skatus Delimiter Error —

S5 TaskMgmt Function SAS ALIGH Ermror |

-

S5P Information Unit
Identify Address Frame
(Open Address Frame

SATA ALIGN Emar
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Click on the CRC Error checkbox, and then click on the OK button at the bottom of the
screen. The Trigger/Filtering screen now shows:

Recording Options

Generall Channel Settings  Triggering / Filtering | Ehannelsl

Mo action specified For the event: "ZRC Error’ in Global Rules, Click here to jump to the problem,

[Global Filtering]
=Click here to add filter condition=

[Global Bules]
@ Wait for CRC Error
=Click here to add an action:

=Click here to add a sequencer

Note that the Global Rules now has the event "Wait for CRC Error" listed, but since there
is no corresponding action defined, the bar at the top has changed from green to yellow
to indicate an incomplete command, and there is a yellow dot next to the incomplete
command.

To complete the command, click on the link that says "<Click here to add an action>", and
select "Trigger" from the list of available actions. The action screen now shows:

Action Properties

Type Properties

Type Action
Beep Description

SMA Oukput
BOE Output - TRIG After Nth ocourence 1 -

Note that you have the option to define a trigger to happen after "N" occurrences of the
event (in this case, after N CRC Errors), but for now we will leave the value at the default
setting of "1" and click the OK button.

Note: All actions have the parameter "After Nth occurrence" where N can
be set to a number greater than or equal to one. If N is set to three,
this does NOT mean that the action will happen three times.
This means that the event which calls the action must occur three
times before the action happens one time.

LeCroy Corporation 57



Version 6.25 SASSuite User Manual

Our Global Rule now reads:

Recording Options

Generall Channel Settings  Triggering / Filtering | Ehannelsl

Trigaering,Filtering Options are walid.

[Global Filtering]
=Click here to add filter condition=

[Global Bules]
Wait for CREC Error
then Trigger

Finally, we decide to have the system beep so that we know that the CRC Error has
occurred and the system has been triggered. So click on the link which reads "<Click
here to add another action>", select "Beep" from the list of available actions, and click
OK. The completed Global Rule now reads:

Recording Options

Generall Channel Settings  Triggering / Filtering | Ehannelsl

Trigaering,Filtering Options are walid.

[Global Filtering]
=Click here to add filter condition=

[Global Bules]
Wait for CREC Error
then Trigger
and Eeep (Z50 m=)

In this simple example, we have demonstrated how easy it is to add events and actions
to sequences, including places where we want multiple events or actions to be included.

The available events and resulting actions that can take place are discussed in detail
below.
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Building
Sequences

Multiple Parallel Events

When multiple events are defined in Global Rules, the events are operating in parallel
and will continue to remain active (even if they have occurred one or more times) until
recording is stopped. In the example below, three different events have been defined
which will all cause an action on the " EXT OUT" SMA output at the rear of the unit. In
addition, one event (a SCSI HARD_RESET primitive) will alert the user with a beep. As
long as recording continues, these events will continue to cause their defined outputs on
the "EXT OUT" SMA output and/or beeper.

[F] [Global Pules]
[=] WMait for CRC Error
then BENC Output - Toggle
= Wait for HADD DREZSET
then BENC Output - Send Negative Pulse
and Eeep (Z50 m=)
= Wait for SCEI Status: 'TASE ABORTED'
then BENC Output - Send Positive Pulse

Sequences differ from Global Rules in that sequences may have multiple states defined,
although only one state within a sequence is active at any given time. However, all events
within that state are active and operating in parallel. This allows for branching and looping
between states, where State 0 (which is always the starting state) can call another state
depending on a specified sequence of events, and that state can in turn call a different

state, or can call the original state.

Note: There is an upper limit of 256 states that can be defined within any
one sequence.

Note: Sequences allow a state to contain multiple conditions that result in
branches to different other states. For example, if event A results in
a branch to State 2, and event B results in a branch to State 3, then
the sequence will branch to either State 2 or State 3, depending on
which event occurs first.

As another simple example to explain how this works, suppose we want to create some
type of handshake between an Avalanche unit and an external device. We want the
Avalanche unit to look for a SCSI Check Condition, inform the external device when one
is detected, and then allow the external device to complete some task before starting to
watch for the next Check Condition.
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We can create this sequence as follows. First, open the Triggering /Filtering window by
selecting Recording Options (Avalanche)... from the Setup menu, and then click the
Triggering/Filtering tab. The screen shows the following:

Recording Options

Generall Channel Settings  Triggering / Filtering | Ehannelsl

Trigaering,Filtering Options are walid.

[Global Filtering]
=Click here to add filter condition=

[Global Bules]
=Click here to add an ewvent>

=Click here to add a sequencer

In this case, since we want to create a sequence that has multiple states, we will click on
"<Click here to add a sequence>". The screen displays the following:

Recording Options

Generall Channel Settings  Triggering / Filtering | Ehannelsl

Trigaering,Filtering Options are walid.

[Global Filtering]
=Click here to add filter condition=

[Global Bules]
=Click here to add an ewvent>

[Sequence O]
[Btate O]
=Click here to add an ewvent>
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The new sequence has been added (Sequence 0) and a default starting state (State 0)
has been created. To create the logic of the sequence, in the section under State O click
on "<Click here to add an event>" and a list of possible events appears. In the event type
list, we select "SCSI Status" and in the drop down list that appears, we select "Check
Condition", as follows:

Event Properkies

Type Properties

SA5 Primitive Tupe Ewent

SATA Primitive Description

E§me Channels Mit T Wiz Pz Wiz Bz Wia W
FIS scsisws ________[EO) E
ATA Command GOOD

SMP Frame CHECK COMDITION

Data Pattern COMDITION MET k

QOB Signal

SMa Input INTERMEDIATE

EOE Input - TRIG INTERMEDIATE-CONDITION MET

Errar RESERVATION CONFLICT

Obsolete

551 TaskMamt Function TASK. SET FULL

53P Information Linit ACA ACTIVE

Identify Address Frame TASK ABORTED

Open Address Frame

Ok | Cancel |

Click "OK", and the Sequence 0 we are building now looks as follows:

Recording Options

Generall Channel Settings  Triggering / Filtering | Ehannelsl

Mo action specified for the event: 'SCSI Skatus: "CHECK COMDITION" in Sequence 0, State 0. Click het

[Global Filtering]
=Click here to add filter condition=

% [Flobal Pules]
=Click here to add an ewvent>

[Sequence O]
[Btate O]
@ Wait for S5CEI Status: 'CHECE CONDITION'
=Click here to add an action:

Note again that the existing of a event without an action to complete the state is flagged
by the yellow bar along the top and the yellow dot to the left of the incomplete command.
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To complete State 0, we need to select an action, so click the link "<Click here to add an
action>" and select "SMA Output”, then in the drop-down list of outputs select "Send

Positive Pulse", as follows:

Action Properties

Type Properties
Trigger Type Action
Branch to Existing State Description
Branch to Mew State
Beey Everny MNth ocournence 1
Toggle |T
BOB Output - TRIG Pulze Length Falling Edge
Rizing Edge
Toggle
Send Meg

Click OK, and State 0 now reads as follows:

[Bequence O]
[Etate O]
Wait for SCEI Status: 'CHECE CONDITION'

then S5MA Output - Send Positive Pulse

However, we don’t want this action to just happen once, we now need the system to wait
for a response from the external system when it is ready for the next Check Condition.

So click on the link next to "Send Positive Pulse" that reads "<Click here to add another
action>" and select "Branch to new state" from the list of actions. The screen now shows:

Action Properties

Type Properties

Tupe Aition

Description

After Mth ocourmence 1

Destination State State 1 -
BB Qutput - TRIG

The default values provided of branching on the first occurrence and branching to State
1 are what we need, so click OK and the sequence we are building now looks as follows:

[Sequence O]
[Gtate O]
= Wait for 2C5I Statws: 'CHECE CONDITION'
then 5MA Output - Send Positiwe Pulse
o and Eranch to 'State 1'

(= [Btate 1]
- =Click here to add an ewent:
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A new state, State 1, has automatically been added, and now we are ready to tell the

State 1 what to do when the external device is ready to process another SCSI "Check
Condition" status. So first click on "<Click here to add an event>" (under State 1), and
select "SMA Input" and click on the checkbox next to "Positive Pulse", as follows:

Event Properties

Type Properties
SAS Primitive Type Ewent
SATA Primitive Description
Timer —
Skate Entrance = Input Events Positive Pulse
FIS Equalz 0 -
ATA Command Equals 1 -
SMP Frame =
Data Pattern F'osm\uie Pulze 4 I
Q0B Signal Megative Pulse I by
Any Pulze -

Eggrlnput - TRIG Positive Edge -
SCSI Status Megative Edge r
SCSI TaskMgrt Function Min Pulse Length Onz
S5P Infarmation Unit

Max Pulse Length 500
Identify Address Frame SeTEe end e
Open Address Frame

Click OK, and the sequence now reads:

[Sequence O]
[Etate 0]
Wait for HCEIT Status:

'CHECE CONDITION'

then 5M2 Output - Send Positiwe Pulse

and Eranch to

E [Btate 1]
o = Wait for SMA Input

- Poszitiwe Pulse

=ZClick here to add an action>=

To complete State 1, click on "<Click here to add an action>" and select "Branch to
Existing State", and then select State 0 from the drop-down list of available states, as

follows:

Action Properties

Properties

BiOB Output - TRIG

Type

Action

Description

After Nth ocourence

tion State

1
<unknown states [+

<uhkhowh state:
State 1
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Click OK, and the completed sequence now reads as follows:

Generall Channel Settings  Triggenng / Filtering | Ehannelsl

Triggering/Filkering Options are walid,

“Click here

[Flobal Filtering]

to add filter condition®

[Flokal Puleszs]
“Click here

to add an event:

[Fequence O]
[Btate O]
- WMait for

then
- arud

E [State 1]
- WMait for
o then

SCEI Statwus: 'CHECE CONDITION'
EMA Output - Send Positive Pulse
Branch to 'State 1

EMA Input - Positiwve Pulse
Branch to 'State 0

Note that the sequence we have created contains two defined states:

¢ State 0 is the starting state, which watches traffic passing through the
analyzer to detect a SCSI Check Condition on any channel. Once the Check
Condition is detected, the analyzer issues a positive pulse to an external
device and branches to State 1.

¢ State 1is a waiting state, which watches for a positive pulse to return from the
external device before doing anything else. Once the external device signals
that it is ready to process the next Check Condition, the external device
sends a positive pulse to the analyzer, which causes it to return to State 0 and
begin the process again.

Note: Only one state within this sequence is active at any time. The two
states form a loop, first watching for the Check Condition and then
waiting for a response from the external device. While in State 1,
traffic will be recorded but any SCSI Check Condition that occurs will
be ignored by the analyzer since State 0 is not active at that time.
The sequence will continue to loop until some manual intervention is
used to stop the analyzer from continuing to record (e.g., the Stop
Recording button is clicked).

With this simple example, we have demonstrated how sequences can contain multiple
states, and how branching and looping can occur between various states within a

sequences.
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Events

Multiple Parallel Events within a State

If multiple events are defined within a state, all events are simultaneously active and
operate in parallel as long as that state is active. Once a branch to another state occurs,
all events in the first state cease to be active.

There is one exception to this rule due to a special event ("State Entrance") which is
intended to provide a one-time action or set of actions that occur only when the state is
initially entered. Among other applications, this can be useful for following which state
the system is in at any given time (e.g., you can have the system beep when it enters a
particular state).

Multiple Parallel Sequences

Again, note that within a given sequence only one state is active at any given time, but
different sequences can be simultaneously active. There can be three simultaneously
active processes, which are as follows:

* Global Rules (which has only one state)
* Sequence 0 (which can contain multiple states)

¢ Sequence 1 (which can contain multiple states)

s 5 For either Global Rules or Sequences, there is a

list of event types that you can choose from,
Type which is presented to you each time you "Click

=A5 Primitive here to add an event". With one exception (see

SATA Primitive below), the list of events is identical between

Tirner Global Rules and Sequences.
Efgurdlng start The events are explained in more detail in this
ATA Command section.

SMP Frame

[Data Pattern

Q06 Signal

SMA Input

BOEB Input - TRIG

Errar

SIZ5I Skakus

55T TaskMagmt Funckion

S5P Information Unit

Identify Address Frame

Open Address Frame
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SAS Primitive
The SAS Primitive event screen allows you to define one or more SAS primitives which
must be detected in the traffic in order to generate an action. This screen selection is
directly analogous to the SAS Primitive selection described in the Filtering section.
Type Properties
585 vE Type Event -
S,QTA Primikive Description
E;n;rrding Start Channels M Mtz WtzWiz W1z VW ia VT4
= Primitives <nathing selecteds
ATA Comnmand ACK r
SMP Fi
Data I;:F;eern AlP C
OO Signal ALIGH [0 -
BOB Input - TRIG ALER ) L
ot -
iy ALIGN [2) C
SCST Status ALIGH [3) r
SCSI Taskigmt Function BREAK -
5P Iljformation Unit EREAK REPLY nl
Ky hiedaily sRoAociST s B
CLOSE ke |0
CREDIT_BLOCKED -
DOME r
ECF -
ED&F r
ERROR r
HARD_RESET -
MU 1 -
RALINA 11 — LI
[s]4 | Cancel |
The detection of SAS Primitives can be limited to certain channels by selecting the
appropriate channels across the top of the screen, By default, all channels are selected.
All SAS Primitives are listed using a nested hierarchical structure, in which groups of
related primitives can be selected with a single checkbox, or the nested hierarchy can be
expanded by clicking on the [+] symbols to select individual primitives within a group.
Note: As with other screens, a shortcut method of selecting or deselecting
all channels or all primitives is provided by using CTRL-Click on any
checkbox.
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SATA Primitives

SATA Primitives can be selected in a similar manner, with the slight exception that the list
of primitives does not use a nested hierarchical structure.

Event Properties

Type Properties
|SAS Primitive Type Ewent -
L Description
@zMﬁwt Channels Wi WMTtiWiEz Wiz Wiz W1z Wia VT4
=l Primitives <nothing selected:
ATA Command ALIGN [0) Il
Data pattern SATA_SOF C
OO Signal SaTaA_EOF |
SMA Input SaTa_CONT -
BOB Input - TRIG SATA_DMAT -
SCSI Status SATA_HOLD C
gggII;?osrknTagtli-g;Fumetion SATA_HOLDA -
- SATA_PMACK r
e e e r
GaTa,_PMREC_P r
SATA_PMREG_S -
SATA_R_ERR -
SATA_R_IP -
SaTa_R_OK r
SaTa_R_RODY —
SaTa_SYNC -
SATA_WTRM
C‘A.TA._V =] ni ||: ;I

E

Cancel |

Timer

The timer event allows the user to insert a specified delay. The Timer event screen allows
the user to select a delay between 50 ns and 50 years, by selecting an appropriate value
from the dropdown menu.

Event Properties

Type Properties
SAS Primitive Type Event
SATA Primitive Description
Timer Walue 1 zec -

Recording Start

ATA Carnrnand

An example of how the timer event might be used is shown below. In this example, the
analyzer waits to detect a CREDIT_BLOCKED primitive, then beeps to alert the user and
triggers the analyzer. If the condition is not detected within 30 secs, the analyzer will
trigger to stop the test.

General] Channel Settings T riggering / Filkering l Ehannels]

Triggering)Filkering Options are walid,

[Global Pules]
Wait for CREDIT_ EBLOCEED
then EBeep (250 m=)
atnd Trigoger
Wait for Timer (30 sec)
then Trigoger
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Recording Start/State Entrance
In the list of events for Global Rules, this event is listed as "Recording Start", since Global
Rules have only one state and it begins at the start of recording. For sequences, this
event is listed as "State Entrance".
These events are used for special actions which the user only wants to occur once, when
the state is first entered. Some examples have been given earlier where the user might
want a beep as an alert when the system enters a specific state, but the concept is
general and there may be an entire list of actions that the user wants to occur when a
state is entered, but then not remain active while the system remains in that state.
The "Recording Start" and "State Entrance" events have no other parameters associated
with the event.
Type Properties
SAS Primitive Type Event
it Description
SMP Frame
FIS
The FIS Event allows the user to specify virtually any parameter associated with any
SATA FIS (Frame Information Structure). There are several types of FIS formats, and the
drop-down list under "FIS Type" allows the user to select the FIS format of interest.
Type Properties
SA5 Primitive Type Ewvent -
SﬁTP. Primitive Description
E;nceorrdin Start Channels FinMriVez FizFiz Mz W4 Fra
_ FegH-D
QI\T‘;: Eommand = RegH-:D Fields
rame .
Draka Pattern Featuies E:E gl'l%g
QOB Signal Command DM Activate
SMA Input C Cibdd, Setup
BOE Input - TRIG = BIST Activate
Error R PIO Setup
SC5T Status Data
SC5T TaskMgmt Function Reserved(d) Route
S5P Iljformation Unit Part endar FIS
g;;:?dgfi:;i:éime FIS Type Regizter Host to Device
Dev/Head
Cyl High
Cyl Low
Sector Mumber
Features(exp]
Cul Highlexp]
Cul Low(exp]
2ot Mmoo o
K | Cancel |
With the selection of the FIS Type, the fields associated with that FIS Type will appear as
a list below the type, and the user may enter any value for any of the defined fields.
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ATA Command

The ATA Command Event allows the user to specify any ATA command that might be
present in the data stream. Selecting this event type provides a drop-down list of ATA
Commands that can be selected.

Event Properties

Type Properties
SAS Primitive Type Ewent
SATA Primitive Description
Ti
mer Channels Wi WMTtiWiEz Wiz Wiz W1z Wia VT4

Recording Start

ATA Cammand

SMP Frame

[rata Pattern

QOB Signal

SMA& Input

BB Input - TRIG

Error

SiZ5T Skatus

SCSI TaskMarat Function
53P Information Unit
Identify Address Frame
Open Address Frame

hon - NOP

4

-NOP

h03 - CFA REQUEST EXTEMNDED ERROR CODE
h03 - DEVICE RESET
h10 - RECALIBRATE
h20 - READ SECTOR(S)
h21 - READ SECTORS w0 RETRIES
h22 - READ LOMG
h23 - READ LOMG W0 RETRIES
h24 - READ SECTOR[S) EXT
h2h - READ DMA EXT
h26 - READ DMA QUELIED EXT

; B

h23 - READ MULTIPLE EXT

hd - READ STREAM DMA EXT

h2B - READ STREAM EXT

h2F - READ LOG EXT

h30 -wWRITE SECTOR(S)

h31 -wWRITE SECTORS w0 RETRIES
h32 -WRITE LONG

h33 -WRITE LONG W0 RETRIES
h34 -WRITE SECTOR(S) EXT

h35 - WRITE DMA EXT

h36 - WRITE DA QUELIED EXT

h37 - SET MAX ADDRESS_EXT

h38 - CFA WRITE SECTORS WITHOUT ERASE
h33 -WRITE MULTIPLE EXT

kA UURITE STREARS MkdA BT

SMP Frame

The SMP Frame event allows the user to specify any SMP (Serial Management Protocol)
Frame. As with other frame descriptors, drop-down menus are supplied where
appropriate and the user may enter specific data values for appropriate fields in the frame

structure.

Event Properties

Type Properties
SAS Primitive Type Event
SATA Primitive Description
i
R?ceorrding ctart Channels FhiRrnFe FrzVie FizFa Ve
FIS Report General |T
ommand Frame Type Feport General
SMP Frame Fieport Mfg Info
Data Patharm = Report GeneralRequest DisE:over d
QOB Signal 3MP Frame Type Fepart Phy Enr Log
SMA Input Function Report Phy SATA
BB Input - TRIG Fesered Feport Route Info
Error
SCSI Status CRC Phy Control
S5 TaskMgmt Function
S5P Information Unit
P S
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Data Pattern
The Data Pattern event allows the user a generic way of defining a match to any part of
a frame, starting with the first Dwords that follow the SOF. This event will match values
a specific distance into the frame (number of Dwords) with the value(s) provided by the
user.
Type Froperties
SAS Primitive Type Ewent -
S:QTA Primitive Description
;'gforrding Skt Channels Wi WMTtiWiEz Wiz Wiz W1z Wia VT4
FI5 Start of Frame S0F
ATA Command El Data Pattern 4 of 512 hytes specified
Sl Duwiord #0 000000000
OOE Signal Dward #1
SMA Input [hword $#2
BCB Input - TRIG Diword #3
Error
ST Status Dword #4
SCSI TaskMarat Function Dword #5
S5P Inf kion Unik
Identl%;g.n;;rlglsjs Fl::ame Dyeord
Open Address Frame Diword #7
[hword #8
Dword #3
Diword #10
Dhword #11
Dhword #12
Dhword #13
Dvord #14
Dword #15
n?}:E[A HiC ;I
(a4 | Cancel |
OOB Signal
The OOB Signal event allows the user to specify either the occurrence or the completion
of the three OOB (out of band) commands, COMINIT, COMWAKE, and/or COMSAS.
Type Properties
SAS Primitive Type Event
S:QTA Primitive Diescription
ngorrding Start Chanrels i MTiVeE Fiz Fiz W1z Ve P14
FIS =] DOB Events <nothing zelected:
QI\T;; gommand COMINIT Detected i
Fame
Data Pattern COMIMIT Completed -
COMwWAKE Detected -
S Input COMWAKE Completed Il
BOB Input - TRIG COMSAS Detected -
SIS Skatus COMSAS Completed -
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SMA Input
The SMA Input event is used to detect triggers and other TTL transitions that occur on
the "EXT IN" connector at the rear of the unit.

Event Properties

Type Properties
SAS Primitive Type Ewent
SATA Primitive Description
Tirnet -
Recording Start =l Input Events <nothing selected:
Equalz 0 -
ATA Command Equals 1 -
SMP Frame P
Diata Pattern Posm\fe Pulze -
Q06 Signal Megative Pulse I
Any Pulse -
Eggrlnput - TRIG Positive Edge -
SCSI Status Megative Edge r
SICSI TaskMgrit Function Min Pulse Length Onz
53P Information Unit Wan Pulse Length 500
Identify Address Frame Sk rise end ns
Open Address Frame

Note that the TTL transition that occurs can be of several different types, including
remaining at a given value. In addition, there are minimum and maximum durations that
can be selected for each type of transition, ranging from 0 to 1.5 usec for minimum pulse
length, and from 0 to 25 usec for maximum pulse length.

BOB Input - TRIG

The BOB (Breakout Board) Input trigger events come from signals connected to the
Breakout Board (which is in turn connected to the analyzer via the Data In/Out connector
on the back of the unit). The BOB Input - TRIG events have identical parameters to the
BNC Input event described above, with the additional parameter that since there are two
separate triggers, an extra parameter (called "Trigger Source", with allowed values of
"Input 0" and "Input 1") is provided.

Error
The Error event is a series of errors that can be selected individually or in combination,
as shown below:

Event Properties

Type Properties

SA5 Primitive Type Ewvent

SATA Primitive Description

E;n;rrding Start Channels FinMriVez FizFiz Mz W4 Fra
FIS = Errars <nothing selectad:
ATA Command CRC Emor r

SMP Frame - -

Diaka Pattern Dlspénty Error -

00E Signal Invalid Symbol -

SMA Input Multiplex Errar -

BOE Input - TRIG Comma alignment Ermror -

551 Status Delimiter Error -

SC5T TaskMgmt Function 545 ALIGN Error [l

S5P Information Unit GATA ALIGN Erar [

Identify Address Frame
(Open Address Frame
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SCSI Status

The SCSI Status event allows the user to specify a number of high level SCSI conditions,
shown in the drop-down list illustrated below:

Event Properties

Type Properties
SAS Primitive Type Ewent
SATA Primitive Description
Ti
mer Channels Wi WMTtiWiEz Wiz Wiz W1z Wia VT4

Recording Start

ATA Command
SMP Frame

Data Pattern
QOB Signal

SMA& Input

BB Input - TRIG
Erraor

SCSI TaskMarat Function
53P Information Unit
Identify Address Frame
Open Address Frame

SCSI TaskMgmt Function
The SCSI TaskMgmt Function Event provides a series of SCSI task management
functions which can be selected from a drop-down list, as shown below:

Event Properties

G00D [+
G000

CHECK. COMDITION k
CONDITION MET

BUSY

INTERMEDIATE

INTERMEDIATE-CONDITION MET
RESERVATION CONFLICT
Obszolete

TASK SET FULL

ACAACTIVE

TASK ABORTED

Type Froperties
SAS Primitive Type Ewent
SATA Primitive Description
Ti
mer Channels Wi WMTtiWiEz Wiz Wiz W1z Wia VT4

Recording Start

ATA Command
SMP Frame

[rata Pattern
QOB Signal

SMA& Input

BB Input - TRIG
Error

SiC5T Status
SCST TaskMarnt Function
53P Information Unit
Identify Address Frame
Open Address Frame

SSP Information Unit
The SSP Information Unit event provides a flexible and powerful way for defining virtually
any type of SSP (Serial SCSI Protocol) event. Selecting the SSP Information Unit event
provides a screen that includes a drop-down menu to select the type of SSP IU, as shown

below:

Event Properties

ABORT TASK [+

ABORT TASK
ABORT TASK SET
CLEAR TASK SET

CLEAR ACA
GUERY TASK

Type Properties
SAS Primitive Type Ewent -
SATA Primitive Description
Ti
mer Channels Wi WMTtiWiEz Wiz Wiz W1z Wia VT4

Recording Start

ATA Command

SMP Frame

[rata Pattern

QOB Signal

SMA& Input

BB Input - TRIG

Error

SiZ5T Skatus

SIZSI TaskMgrit Function
Formation Linit

entify Address Frame

Open Address Frame

COmMMAND [+

= 55P Headsr [DATA

Frame Type FER RO

Hashed Destination SAS Address RESPOMSE

Reserved TaSE

Hashed Source 545 Address AN

Reserved

Reserved

Reserved

Fietry Data Frames

R atranemit
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The screen also includes a complete list of fields in the SSP frame, allowing the user to
specify values for specific fields. Scrolling down this list reveals the COMMAND Fields
parameter, as follows:

Laung s

E COMMAND Fields 0 of 512 bytes specified "
R

[TIM THN

Clicking on the gray box on the far right brings up a screen where individual bits can be
mapped into specific command field Dwords, either as a bit pattern or as Mask or Match
Fields (Hex).

Data Pattern

azk ha
.............. WIS | T TR T TR (R j
Dwerd 0 [ R R R R AR AR AR A X% [00000000] [000

|||||||||||||| LLnlN |(LC|)) P S S S S S A S S S SR L L L L 1 L L
Dword 1 [ R R R LR AR LARIAXILEE] (00000000 [000
) IRelselr\reld L 4E Task Prin, Task ) IRelselr\reld L {\dldltllor:al O Res.y

1 1 1 1 1 1 1
wmﬂ|XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX||OOOOOOOO||OOO

1 1 1 1 1 1 1
Dword 3 [ R R R R AL ARIAXLLEE] (00000000 [000

Drata Dwword

1 1 1 1 1 1 1
wmﬂ|XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX||OOOOOOOO||OOO

Diata Dward

L L L L 1 L L
Wmﬁ|XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX||OOOOOOOO||OOO

Drata Dwword

L L L L 1 L L
DuordB [ R R K K R AR KKK AKX ] (00000000 [000

Diata Dward

||||||||||||||||||||||||||||||| 1 1 1 1 1 1 1
Duord 7 [ R R AR RRARIREE] (00000000 [000

Data Dword

1 1 1 1 1 1 1
mmw|XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX||OOOOOOOO||OOO

Diata Dward

L L L L 1 L L
Wmﬂ|XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX||OOOOOOOO||OOO

Crata Dwword OK |

1 1 1 1 1 1 1
Dmmm|XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX||OOOOOO?O||Oqgﬁj Cancell

1]
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Identify Address Frame
The Identify Address Frame event provides a list of fields which can be edited to match
with specific values provided by the user. Some fields (such as device type) reveal a

drop-down list of defined selections for that field.

Event Properties

Type Froperties
SAS Primitive Type Ewent -
?:QTA Primitive Description
ngnceorrding Skt Channels Wi WMTtiWiEz Wiz Wiz W1z Wia VT4
= Fields 1 of 32 bytes specified
ATA Command Restricted
SMP Frame Device T
Data Pattern evice 1 ype
QOB Signal AF Frame Type =0
SMA Input Restricted
BB Input - TRIG FReserved
Error
SCST Status SSP_l
SCSI TaskMamt Funiction STRI
53P Infarmation Uni
Identify &ddress Frame SMP‘.l
Open Address Frame Restricted
Reserved
S5P_T
STR_T
SHP_T
Restricted
Restricted
Restricted
545 Address (HI)
CAC Addrman 1171 ;I

oK | Cancel |

Open Address Frame
Similar to the Identify Address Frame event listed above, the Open Address Frame event
provides a list of fields which can be edited by the user, with helpful drop-down menus for
fields with defined selections (protocol and connection rate).

Event Properties

Type Properties
SAS Primitive Type Event
?:QTA Primitive Description
imer
Recording Start Chanrels i MTiVeE Fiz Fiz W1z Ve P14
FIS = Fields 1 of 32 bytes specified
ATA Command | Part
SMP Frame FT po—
Data Pattern rotaeo)
0OB Signal AF Frame Type 0x1
SMA Input Features
BOE Input - TRIG Corm Bate
Error
SCSI Status Tag

S5 TaskMgmt Function
S5P Information Unit
Identify Address Frame

Open Address Frame

Destination 545 Address [HI]

Destination 545 Address (LO)]

Source 545 Address [HI)

Source SAS Address (LO)

Acc Zone Magmt

Src Group 1D

PB_Cnt

A Time

More Compatible Features

CRC

Ok | Cancel |
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Actions

Once any event (or set of events) has been
identified, the next step is to define an action (or
Type a set of actions) that result from the event(s).
There are several actions which can take place,

;:Er?fl: ko Existing State as shown in the list to the left. (Note: The

Branch ko Bew Stake actions "Branch to Existing State" and "Branch
Beep to New State" are shown only when building a
3MA Cubpuk sequence, in which multiple states are allowed.

BOB Output - TRIG If building Global Rules, these options are not

shown, since Global Rules have only one state.

Trigger

The Trigger action is the most common endpoint of the majority of scenarios. Triggers
work in combination with other settings previously described to determine what data is
actually captured and retained in analyzer memory. Triggers work, in effect, to stop
recording, but depending on the settings for the trigger position, recording may not stop
immediately when the trigger is issued.

The Trigger action has only one parameter, which is the number of time the action must
be called before the trigger is issued. This allows the scenario to trigger, for example, on
the 10th instance that the specific event occurred. The number of occurrences can be
selected from a list of options provided in the drop-down menu.

Action Properties

Type Properties
[Type | Action
Branch to Existing State Description

Branch to Mew State

After Mth occurence -

BOE Output - TRIG

Branch to Existing State

This action is shown only for sequences, not for Global Rules which can contain only one
state. The Branch to Existing State action provides a means for branching and looping
within a scenario between different predefined states.

Action Properties

Type Froperties

Type Action
Description

Beep After Nth occurence 1
SMa Output Destination State <unknown state> [+
BOB Output - TRIG <urknown states

State 0

State 2

The option of an "unknown state" is provided as a temporary means to include a branch
to state which has not yet been defined, but if this option is selected the Triggering/
Filtering screen will identify this as an error in the script until the new state is defined and
the user returns to and corrects this "dead end".

Also note that the option is provided, as with all actions, of the event needing to happen
multiple times before the action actually occurs.
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Branch to New State

This option is shown only for sequences, not for Global Rules which can contain only one
state. The Branch to New State action is similar to the Branch to Existing State action
defined above, however this option automatically create a new (but empty) state in the
scenario. If there are currently "n" states in the scenario, the new state will be "State N"
(because states always start with State 0).

Beep

The Beep action produces an audible beep to alert the user to various events that have
occurred. The beep can be specified as a duration of 250 ms or of 1 sec. Multiple beeps
could be created in a sequence by branching to a new state which waits for a short time
and then issues a second beep.

SMA Output

The SMA Output action produces a signal to an external device. The type and duration
of the signal can be controlled by the parameters listed in the action, as follows:

Action Propetrties

Type Properties

Trigger Type Action
Branch ta Existing State Description

Branch to Mew State

Beey Every Mth occurmence 1

Output Action Toggle |T
BOB Output - TRIG Pulze Length |Falling Edge
Rising Edge

Send Megative Pulse
Send Positive Pulse

The signal created by the SMA Output action appears as a TTL level signal on the "EXT
OUT" connector at the rear of the Avalanche unit.

BOB Output - TRIG

The BOB (Break Out Board) Output -TRIG action produces a TTL level signal on one of
the two outputs on the breakout board (which is connected to the analyzer via the Data
In/Out connector at the rear of the unit). The parameters associated with this action are
identical to the BNC Output action described above, with the addition that since there are
two outputs on the breakout board, there is an additional parameter of "Trigger
Destination" with the allowed values of "Output 0" or Output 1".
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Recording Options - Channels

The Channels page allows the channel names to be customized. To change a channel
name, select the channel, then click the edit button and enter the new text, then click OK.
Once the options are set, the analyzer will update the open trace and all future traces with
the new channel names.

x|

Genarall Chaninel Setlingsl Fiecording Rules  Channels I

Channel | Channel Mame |

Exdit Restore Defaults

Save... | SaveAsDefau\tl Load... | 0K | Cancel |

Note: You can also change channel names by clicking on the first cell of a
trace (the channel cell) and selecting Rename Channel from the
pop-up menu.

Where Custom channel names appear in three places:
Custom ® The trace itself

Channel

Names * Link Tracker window
Appear * Bus Usage window
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Custom Channel Names in the Trace - Custom channel names do not appear right
away in the trace: the original names continue to display. To see the custom channel
names, click in the first cell of the trace (the channel cell) and select Format from the
pop-up menu, then select Custom.

DORE (M
k258.5 D30.0

Rename Channel S
CLOSE (I

Color g Custom

Hide k25,5 D020

—

The custom names will then appear in the trace.

1 Frame
32 985.000 ns 00.000 035 567
985.000 ns 00.000 035 567

Custom Channel Names in the Link Tracker Window - The Link Tracker window will
automatically show custom channel names as soon as they have been customized.

Link Tracker - Frame # 0

Channel I1 renamed as Init 1.

Lo B
| E[pe s & @ | | & 55 10b RD | Temt
| Time | Packet# | Init_1 T1
00.000 000 000 0 (Init_1]
00.000 000 026 [EE RN YU Features | 3 Gbp:
00.000 000 053 Destination SA5 Address
00.000 000 073 | Destination SAS Address |

Custom Channel Names in the Bus Usage Window - Custom Channel names
automatically appear in the Bus Usage window as soon as they have been customized.
The easiest way to see this is to open the Bus Usage window and then to open the
Properties dialog for the window. It will list the custom channel names.
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To open the properties dialog box for the Bus Usage window, right-click in the window,
then choose Properties from the pop-up menu.

Graph area properties 1]

Frarne lenc rinel Init_1 Title: Appearance

]_Frame Ienlh an Channel T1 IFlame length on Channel Init_1 ILlne j
Birame :eng:: on E:anne: IT22 Type: Color:

1ame length on Channe
tFrame Ienglh on Charinel 12 IFrama length over time from initiator on channel 1 j !\ Ij

]_Frame length on Channel T3 — Filter out
LFrame length on Charnel 14 i~ Event Groups

LFrame length on Channel T4

[ ]Primitives
[]5ource Addreszes
[ ]Destination Addresses

Packet Types

Priritive
O0B Signal
Open Address Frame

[10ata Length Idertify Address Frame
[C1SMP Frames ga’;?ﬁa?;

[C155P Frames Connect

[IChannels Disconnect

[CIFIS Types STP Frame

' Hide selected items

€ Shaw selected items

Mew | Delete | Restore defaults

0K I Cancel Apply

Saving and Loading Recording Options

Once defined, a set of recording options cam be saved as a file on disk for later use.
Included in this file are all settings for all four screens that appear under the recording
options selection, including General, Channel Settings, Filtering/Triggering, and

Channels. Included in this information will be all filtering criteria, Global Rules, and any
defined sequences.

To save a set of recording options, have the recording options window open (with any
tabbed page showing), and click on Save... at the bottom of the screen.

Save... Save &z Detault Load...

Clicking on Save... will bring up a window allowing the user to name the file and navigate
to any folder that he wishes to use to save the file.

To reload a saved recording options file, click on the Load... button and select the file.

If you would like to define a set of recording options as the default for the system, once
the recording options are correctly defined click on the Save As Default button.
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Chapter 5: SASTracer Recording

Options

Recording options provide instructions for the analyzer hardware as to how a trace
recording should be captured. Included in these instructions are items such as how to
start or stop a recording, what information should be recorded, and trigger conditions that
can be used to automatically record certain data events (or sequences of events) when
they occur.

Since these instructions are specific to the hardware platform being used, there are
differences in the way the recording options are set up for the Avalanche system vs. the
SASTracer system. In order to present this information clearly, we have divided the
information into two Chapters in this User Manual.

This Chapter covers recording options for the SASTracer systems only. For
information on the Avalanche systems, see Chapter 4.

General Recording Options

From the Setup menu, select Recording Options (UPAS 10K)... . The following screen
is displayed:

Recording Options |

General I Channel Settings I Recording Rules I Channels I

— Recording Type 0 ption: — Mizc Information

& Snapshot I Truncate Data Pavload Dwords: I 14 UPAS 10000 Analyzer Platform

" Dl Tiames ™ Beep'when Trigger Ocours

£ Ewent Trigger

— Recording Scope

€+ Conventional Single Buffer Recording

 BufferSize———— Trigger Pasition———————————————
16.000 MB Mat used with snapshot
e e e LeCroy 3Gbps SAS/SATA Analyzer
. =l y
[T Save &z Multisegment Trace = B seaments [4-128]

" Spooled Recording
— Recording Size

% Fecord for Im

' Fecod [ 120000 1B

= Until Triggered, plus Im
= Until Triggered) plus [T 120000 MB

— Dptions Mame———— Trace Filename & Path
I[)eraun |7 C:\Program FilezhLe... \data.zas Browse... I

Usge the Recording Rules tab to gpecify Filtering and/or Triggering conditions.

Save.. I Save Az Default | Load... I Ok I Cancel

LeCroy Corporation

81



Version 6.25

SASSuite User Manual

Recording
Type

Options

Recording
Scope

Options displayed on the General page include the following:

* Recording Type
* (Recording) Options

* Recording Scope, including Buffer Size and Trigger Position for conventional
recordings, and recording parameters for spooled recordings

* Options Name
* Trace Filename & Path

* Misc Information

The Recording Type box presents three options that control how SASSuite begins and
ends a recording. The options are Snapshot, Manual Trigger, and Event Trigger.

Snapshot: A fixed-length recording. A Snapshot is a recording whose
size is set via the "Buffer Size" box. Recording begins when the Start
Recording button —.rL is clicked and ends when either the preselected
buffer size is filled 6rithe Stop Recording button LI is pressed.

Manual Trigger: A recording whose ending is triggered by pressing the
Trigger button on the front panel. Recording begins when the Record
button ® | is pressed on the Tool Bar. Recording continues in a
circular manner within the limits set by the buffer size. Recording is
ended by the user pressing the Trigger button on the front panel,
although in some cases recording may not stop immediately. Once the
Trigger button has been pressed, recording continues until the
post-trigger buffer has been filled (see Trigger Position below) or the
Stop button Ll is clicked on the Tool Bar.

Event Trigger: A recording whose ending is triggered by user-defined
events. Recording begins when the Record button # | is clicked on
the Tool Bar. Recording continues in a circular manner within the limits
set by the buffer size until a trigger event is detected and the defined
amount of data has been recorded after the Trigger event.

The options checkboxes appear on the upper right side of the General tab of the
Recording Options window.

Truncate Data Payload Dwords: Allows data payloads to be truncated
to whatever length is specified in the box. Truncating the payload limits
the amount of space each frame requires to be stored in the buffer,
thereby increasing the number of frames that can be recorded.

Beep When Trigger Occurs: When this checkbox is selected, the
computer connected to the SASSuite beeps three times to alert the
user when a Trigger condition is first detected.

Recording Scope presents two important options that affect the size or scope of the
recording. These options are Spooled and Conventional recordings. The Spooled option
enables very large recordings--for example, several hours. The Conventional option is
used for smaller recordings--for example, several minutes.
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Conventional Single Buffer Recording

In a Conventional recording, the trace is recorded and stored in the analyzer buffer before
it is uploaded to the host PC. Recordings are thus limited in size to the maximum size of
the analyzer buffer. If you are planning to create a moderate-sized recording, this is a
good option to select. You set the buffer size and the trigger position, then begin the
recording. Once the recording is complete, the traffic is uploaded to the host PC.

If you are planning to create a large recording or are planning to let the analyzer run over
a several days, then select Spooled Recording. In a Spooled Recording, traffic is
uploaded periodically to the host PC--thus freeing analyzer buffer and allowing the
recording to continue.

Buffer Size - The Buffer Size slide bar adjusts the
recording buffer size from 1.6 megabytes to 2048 MB.
This option is used for setting the maximum memory to be

used for a Conventional recording. — :I

The option mentioned above for truncating data payloads,
as well as filtering options which will be discussed later,
determine what information from the raw data stream is actually recorded into trace
memory. Also, although there are 2048 MB of physical memory in the SAS Tracer
analyzer, there is additional information recorded with each frame, such as timestamps
and other system parameters, so the efficiency of the recording ranges from about 37%
in the worst case to 75% in normal traffic and higher when packing is possible (ratio of
physical memory to actual SAS or SATA traffic).

Buffer Size
16.000 kB

Note: The Buffer Size slider bar is not linear and affords more granularity in the
smaller buffer sizes.

Trigger Position - The Trigger Position slider bar

allows the user to define the position of the trigger [RECEE -
within the recorded traffic. Essentially, this is 40 % post-triggening
instructing the system when to stop recording. If the R
trigger position is set to the end of the recording, _

recording will stop immediately when the trigger
occurs. If the trigger is set to the start of the recording,
when the trigger occurs the system will continue to record until the buffer has filled again
and then stop (before the new data overwrites the trigger). Any intermediate setting
allows the user to see data both before and after the trigger occurred. You can adjust the
Triggering Position between 1 and 99% post-Trigger. Trigger Position is available only
when Manual Trigger or Event Trigger is selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following Trigger Position
settings, the amount of pre- and post-Trigger data is:
* 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger
* 75% post-triggering: 4MB pre-trigger, 12MB post-trigger
* 50% post-triggering: 8MB pre-trigger, 8MB post-trigger
* 25% post-triggering: 12MB pre-trigger, 4MB post-trigger
* 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger
Note: When a Trigger occurs, recording continues until the post-Trigger
amount of the buffer is filled.
Note: The buffer is limited to 1 GB when in trainer mode/configuration.

LeCroy Corporation

83



Version 6.25

SASSuite User Manual

Save As Multisegment

Trace ¥ Save iz Mulisegment Trace I—E‘qu ME zegments [4-128]
This option causes the analyzer

to segment the trace into multiple files and create an index file called data.mit that
summarizes the starting and finishing frame for each segment.

This option is useful for very large recordings and for host PCs with limited memory. In
the latter case, multi-segmenting gives a PC with limited memory a way to open
recordings that would otherwise be too large to open.

The only downside to multi-segmenting is that limits the scope of reports such as Traffic
Summary, Bus Utilization, and Error Summary to each of the segments. You will not be
able to perform summary statistics on the full recording.

The default value for this option is 10 MB. Before attempting large recordings, it is
recommended that you adjust this number to see what value best suits your needs.
based on the capabilities of your host PC.

To create a multisegmented trace,
Step 1 Check the box marked Save As Multisegmented Trace.
Step 2 Set the file size for each segment in the box marked MB Segments.

File Structure for Segmented Files

Multisegmenting produces an index file and subordinate trace files. The default name of
the index file is dataXYZ.smt, where XYZ is the last three digits of the analyzer’s serial
number. (You can see the unit’s serial number by selecting Help > About SASSuite)
Thus, for example, if you had an analyzer with the serial number 111, the index file would
be called data111.smt.

The index file and the segmented trace files are stored in a directory named after the
index file. The directory is named indexfilename_smt_files. For example, if the index
file is named data111.smt, the directory will be named data111_smt files. Below this
directory additional, sequentially numbered sub-directories (up to 100,000) that house
the segmented trace files. These sub-directories bear simple numerical names: 00000 -
00999. Each of these subdirectories can hold up to 100 sequentially-numbered segment
files. Collectively, the entire directory structure can hold up to 10 million files.

Example

A 1010 MB recording using 10 MB segments and the default file names will create the
following sub-directories and files. The example below uses the serial number 111:

¢ data111.smt This is the index file.
¢ data111_smt_files\00000\segment_00000.sas
¢ data111_smt_files\00000\segment_00001.sas

¢ data111_smt_files\00000\segment_00099.sas
¢ data111_smt_files\00001\segment_00100.sas
¢ data111_smt_files\00001\segment_00101.sas

The index file looks something like a trace file but contains packet-like entities that
summarize each 10 MB segment.
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J File Setup Record Generate  Report  Search  Wiew  Tooks  Window  Help

-

| x

|lzarpae(piE st 222w 8e

[rmuwm@0R0000] & BEEE | ]

Start Frame # Murm Frames
612484

Duration Time Stamp
24.032 ms 00 : 00 : 00. 000001 192

Start Frame # Mum Frames Duration Time Stamp
:00:00. 0240331587

Start Frame # Murn Frames Duration Time Stamp
1224973 612484 24.030 ms 100 : 00 . 048 062 592

Start Frame # Mum Frames Duration Time Stamp
100 00. 072093 062

Start Frame # Murn Frames Duration Time Stamp
2449945 F12484 24.031 ms :00:00. 0965122 185

K1

o

]

Ready [ I I

search: Fd

When uploading is complete, the index file will be opened. Each "packet" in this file
corresponds to one of the numbered segments. Double clicking on the packet will open

the corresponding segment file.

Multisegment Toolbar

When an index file is opened like the one shown above, the
Multisegment Toolbar will display. This toolbar lets you navigate the
index file.

|4 Open first segment in
multisegment trace.

P Open previous
segment in
multisegment trace.

i |Open index file. This
i button becomes active
if a multisegment trace
file is open.

> Open next segment in
multisegment trace.

> Open last segment in
multisegment trace.

Spooled Recording

(Ea |

In a Spooled recording, uploading commences when the recording is begun. As traffic is
uploaded from the analyzer to the host PC, the analyzer memory is freed, creating space
for recording additional traffic. Recording can thus continue for long periods of time, and
create file lengths well in excess of the actual physical memory in the analyzer. However,
an issue to be aware of with any spooled recording is that the actual spooling process is
typically slow in comparison to the potential recording speed of the analyzer. So unless
the recorded traffic is intermittent or heavily filtered, it is possible for data to be lost if the
the spooling process does not keep pace with the recording process. This produces

"gaps" in the resulting data, which are identified in the data file.
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Recording Size
With Spooled Recordings, you are given the option of setting the recording length based

on time or on the recording size.
Record for - Enter the duration of the recording in days, hours, minutes, and seconds.

Record - Enter the amount of traffic (in MB) that you want the analyzer to record.
Selecting this option will create a fixed length recording that begins as soon as you click
the REC button on the menu bar.

Until Triggered, plus - Enter the amount of traffic (in time) that you want the analyzer to
record following an event trigger. Recording time units are days, hours, minutes, and
seconds.

Until Triggered, plus - Enter the amount of traffic (in MB) that you want the analyzer to
record following an event trigger.

You select event triggers in the Recording Rules page -- see “Recording Rules” on
page 88 for details.

Spooled Recordings - Performance Issues
During a spooled recording if the analyzer buffer fills faster than the trace can be
uploaded to the host PC, the analyzer will briefly suspend recording until some of the
buffer is free. When recording is suspended, gaps will appear in the trace. These gaps
will | appear as in the trace
% nmﬁiw 0!
m nzzamcz

Time.

Durmg the recording, you can see |f gaps are Ilkely to happen by reading the status bar
at the bottom of the screen.

FCTracer SN:111 | Triggered & Spooling | 27MBytes | som 0 | gape 2 Actvi: [ Hardware Buffer |

Ready I [to Al

The Status bar has two fields that you can use to determine if gaps are occurring or are
about to occur.

Gaps - Shows how many gaps have occurred. In the example above, two gaps have
occurred.

Hardware Buffer - shows you how full the analyzer buffer is and if the analyzer is
currently dropping packets. In the example above, Hardware Buffer field shows that the
buffer is full (shown by the thick green graph) and that the analyzer is currently dropping
packets (shown by thin red line atop of the green graph.)

Preventing Gaps

Gaps can be caused by a number of factors - the number of channels being recorded,
the absence of filtering, the performance of the host PC (for example, is it using USB 2.0
to upload traffic?), and the amount of traffic produced by the devices under test.

There are several ways to prevent gaps. You will need to experiment with your setup to
determine what works best for you. You might try filtering out primitives, turning on data
truncation (for example to 10 DWords) and filtering out LISMs. If you want to record
primitives, it is recommended that you enable primitive packing.
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Channel Settings

Speed
Settings

Channel
Settings

The Channel Settings page lets you to set speed, descrambling and packing options for
each channel. It also lets you inhibit channel recording.

Hecording Uptions #.9
General Channel Settings l Recording Rules } Channels I
Speed Settings
Links

1 2 3 4

Auto Detect Link Rate  (» IO O s

150G/ Link Rate () i o

300G Link Rate r 9l @

Channel Settings

Channels
3T 12 T2 13 73 14 T4

Inhibit u m wmw(E (e
MoDescrambling [ [ [ [ I [ [~ T
Mo Packing o m mm B8 ==

The SASTracer systems support Autodetect Link Rate which is designed to pass through
the speed negotiation signaling allowing the initiator and device to determine the link
speed using the method defined in the SAS specification. In general, this is the most
convenient setting to use because it ensures the traffic will get recorded at the negotiated
rate. Alternatively, users may force the analyzer to record at the 1.5G or 3G rate.
However, if the negotiated link speed is higher or lower than the speed selected in this
tab, analyzer will not decode the traffic properly (there will be errors in the trace). The user
will know if devices are negotiating successfully by getting clean recordings.

These options allow you to inhibit recording and turn off scrambling and packing on a
channel by channel basis.

Inhibit - Inhibits recording of traffic from selected channels. For example, if you check
the option for T1, it means "record all channels except for Target channel 1 (T1)."

No Descrambling - Turns off the analyzer’s descrambling from the selected channels.
Select this option if your DUTs are not scrambling their traffic.

No Packing - Turns off primitive and idle packing from the selected channels.

LeCroy Corporation
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Recording Rules

The Recording Rules page lets you set triggers and filters. The page divides into following

areas:
Recording Options 5 x|
fieneral | Channel Setings  Recording Rues | Channes |
— Rule
- I
Toolbar Sreween M| 0| @[5 - Status
I e et Fvem | Indicator
g Frimitive
Available =T Error RIGGER
Events | = oo
- / Sequencing
Cell
Global _—"" |
State

save. | SavehsDelad | Losd | Cancel |

» Toolbar - Contains buttons that control the Recording Rules page.

+ Available Events area -- Part of the screen where you can park
buttons that you intend to use in the Global State Cell.

» Global State Cell -- Part of the screen where you create trigger and
filter conditions. You create conditions by dragging event buttons from
the Available Events Area into the Global State Cell and then assign
actions to the event buttons.

* Sequence Cell -- The inactive cell marked by the faint text Drag an
event here to add a new sequence. Once an event button is placed in
this cell, the cell becomes active. The Sequence Cell is used to create
event sequences - chains of events leading to an action: If x followed
by y followed by z occurs, trigger. Event Sequences are created by
assigning the action Advance the Sequence to the links in the chain
and trigger (or some other action) to the final event.

* Rule Status Indicator - An indicator that shows the validity status of
the current set of recording rules. When the rules are correct, the
indicator will display the text Config is valid. When incorrect, the
indicator will turn red and display the text Config is Invalid.

*  Pop-up Menus (not shown) - Right-clicking on button or area in the
Recording Rules page will access a context-sensitive pop-up menu
containing most of the commands listed in the toolbar.
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Recording Rules Toolbar

The Recording Rules toolbar exposes functionality for controlling the Recording Rules

page.

wll Mlew event

New Event. Opens a menu of events. Selecting an
event causes an event button to appear in the Available
Events area.

Delete Event. Deletes selected event button.

Undo. Undoes last change made to Recording Rules
page. The undo buffer has unlimited depth.

Redo. Repeats changes undone by the Undo button.

IR §

Zoom In. Enlarges the display. There are five zoom
levels. The default level is the middle one. If you have a
wheel mouse, you can also zoom by holding down the
Control key and then operating the mouse wheel.

Zoom Out. Makes the display appear smaller.

@ o

Show/Hide channels. When pressed, this button tells
the Recording Rules dialog to show the channel buttons
on the Events icons. When unpressed, the channels are
hidden.

Show/Hide Properties Dialog. Shows or hides the
Properties dialog of the selected State/Event/Action.

Config is valid. This message displays when the current
Recording Rules configuration is valid and can be
executed by the hardware. This message gets updated
every time the Recording Rules configuration changes.
When the configuration is incorrect, the message is
replaced by "Config is invalid."

Config is invalid. This message displays when the
current Recording Rules configuration exceeds
hardware limitations. You can click the indicator to get
the diagnostics message box to find the problem.

LeCroy Corporation
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Recording Rules Page - How it Works

The Recording Rules page can be thought of as a chalk board where you create a
graphical model of the events and actions. In essence,
you are creating a visual representation of the rules that
the analyzer should follow during a recording.

wl New event

N oo
Frames 4 Primitive
You can create simple or complex rules. zij‘;lsd X
Creating a rule involves three steps: ATA Cemmands
Bus Conditions and QOE Signals
Step 1 Select one or more events. frrers

Breakout Board Data

Step 2 Select the channels that the analyzer Tner
should record. ' '

Step 3 Assign an actions to the events. o Mewevent

| Avnailable Events |

Selecting Events are selected from the New Event menu:
Events Step 1 Click the New Event button.
[frifefrafefrfijri
A menu of Events and Event categories displays.
Prim. Categary
Step 2 Select an Event from the menu. Once a selection IEEBEEDEDD
has been made, an Event button appears in the
Available Events area. The Available Events area is an inactive part of
the window where buttons can be parked for future use.

Selecting a At the bottom of each event button are small buttons that represent analyzer channels.

Channel on  Selecting a channel button tells the analyzer which channels to monitor for trigger and

an Event filter events.

Button Note that deselecting a channel button does not stop the recording on that channel - it
merely disables actions such as triggers on the channel. Thus, if you had set the
analyzer to trigger on an error but had deselected channel T1, the analyzer would record
traffic on all channels (including T1) but would ignore any error that occurred on channel
T1.

To turn off recording for individual channels, use Inhibit Recording option in the Recording
Options > Channel Settings page. This option will prevent traffic from being recorded into
the trace.
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Assigning an Action

Assigning an action tells the analyzer what to do when it has found the
targeted event. If you do not assign an action, the analyzer will look for
the event but do nothing once the event has been encountered.

Assigning an action is a two-step process: first, move an Event button
from the Available Events area on the left to one of the two cells in the
center of the window. Then, right-click on the Event button and assign

an action.
Dragging a  The center of the PR
Button to Recording Rules - >
the Global window is where rules nnEEEDD
State Cell or  are defined. To create To activate an Event button, drag it to the
Sequence a rule, you must drag Global State Cell.
Cell an Event button from

the Available Events area on the left to one of the two cells in the center
of the Recording Rules window. The cells in the center control the
duration of the rule: rules created with the Global State Cell are always
enabled, while rules created in the Sequence cell are conditionally

enabled.

The Global State Cell - The Global

State Cell tells the analyzer what @)

events to look for throughout the entire !,

recording. The cell is called a "Global %
State" because the conditions you ShiP
define in the cell are always active. SR —E
You can place several events in this Lol ol —

cell. Doing so tells the analyzer to look This configuration reads
for all of the events all of the time. For  "trigger if any of these events
example, you could place three events occur."

in this cell and have each cause a
trigger. Such a configuration would read "If any of the events occur,
trigger."

Sequence Cell - Sequence cells are marked with the faint text Drag to
add a new sequence.

The Sequence Cell is
used to create event
sequences. An event
sequence is a chain of Prim. Category
events leading to some
action. Forexample, "If —
x is followed by y and nnEEnEon
then by z, trigger."
Events linked in a chain
are looked at
sequentially. Thus, at
any given time, the analyzer is often only be looking for a single event
out of the several that might be in the Sequence cell.

Ml BEQE0G

An event sequence. This reads "If a primitive
is followed by an error, then trigger.”
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There can be up to 255 events linked together into a sequence. Only one sequence can
be created.

When two or more events have been moved into a Sequence cell, they can be linked into
a sequence by assigning the action Advance the sequence to events in the chain. The
last event in a sequence is then usually assigned the action Trigger.

There are two ways to assign an action to an event button:

¢ Right-click on an event button and select Specify Action from the pop-up
menu.

* Double-click on the event button and then select an action from the
Properties dialog box.

Assigning an Action from the Pop-up Menu
To assign an action to an event button via the pop-up menu,

Step 1 Right-click on the button. A pop-up menu appears:

Error NO ACTION
DIEEDED

Trigger

Add Courter... Filter In
Move Event Ta 4 iz Gt
Copy Event To 4 Restart Al
i Delete This Event External Trigger Pulse HIGH
PropeT External Trigger Pulse LOW

External Trigger Pulse TOGGLE

Properties...

Step 2 Select Specify Action and then an action from the sub-menu. The
menu closes and the action is assigned.

Error TRIGGER
DIEEDEDT
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Assigning an Action via the Properties Dialog Box

Step 1 You can also assign actions to event buttons via the Properties
dialog box. Double-click on an event button to open the
properties dialog box.

E|
Error |Aclions| ﬂl
Lo efraf ofrs] wfrd]

[~ Packet Type

[~ Align Frequencey
Label I" CAC
lE”O'— [ Disparity

" Delimiter
Channels: (! [ Symbal Encoding
[~ algnment
™ Count IE—
™ NOT
[Match an the opposite
of this ewent]

|Desc: Any occurence on channels T1.12, or T2 of any of the selected Emor

Step 2 Select the Actions tab.

Step 3 Assign an action.

See “Types of Properties Dialog Boxes” on page 97 for further
details on Properties dialog boxes.

Global State (active at all times)

Etror % Global 5 we at all times)
I i [ i i i New Event 3
Properties...

Error

Specify Actionis) 3
Add Courter...

Move Event Ta »

Copy Event To 3

i Delete This Event

Properties...
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Types of Pop-up Menus

Global State
Cell and
Sequence
Cell Pop-up
Menus

Event
Pop-up
Menu

The pop-up menu are context-sensitive and will display different options depending on
the object you have clicked.

If you click on the Global State Cell or Sequence Cell (but not one of the buttons inside
them), you will get the following pop-up menu:

New Event - Brings up a menu of Event types. This is the same menu that appears when
you click the New Event button on the toolbar.

Properties - Brings up the State Properties dialog for the selected state.

If you click on an Event button, you will get the following pop-up menu:
Specify Action(s) - opens a sub-menu with the following options:

» Trigger - Triggers end of recording. Recording continues until post-trigger
buffer is expended. Buffer settings are controlled by the Recording Options -
General page.

» Filter Out - Excludes selected traffic from recording. Filtering preserves
recording memory, thereby extending recording sessions and excluding
events of little interest.

+ Advance the Sequence - Appears only in Sequence Cells and is used to
create event sequences. Tells the analyzer to look for the next event in the
sequence.

+ Filter In - Includes selected traffic in recording.

» External Trigger Pulse HIGH - Sends an output signal with a Pulse High
format through the output ports on the back of the CATC 10K. Pulse High is
the default format. Pulse High causes the analyzer to transmit a 5 volt, 40
nanosecond signal.

» External Trigger Pulse LOW - Sends an output signal with a Pulse Low
format through the output ports on the back of the CATC 10K. Pulse Low
causes the analyzer to transmit a 0 volt, 40 nanosecond signal.

» External Trigger Pulse TOGGLE -This format causes the analyzer to
transmit a signal that will toggle with each trigger event between a
continuous 5 volt signal and a continuous 0 volt signal.

Add Counter - Displays the Event Properties dialog with the Counter selected and ready
to accept the count value. The menu item is not shown if the counter is not applicable to
the selected event. If the counter is already specified this menu item is replaced with
Don’t Use Counter and Change Counter Value.

Move Event To - Moves selected event to a different position in the Recording Rules
window.

Copy Event To - Copies selected event to a different position in the Recording Rules
window.

Delete this Event - Deletes the selected Event. Alternatively, you can use the Delete
button on the toolbar or keyboard to delete events.

Properties - Opens a dialog box and lets you specify further sub-types (for example,
types of errors) and additional conditions for the selected event.
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Action
Pop-up
Menu

If you click on an Action button, you will get the following pop-up menu:

Trigger - Sets or clears Trigger action.
Filter In - Sets or clears Filter In action. This

R action(s
,T Trigger
Filter In

Filter Ouk
Restart All

External Trigger Pulse HIGH
External Trigger Pulse LOW

External Trigger Pulse TOGGLE

Properties...

Global State Cell.
Action menu for event in

Trigger

Filker Qut:

v Advance the Sequence
Restart Al

External Trigger Pulse HIGH

External Trigger Pulse LOW

External Trigger Pulse TOGGLE

Properties...

Actions menu for event in
Sequence cell.

Filter Out - Sets or clears the Filter Out action

option precludes the use of Filter Out.

. This option precludes the use of Filter In.
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Restart All - Restarts any sequences or counts you may have set on other buttons. The
example on the right illustrates how the Restart All action works. This example reads
"Look for a sequence of five SSP Frames and then trigger. If, however, an Error occurs
any time before the fifth SSP frame has occurred, restart the count".

L ZEP
Jufriefrz] afrf i frd] & MNew event ;
Count 5 Primitives 3 Primitive Categories
Errar Frames 3 rimitive |
(rifefr] ojfu SCS1 Commands » —
Restart example. In this configuration, SATAFIE g
the analyzer will restart its search for a ATA C”":"a”ds } |
sequence of 5 SSP frames if an error is zus coneiens endiaoe sgna
encountered. e
(-~ Breakout Board Data
Timer
Frim. Category
I ] [ i B il [ i)
NOP
%
EIE]EZE'ER!E!
Second restart example. In this
configuration, the analyzer will restart
its search for the above sequence of
events if a SCSI command is found.
External Trigger Pulse HIGH, Pulse LOW, Pulse TOGGLE - Causes the event send an
external signal out through the External Out port on the back of the CATC 10K. The
shape of the signal (Pulse HIGH, Pulse LOW or Pulse TOGGLE) must be the same for
all events sending out such signal. This means that if you change the output signal for
one event, it will automatically change the signal for all other events sending output
signals.
Properties - Displays the Action Properties dialog for the selected state.
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New Events Menu

To add new Event buttons to the Available Events area, click the New Events button. A
menu opens with the following categories:

* Primitives

* Frames

¢ SCSI Commands

* SATAFIS

* SSP Frame Header
* SSP Information Unit
* ATA Commands

¢ ATAPI Commands

* SATA Data Pattern

* SAS Data Pattern

¢ Bus Conditions and OOB Signals
* Errors

* Breakout Board Data

* Timer

Types of Properties Dialog Boxes

Each cell and button has a properties dialog box that allows refinement of the options
being set.

Properties dialog boxes can be opened by:
* Double-clicking a button or cell.
* Right-clicking a button and selecting Properties from the pop-up menu.

¢ Clicking the Properties button on the toolbar.

Properties dialog boxes exist for all items in the Recording Rules page: the event
buttons, action buttons, Global State cell and Sequence cells.
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Properties
Dialog Box -
General
Features

Properties Dialog boxes share several features: an Icon preview, a Label Icon, Channel
Settings, Negation, Counter, a Pin button, and a Descriptive String.

- .
Event -
ik 551 Conmand ]Amﬂ\ = Button
Preview [HEEREDD

ERASE(10] =
ERASE(12]
FORMAT UNIT
lcon Labet LOCK-UNLCK CACHE(10)
s LOCK-UNLCK, CACHE(16)
Label —— |SEIREEE WEDIUM SCAN
PRE-FETCH(10)
es B ;EEE:TE[;L»C:":\%BTJW o N~_Actions
Channels READ CAPACITY(1E) Options
Counter — [ Cowt [F | [PEADDEFECT DATAND) =

Negation— I NOT

[Match on the opposite
af this event)

Description
String

|Desc’ Any occurrence on channels T1, 12, or |2 of arw of the selected SCSI Command

Specific EventSettings

Icon Preview - The Icon Preview shows what the button currently looks like. If you make
changes to the Channel settings or the Icon Label, these changes will immediately
display in the Preview.

Icon Label - A text box for labeling the button. Whatever is typed here will appear on the
button.

Channels - These controls allow you to select the channel(s) that the analyzer should
search when it is looking for the event.

Counter - A counter tells the analyzer to search for x instances of the selected event. For
example, if you enter "10," the analyzer will count 10 instances of the selected event
before it performs whatever action you assign. There are only two counts available in the
hardware so if you try to assign more than two, you will get a warning.

Note: Counters can not be applied to events with Filter Actions. The maximum
counter value is 65,535.

Negation - Tells the hardware to match the opposite of the event. For example, if you
select NOT for Errors Event, the match will occur on Error types that are not checked. If
you select NOT for a SCSI command, the match will occur on any FCP_CMND except
for the selected one, and also on the selected one if the additional parameters do not
match.

Pin Button - Allows you to "pin" the Properties dialog box to the application so that it does
not go away when another object appears such as an event, state or action.

Description String - This area contains a textual description of the event.

Specific Event Settings - The largest part of the Event Properties dialog box. By
selecting one or more events from the list, you narrow the range of events for which the
analyzer searches.
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The options presented in this area vary depending on the selected event. There are three

basic formats:

* Checkboxes

* List

¢ Pattern Editor

Checkboxes and Lists present options for you to select from. Selecting one or more
option tells the analyzer which event(s) the analyzer should search for. Examples are

shown below:

i
Frimitive Category | Actions | ﬂl
™ ALIGN [~ CLOSE
e [~ NOTIFY [~ CREDIT BLOCKED
Label: [~ Ak [~ OPEM ACCEPT
IF'rim. Category [ Mak [~ OPEW REJECT
I RRDY [~ BROADCAST
Channels: v Al I~ alP [~ DONE
il [ i [~ BREAK [~ SATAPRIMITIVE
[T Court: |2—
[~ HOT
[Match on the opposite
of thiz event]
|Desc:: Any ocourrence on channels 11, T1, 12, or T2 of any of the selected Primitive Categories
Event Properties #
Primitive: | Actions | L

e ofsfufry

Label:

Channels: v &l
i il H i

" Count: |2

[~ NOT

[Match on the opposite
of thiz event]

ALK

AlP [NORMAL)
AP [RESERVED 0)
AP [RESERVED 1)

AP [RESERVED 2)

AP [RESERVED WAITING ON PARTIAL)
AP PwAITING ON CONMECTION)

AP PwAITING ON DEVICE)

AP PWAITING OM PARTIAL)

ALIGH [0)
ALIGN [1]

|Desc:: Any ocourrence on channels 11, T1, 12, or T2 of the specified Primitive nknown

The Pattern Editor, on the other hand, presents a series of text boxes in which you can
enter a data pattern (in 8 bit codes) that the analyzer can use as a trigger pattern search.
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The Pattern Editor has two components: the text boxes themselves, in which a pattern
can be entered, and pull-down menus. Pull-down menus are available for some fields.
By clicking on any field header, users will either be presented with a drop down menu
(below) or they can enter values in decimal or hex and the string will be converted to
binary after clicking on a different field.

vent Properties

Label:

Iegister Device to Host

Channels: v &l
I ] 3 i I i I i

[ Count: |2—

[~ MOT

[Match an the opposite
of thiz event]

FIS | Actions |

Error X Stabus R LR Rgser\tﬁed@j FIS Type
Dwi |XXXXXXXXXXXXXXXXXXXXXXX)@IE [E 'l

E
L

DewHead —  CylHigh Cyl Lows Feqister Host to D evice

Dl |XXXXXXXXXXXXXXXXXXXXXXX Feagister Davice to Host

Set Device Bits

, Reservedll) |, Cylffighlexp) | | Syllowlenl | |ppya Activate
Dw2 | X3 S DM Setup
. Reser\red[ﬂp . Reser\red[ﬂp . Sector Countlaxp] BIST Activate
""" L PI0 Setup

Dwd | XXX K AKX HX LKA LK E KKK AL Z LA pata

Reserved(D) Foute

g e yen P TP il s L, pRERTTee [4FF] Yendar FIS
|

Dwd | XX H A KK ALK K AKX KA LXK AR KLR

|Desc: Any occumence on channels 11, T1,12, T2, 13, T3, 14, or T4 of the specified FIS Register Device to Host

Actions Tab - The Actions tab opens a page of options for setting triggers and other
actions on the selected events.

Event Properties

Label:

ISESI Comnmand

Channels: v &l
[T efr]

[~ Count: |2
[~ NOT

[Match on the opposite
of thiz event]

SCS| Command  Actions |

—Intemal Triggering—————  ~ Sequencing
[ ) Advance Sequence
) Festart Sequence
r— External Triggering " Restart &l
{* Mone
" Pulse High —
" Pulze Low —Fll;e.nnq
" Pulse Toggle il
& Mane ™ Filter Out
" None

|Desu:: Anp occunence an channels 11, T1, 12, or T2 of any of the selected SCS| Command
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Event Properties Dialog Boxes - Descriptions

Each Event button has a different Properties dialog box and each Properties dialog box
has a different set of options.

This section describes the Event Properties dialog boxes and their options.
To see a menu of events, click the New Events button. The events are:

Category

Event

Primitives

Primitive Categories
Primitives

Frames

Open Address Frames
Identify Address Frames
SSP Frames

SMP Frames

SCSI Commands

SCSI Primary Command set

SCSI Block Command set

SCSI Media Changer Command set
SCSI Stream Command set

SATA FIS

Register Host to Device
Register Device to Host
Set Device Bits

DMA Activate

DMA Setup

BIST Activate

PID Setup

DataRoute

Vend FIS: OxFF

ATA Commands

All ATA commands

ATAP| Commands

All ATAPI 6/7 commands

SSP Header Fields

Command
Data
Response
Task
Vendor
Reserved

SSP Information Units

Command
Data
Response
Task

SMP Request/Response

SMP Request
SMP Response

Errors

Breakout Board Data

Timer

Bus Conditions and OOB

Signals

The descriptions below follow the order of events listed in the table above.
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There are two types of primitive events: Primitive Categories and Primitives.
Primitive Presents options for triggering or filtering on various Primitive categories. If NOT is
Categories checked, any unchecked primitive category will generate an event match.
g'f°lpert'es ﬂ
1a og Primitive: Categorny |Actions| ﬂl
[~ ALIGN " CLosE
[~ NOTIFY [~ CREDIT BLOCKED
Lahel [~ ACK [~ OPEM ACCEPT
W ™ MaK [~ OPEN REJECT
I~ RRDY [~ EROADCAST
Channels: v Al [~ AP [~ DOME
[TFIEFz) [~ BREAK [~ SATA PRIMITIVE
[~ Count: |2
[ HOT
[Match on the opposite
of this event)
|D esc: Any occurence on channels 11, T1, 12, or T2 of any of the selected Primitive Categories
Primitives Presents a menu of Primitive types. If NOT is checked, any unchecked primitive will
Properties generate an event match.
Dialog Event Properties =]
Primitive Primitve |A0“0n3| ﬂl
I & B i [ e 0 i
ALK -
AIF [NORMAL)
_— AP [RESERVED 0]
Label: AIP [RESERVED 1)
— AIP [RESERVED 2]
Primiti AP [RESERYED ‘WAITING OM PARTIAL]
AIP [WAITING ON COMNECTION]
Channeks: ¥ al AIP [WAITING ON DEVICE)
AP [WAITING ON PARTIAL)
QalEE ALIGN [0
[~ Count: |2— ALIGH (1] LI
[~ NOT
[Match on the opposite
of this event)
|D esc: Any occuence on channels 11, T1, 12, or T2 of the specified Primitive Unknown
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Frames

Open
Address
Frames
Properties
Dialog

Identify
Frames
Properties
Dialog

There are four Frame types in the menu: Open Address Frames, Identify Address
Frames, SSP Frames, and SMP Frames.

Presents options for triggering and filtering on Open Address Frames. Within the page
are the following menus and text boxes:

Protocol: Any, SSP, SMP, STP
Connection Rate: Any, 1.5 Gbps, 3.0 Gbps
Source Port As: Any, Initiator, Target
Pathway Blocked Count (hex):
Destination SAS Address (hex):

Source SAS Address (hex):

Initiator Connection Tag (hex):

If NOT is checked, any unchecked Frame will generate an event match.

|
Open Address Dpen Address IActionsl ﬂl
Il il [ i [ isl [ i Protocal Ay -
Connection Rate Ay =
Label: Source Port A Any hd
pen Address Pathway Blocked Count (hex) l:l
Charnels: v all Destination 545 Address (hex) | | - | |
Source SA5 Address [hex) | | - | |
[~ Count |2— Initiator Connection Tag [hes) l:l
[~ NOT
[Match on the opposite
of thiz event]

|D ez Any occumence on channels 11, T1, 12, or T2 of any of the selected Open Addiess Frames

Presents options for triggering and filtering on Open Address Frames. Within the page
are the following menus and text boxes:

Device Type: Any, End Type, Edge Expander, Fanout Expander
SSP Initiator: Any, Present, Not Present

STP Initiator: Any, Present, Not Present

STP Initiator: Any, Present, Not Present

SSP Target: Any, Present, Not Present

STP Target: Any, Present, Not Present

STP Target: Any, Present, Not Present

SAS Address (hex): Text box for entering an address.

PHY Identifier (hex): Text box for entering PHY identifier.
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If NOT is checked, any unchecked Frame will generate an event match.

Event Properties

Identify Address Id=ntfy Address | Actions |
| il [ i & i i
Device Type Any il
SSP Iritiator | Anw d SSP Target  |Any
Label:
dentify Addiess STF Initiator Ay l STR Target Apy
ShP Initigtar | Anw r SMP Target |4y
Channels: W al
il E i [E =
SAS Address [hex] | | - | |
Court;
i G5 | PHY Identfier hes) [ |
[~ nNOT
[Match on the opposite
of thiz event]

E
B

|D e Any occumence on channels 11, T1,12, T2, 13, T2, 14, or T4 of the specified [dentify Address Frame

SSP Frames Presents options for triggering or filtering on SSP Frames. To specify an SSP Frame

Properties type, select an item from the drop-down menu. If desired, you can further define the
Dialog event by specifying a data pattern in the data fields. To enter a value in binary format,
use the box marked Bitmask. To enter a value in hexadecimal format, use the boxes
marked Mask (hex) and Match (hex). If NOT is checked, any unchecked frame will
generate an event match.
£l
5SP |Aclions| ﬂl
S5P Frame Type [VENDOR SPECIFIC =l
Bitmaszk Mask Match
[hex] [hex)
Channels: v &l
[~ Count: |2
[~ NOT
[Match on the opposite
of this event)
|D esc: Any occurence on channels 11, T1, 12, or T2 of any of the selected SSP Frames
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SMP Frames Presents menus for triggering or filtering on SMP functions. Two menus are presented:

Properties Function and Function Result. The Function Result menu is context-sensitive and

Dialog depends on the menu item selected in the Function menu. If NOT is checked, any
unchecked Frame will generate an event match.

Event Properties

E|
SMP | Achions | ﬂI
Functian IAW SMP Frame j
Label:— Function Result IAny j

ShP

Channels: v &l
i H

[~ Count: |2
[~ NOT

[Match on the opposite
of this event)

|D esc: Any occurence on channels 11, T1, 12, or T2 of any of the selected SMP Frames

SCSI Commands

There are four SCSI Commands in the menu: SCSI Primary Command Set, SCSI Block
Command Set, SCSI Media Changer Command Set, SCSI Stream Command Set.

SCSI Lets you specify parameters for the selected SCSI Primary Command Set. To enter a
Primary parameter, select an item from the drop-down menu.
Command . .
Set If NOT is checked, any unchecked SCSI Command Set will generate an event match.
Properties £l
Dialog 551 Command | Actons| kL
ACCESS COMTROL IM -
ACCESS COMTROL OUT
EXTEMDED CDE
EXTEMDED COFY
INGUIRY
LOG SELECT
LOG SEMSE
Charinels: Il MAIMTEMAMNCE 1N
MAIMTENAMNCE OUT
(el MODE SELECT(10] _I
I Count |2— MODE SELECT(R] hd
[~ wnOT
[Match on the opposite
of thiz event]

|D g5t Any occumehce oh channels 11, T1, 12, ar T2 of any of the selected SCS1 Command
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SCSI Block

Command
Set
Properties
Dialog

Media
Changer
Command
Set
Properties
Dialog

Stream

Presents options for triggering or filtering on various SCSI Block Command sets. If NOT
is checked, any unchecked command will generate an event match.

Event Properties

sommand

5CSI Cammand | Actions |

Commatd

Channels: v &l
i H

[~ Count: |2
[~ NOT

[Match on the opposite
of this event)

ERASE[D)

ERASENZ)

FORMAT UNIT
LOCK-UMLCE. CACHE[10)
LOCK-UMLCE. CACHE(E)
MEDIUM SCAN
PRE-FETCHI0)
PRE-FETCHI1E)

READ CAPACITY(10)
READ CAPACITY(1E)
READ DEFECT DATA[10]

El
k)

|D esc: &ny ocounence on channels 11, T1, 12, or T2 of any of the selected SC51 Command

Presents options for triggering or filtering on various Media Changer Command Sets. If
NOT is checked, any unchecked command will generate an event match.

Event Properties

sormrmand

5CSI Command | Actions |

Channels: v al
[frifefr]

[~ Count: |2
[~ Nt

[Match on the opposite
of thiz event]

EXCHANGE MEDILM
IMIT ELEMENT STATUS
MOWE MEDILM

MOVE MEDIUM ATTACHED

POSITION TO ELEMENT
READ ATTRIBUTE

READ ELEMENT STATUS
READ ELMMT 5TS ATTCH
RELEASE ELEMENT(10]
RELEASE ELEMENTIE)
REQST WOL ELMNT ADDR

]

|

|D est: Any occurence on channels 11, T1, 12, or T2 of any of the selected SCS1 Command

Presents options for triggering or filtering on various Stream Command sets. If NOT is

Command checked, any unchecked command will generate an event match.
Set |
Properties
Dialog mmand SC5I Command |Acti0ns| ﬂl
ERASE[E) a
LOAD UMLOAD
LOCATE[D)
LOCATE[TE]
RCWR BUFFERED DATA
READ BLOCK LIMITS
READ POSITION
Channels: v &l READ REWVERSE(E]
REPORT DNSTY SUFRT
QulEE RE'IND _I
SET CAPALCITY hd
[~ Count: |2
[~ HOT
[Match on the opposite
of this event)
|D esc: &ny ocounence on channels 11, T1, 12, or T2 of any of the selected SC51 Command
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SSP
Information
Unit:
Response
V)

The SSP Information Unit Events provide a bit-level pattern editor for selecting both SSP
header fields and payload parameters including SCSI sense key and additional sense
code patterns. Sense data length and related fields within the Response IU can be
accessed using the scroll bars. Entering a data pattern tells the analyzer to wait for the
specified pattern before triggering. Checking the NOT box selects the inverse match to
the data pattern defined.

-+

Label: Mk |vvvvvvVvvvvvvvvvvvvvvvvvvvvvvvvv|

Responze (U

Dwi0 |XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX| || Response
Charnels: v Al S T RLEEGHLTT e e Data
NiEEEEDD w |DDEIDDDllDDDUDEDllDDlUlDDlllDDUlH
T esponze Data M
[ Count:
o (RyResporse Code, ] Paserved *| | Sense
™ NOT Dw0 |XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX| Data
. Reserved

(ateh on e ceposie || Dyt (KRR KRR R R KRR R KA RO RRRE] v
Desc: Any occurence on channels 11, 71,12, T2, 13, T3, 14, or T4 of the specified Response U Rezponze U

SATA FIS

There are ten SATA FISs that can be selected from the New Events menu: Register Host
to Device, Register Device to Host, Set Device Bits, DMA Setup, BIST Activate, PIO
Setup, Data, Route, and Vend FIS: OxFF.

The Properties dialogs for these FISs are similar to one another. They display data fields
for entering data patterns on a bit-by-bit basis. Entering a data pattern tells the analyzer
to search for the specified pattern. If NOT is checked, any pattern other than the one

specified will generate an event match. The Properties dialog below is for Register Host

Event Properties |

Register Host .. FIS | Actions | ﬂl

[Tl fref ofraf ufri]

s Seiwensl (SRR Rowmesll)  FETEe

Dwi |XXXXXXXXXXXXXXXXXXXXXXXXO 0100111]

C)rl quh

Sector Muriber
...............

Label:

eqgister Host to Device

Crammels Al . Clor:trel L ) Sesler\lrecll(ﬂp ) SlectlorICcI\uljut(:axe) | Sectar Count
Du3 [ R LRI AR L AR AR I I
I~ Count: |2— ) I?\esler"recllfﬂ? ) Sesler\lrecll(ﬂp La Illesler\:’ecll(ﬂp ) Iliesler‘recllfﬂ?

I o Dwd |XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX|

[Match on the opposite
af thiz event)

|Desc: Ay occumence on channels 11, T1,12, T2, 13, T3, 14, or T4 of the specified F15 Register Host to Device

to Device.
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Note that some of the data fields have drop-down menus. To see which fields have
menus, position your mouse pointer over the blue field headings. If the pointer changes
into a hand, then the heading will present a menu if it is clicked.

. FIS T
]Dli@lll 1 j

F||-|:|| zher HII kb |:||-' || B
1Reqister Device to Host
15et Device Bits

| DMA Activate

10M& Setup

1BIST Activate

{PI0 Setup

{Data

Route

1[0=FF]¥endor FIS

Sector Murnber

ATA Commands

ATA
Commands
Properties
Dialog

ATA Commands are presented in a single dialog box.

Presents several options:

Commands - Presents a long list of ATA Commands. Selecting a command will cause
the analyzer to search for the selected command.

Features - A text box for entering a value.
Sector Count - A text box for entering a Sector Count value.
LBA Mode - Select the radio button, then enter a value.

Sector/Cylinder/Dev/Head Mode - Select the radio button, then enter values into the
text boxes.

Event Properties

K|
il ¥l (4 ¥ E i i Command : £ Sort commands by name

| (0x00) NOP/SOFTWARE RESET Il ¢ Sort commands by code
Label ~ Register
NOP Features I_ Sector count I_

Channels: v al £ LBA Made I—
[T efrefefrafufry
" Sector/Cylinder/DeviHead Made

[ Count: |2
Sector Mumber I_ Head number I_

[~ wnOT
Cylinder L Cylinder High
[Match on the opposite SRS L I_ BAELT (AL I_

of thiz event]

|D 23 Any occumence on channels 11, T1, 12, T2, 13, T2, 14, or T4 of the specified AT4 Command MOP

If NOT is checked, any unchecked command will generate an event match.
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ATAPI Commands

ATAPI
Command
Properties
Dialog

Individual ATAPI 6/7 commands can be selected as a trigger event. Resource limitations
restrict ATAPI triggering to a single channel and to a single ATAPI event.

Label:

MEDILM REMOWAL

Channels: [ al
T i 1 i I i I

[~ NOT

[Match on the oppozite
af thiz event]

ATAPI Command | Actins |

* Sart commands by name

Reserved

LN | Reserved

" Sort commands by cods

& [

Operatlon Code i

Dw H#0 |:><xxxxxxxxxxxxxxxxxxxxxxx J|

Reserved

eser, NFL
ool R

[0<1E] PREVENT ZALLOW MEDIUM REMOWAL

D #1 |XXXXXXXXXXXXXXXXXXXXXXXX [0x28) RE&AD [10)

Reserved

[0x&8) READ [12]

Dw #2 |xxxxxxxxxxxxxxxxxxxxxxxx (0=3C) READ BLIFFER

[0-5C] READ BUFFER CAPACITY

0x2f] READ CAPACITY
[0-89] READ CD MSF
[0457) READ DISC INFORMATION

Diesc: the specified ATAP] Command PREYENT AALL0%W MEDIUM REMOVAL on channel 1(0%23] READ FORMAT CAPACITIES

[0x4D] READ DWD STRUCTURE
[0x44) READ HEADER

[0x42] READ SUBCHANMEL
[0+43) READ TOC/PMAATIP

To specify ATAPI commands as the recording event, select the command using the
Operation Code or Command name. Additional ATAPI parameters can be specified by
entering bit-level pattern in binary or decimal including LUN, transfer length and LBA.

Bus Conditions and OOB Signals

Bus Conditions and Out of Band Signals are presented in a single dialog box.

Bus
Conditions
and OOB
Signals

Select from the check boxes to specify the type of Bus Condition or OOB Signal that you
want the analyzer to search for.

If NOT is checked, any unchecked condition will generate an event match.

Bus Condition | Actions I

Bus Conditions
[~ SAS Data Frame
[~ SATA Data Frame
[~ Primitive

[~ Connect

[ Disconnect

O0E Signals

[~ COMwAKE

[~ COMINIT/COMRESET
[~ COMSAS

H|

|

Channels: W al
[T el

™ Count: |2

[~ WOt

[Match on the opposite
of thiz event]

|D ez Any occumence on channels 11, T1, 12, or T2 of any of the selected Bus Condition and D0B Signals
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Errors

Errors
Properties
Dialog

Errors are presented in a single dialog box.

Select from the checkboxes to specify the type(s) of errors you want the analyzer to
search for. If NOT is checked, any unchecked condition will generate an event match.

Event Properties

- | o |
[ jrifefrafofrfufrd

[ Packet Type
[~ &lign Frequencey

Label [~ CRC
IE”D'— " Disparity

I~ Delimiter
Charinels: W al [~ Symbal Encoding
[ Alignment
[~ Count: |2—
[~ wnOT
[Match on the opposite
of thiz event]

E|

Rl

|D esc: Any occurmehce on channels 11, T1, 12, or T2 of any of the selected Emar

Breakout Board Data

Breakout board data are entered into a single dialog box.

Breakout The Breakout Board Data properties dialog box lets you specify a bit pattern from a
Board Data breakout board that can be used for triggering.
Properties E
Dlalog Breakout Board freakout Board |ACti0nS| ﬂl
Mazk Match
Byted [ XX XXKHKK]
Label:
IBreakout Board
Desc: the specified Breakout Board Data
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State Properties Dialog

The State Properties dialog allows you to specify the Global state’s caption. To access
this dialog box, click in the Global State Cell (but not on an Event button).

State Properties

=
&
Label:
Seguence 1, State 1
Timer Specify the value for the timer in seconds, milliseconds, microseconds, and
Properties nanoseconds. The actual timer value is shown below the edit controls and reflects the
Dialog

hardware precision capabilities. The time is rounded up to the next 7.519 nanosecond
sample, which corresponds to the 133 MHz internal clock frequency.

Event Properties

E|
Tirner i o
Timer 3.000s | ctions | =
Secs Millizecs Microsecs Manosecs
E o o o
Label: Actual Value 3 : 0 0 . 5332

Desc: 3.0005 time out
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Actions Tab in the Properties Dialog

The Actions tab at the top of Event Properties dialog boxes lets you set the type of action

that the analyzer will perform once an event has been found.

Event Properties

Label:

IPrimitive

Channels: v &l
i il H i

" Count: |2
[~ HOT

[Match on the opposite
of thiz event]

Primitive  Actions |
r— Internal Triggering

V' Trigger Analyzer

r— External Triggering

" Pulze High

 Pulze Low

" Pulse Toggle
' None

) idvance Sequence
| Restart Sequence
© Festart Al

' None

—Sequencing——————

i~ Filtering
7 Filker In
£ Filker Out

' None

A
=+

|Desc:: Any ocourrence on channels 11, T1, 12, ar T2 of the specified Primitive ALIGH [2]
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Assigning Actions

As shown above, you can double-click an Event or Action button to open the Properties
dialog box, and then select the Actions tab. You can then select an action from one of

the options.

The assigned action will be represented by a button to the right of the

Event button.

You can also assign an action by right-clicking on an Event or Action
button and selecting an action from the pop-up menu.

The following table shows the types of Actions you can select.

Action

Comment

TRIGGER

Triggers the end of the recording.
The end point of the recording is
determined by the buffer settings in
the Recording Options General
page.

FILTER OUT

FILTER IN

Filters traffic in or out of the
recording - thereby conserving
recording buffer space.

Can not be assigned to the events
with Counters.

RESTART ALL

Reinitializes counters.

TRIGGER
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Setting Conditions: The Role of the Global State Cell

The Global State cell is the arena in which you

create triggering and/or filtering conditions.
The cell is called the Global State cell because Errar

the conditions you create are active at all NHE0EE0E
times. You can think of these conditions as the
default conditions. You use the Global State
cell to create simple condition such as "Trigger when you see an xxx error," or "filter out
all xyz primitives."

Example - Creating a Simple Event Trigger
To create a simple condition that is active at all times, place an event button in the Global

State cell:
Step 1 Click the New Event button. An Events
menu opens (shown right). Primiives b
Step 2 Select an event from the menu. The Frames K
event will appear as a button in the %S Commands »
Available Events area on the left.
SiC5I Skakus
Step 3 Drag the event button to the cell
marked "Global State.” SATAFS 4
S5P Frame Head 3
Step 4 Right-click on the button (i.e., not the e Eacer
Global State cell). A pop-up menu 55F Information Lnit +
appears. SMP Request/Response *
Step 5 Select Trigger from the menu. An AT4 Commands
arrow will project from the error button
ATAPI Commands

and point to a cell marked Trigger.
SATA Daka Pattern
Creating Multiple Event Conditions in the S&5 Data Pattern
Global State Cell Bus Conditions and OOB Signals
When multiple buttons are placed in the Global Cell, it ?

creates an "AND" condition or an "OR" condition m

depending on the actions selected.
Breakout Board Data

Creating an OR Condition - When two or more buttons
in the Global State cell are assigned the same action,
the analyzer will search for all of the events and perform
the action on which ever event it sees first. The example below illustrates. It reads
"Trigger if an error or a primitive occurs".

Timer

Error TRIGGER

[ frifefraf ofraf ufre]

TRIGGER
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Creating an AND Condition - When multiple events are placed in the Global State cell
and assigned different actions, an AND statement is created. The example below reads
"Trigger if an error occurs AND filter out any primitives that occur.”

S TRIGGER
NIEEEENT

FILTER OLT

Filter In and A filter causes the analyzer to filter in or out specified events from the recording. If events

Filter Out are filtered out of the recording, they are excluded and not simply hidden from the trace.
The purpose of filtering is to preserve recording memory so you can conduct longer
recording sessions and exclude events that do not interest you.

To Filter In or Out traffic,

Step 1 Click the New Event button. The New Event menu opens.

FILTER OLT

Step 2 Select an event from the menu.
Step 3 Drag the event into the Global State cell.
Step 4 Right-click on the button. A pop-up menu opens.
Step 5 Select Specify Action(s)
Step 6 Select Filter Out (for example).
The analyzer is now configured to filter out the selected event.
Filter In or The options Filter Out Everything or Filter In Everything allow you to filter all traffic in

Out or out of the trace. These options are intended for a future release to allow you to
Everything  selectively exclude and include traffic from a recording.
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Counting In addition to setting triggers and filters, you can also set counters. A counter is an action
Events that allows you to set a trigger based on a count of events. For example, you could use
a counter to "Trigger following the 16th occurrence of an error."

To use a counter, follow these steps:

Step 1 Select an event from the Select Event menu and drag it to the Global
State Cell in the center of the dialog box.

Step 2 Click the small channel buttons on the selected Event button to select
the channels for the actions.

Step 3 Right-click the event and select Add Counter. A dialog box opens.
SMP SMP | actions |

Jifrijeiraf s frsfufry .
Court 16 Function | Ay SMP Frame i

Funetion Result |Any =l

Channels: W &l

[T efrs]

v Count: |1 [

[~ ot

[Match on the oppozite
of thiz event]

|De&u:: Ewery 16th occurence an channelz 11, T1,12, or T2 of anw of the selected SMP Frames

Step 4 In the text box to the right of the label Count enter a value.
Step 5 Make sure the checkbox to the left of the label Count is checked.

Step 6 Click the X in the top right corner of the dialog box to close the dialog. A
counter button should appear below your selected event.

NiEEEEnD TRIGGER

Count 16
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Creating Event Sequences

States

Event sequences are chains of events leading to some action. A sequence is a

©

Prim. Category

(e frf ool ufr]

Eror TRIGGER

Jnfrifefraf ofraf ufr]

multi-event "if, then" condition: "If x followed by y followed by z occurs, trigger." Event
sequences are created by dragging two or more buttons into the Sequence cell. The
Sequence cell is a faintly marked cell just below the Global State cell. The Sequence cell
contains the text Drag an event here to add a new sequence.

Note: Event sequences can only be created in the Sequence cell. You cannot
create a sequence in the Global State cell.

Sequences are made up of cells called States. A state is a stage within a sequence that
specifies what events the analyzer should look for and what actions to apply when the
event occurs.

In the example below, the Sequence is composed of two states. The maximum number
of states a sequence can support is 255.

RUN

I 61 I i B i [ i

(St TRIGGER

{ifrifefre ofmf vjrd

The foregoing example reads: "Trigger if you see a Primitive followed by an error."
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How to To create an event sequence, you drag event buttons to the Sequence cell, link them
Create an with the action Advance the Sequence, then apply a trigger or other action to the end of
Event the chain. The following steps illustrate how to create an event sequence.
Sequence

Step 1 Click the New Event button. The New Event menu opens.

Step 2 Select an event type from the menu, for example an error. A button
appears in the Available Events area.

Step 3 Click the New Event button and select a second event type, for example

a Primitive. At this point, you should see two buttons in the Available
Events area.

Avwailable Events @
t
[ il B i Eix [ il

IIIJIIEL'EEIEIIIJII

Step 4 Drag the first button to the cell marked "Drag an event here to create a
sequence." When you finish, notice how two new cells appear in the
window as shown below the cell where you placed your button.

)

Error TRIGGER

1 jrafe fraf o ufri]

Step 5 Double-click on the button. A Properties dialog box opens.

|
E”D[ | ACtiDnS I ﬂl
L frifefraf ofrafu fri]

™ Packet Type
[ Align Frequencey

Label: I” CRC
IE”m— [ Disparity

I~ Delimiter
Channels: I Al [~ Symbal Encading
[~ Alignment
[~ Count: |2—
[~ NOT

[Match on the opposite
of thiz event]

|Desc:: Any ocourrence on channels 11, T1, 12, or T2 of any of the selected Emar

Step 6 Select desired options from the dialog box, for example an error
sub-type. The options apply immediately.
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Step 7 Close the Properties dialog box by clicking the X in the top right corner.
The Properties dialog box closes.

Step 8 Drag the second event button to the cell immediately below the cell
occupied by your first event button. Note that an additional cell appears

()

Error TRIGGER

(e frfeisfufr]

Primitive NO ACTION
I il [ ¥ B i= [

marked "Drag an event here to add a sequence.”
Step 9 Right-click on the first event button. A pop-up menu appears.

Note: Be sure to click on the button itself and not the cell. If you click the cell,
you will get a different menu with fewer options.

Step 10 Select Specify Actions. Notice
how this menu differs slightly from
the menu shown earlier in this '
chapter. You will see three E | fecamen
options for advancing or restarting HoRentTo
a sequence:

Trigger

Filker In

Filker Qut

Copy Event To 3 Advance the Sequence

W) Delete This Event Restart Al

¢ Advance the Sequence - Draws an External Tringer Pulss HIGH

arrow that connects the selected
event button to the event button
below it. This option creates a Froperties...

sequence.

Properties...
External Trigger Pulse LOW

External Trigger Pulse TOGEGLE

¢ Restart the Sequence - (Not visible in the menu above.) This option restarts
the entire sequence. This option appears once you have linked two or more
buttons in a sequence. This option draws an arrow upward from the selected
event button to the beginning of the sequence.

* Restart All - Restart all sequences and counts. This option creates an arrow
pointing a cell marked "Restart All."

Step 11 Select Advance the Sequence. An arrow will appear that connects
the first button to the second.

Step 12 Right-click the second button and select Specify Actions. A
sub-menu appears.
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Step 13 Select Trigger. A cell will appear to the right of the second button
saying "Trigger." Your sequence configuration is now complete and
should look like this:

()

Errar
i frofefraf oimf w fri
il [ i 5 i [ il

Using a Timers let you set a time-delay for a trigger or other action. The following example
Timer illustrates how timers work.

L

Timer 3.000s

TRIGGER

This example reads "Look for a Primitive. When you see one, wait three seconds then
trigger."

To create the example shown above, perform the following steps:
Step 1 Click the New Event button to open the Event menu.

Step 2 Select an event such as Primitive from the menu. An event button
appears in the Available Events area.

Step 3 Drag the event button into a Sequence cell marked "Drag an event here
tfo add another state." Once the button is added, the cell turns blue and
acquires a title like "Sequence 1, State 1." Below the cell, a new cell
appears marked "Drag an event here to add another state."

Step 4 Click the New Events button. The Events menu opens.
Step 5 Select Timer. A Timer button appears in the Available Events list.

Step 6 Drag the Timer Button to the cell marked "Drag an event here to add
another state." The cell turns blue and acquires a title like "Sequence
1, State 2."

Step 7 To link the two events into a sequence, right-click on the first event (in
our example, the Primitive event button). Be sure to click on the event
button and not on the cell. A pop-up menu appears.
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Step 8 Select Specify Action(s). A sub-menu opens.

Step 9 Select Advance the Sequence. The menu closes and an arrow
appears that connects this cell to the State cell below.

Step 10 Right-click on the Timer button. A pop-up menu appears.

Step 11 Select Specify Action(s). A sub-menu opens.

Step 12 Select Trigger. The menu closes and an arrow appears that connects
the Timer button to a new cell to the right marked Trigger.

Step 13 To set the duration of the Timer, double-click on the Timer button. A

dialog box appears.

Event Properties

Timner | Achions I

Timer 3.000s
Secs Millizecs bicrozecs Manosec
E o g I°
Label: Actual Value 3 : I : i 5332
|Desc:: 3.000z brne out
Step 14 Enter a time value in the boxes.
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Step 15 Click the x to close the dialog box. The timer is now set.

Recording Options g\
Generall Channel Settings  Recording Rules I Channe\sl
@ Newevent im0 | | @ | Q||Em| = Config is valid

Py

ALIGM, NOTIFY FILTER OUT

Identify Address
I ] [ i [ 0 i)
NAUIRY

Sy TRIGGER

L efrefuirsfufr]

Sequence 1, State 1

I il 3 E [ E 0
Open Address
I il & i [ 5 0 )

Data Pattern

[ efre i)

OPEN REJECT =
Lifrifefrefsjrs]ufr]

<

Save. Save As Default Load. Cancel

Sequential Events and Timers

The recording option above shows an example of using a Loop and Timer to trigger on
Open Timeout violation. This reads "Wait for an OPEN ADDRESS on I1; If OPEN
ACCEPT or an OPEN REJECT occurs on T1 within 1ms, restart the loop; ELSE IF 1 ms
elapses (without detecting an OPEN ACCEPT or an OPEN REJECT on T1) then trigger
the analyzer".
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Recording Options - Channels

The Channels page allows the channel names to be customized. To change a channel
name, select the channel, then click the edit button and enter the new text, then click OK.
Once the options are set, the analyzer will update the open trace and all future traces with
the new channel names.

x|

Genarall Chaninel Setlingsl Fiecording Rules  Channels I

Channel | Channel Mame |

Exdit Restore Defaults

Save... | SaveAsDefau\tl Load... | 0K | Cancel |

Note: You can also change channel names by clicking on the first cell of a
trace (the channel cell) and selecting Rename Channel from the
pop-up menu.

Where Custom channel names appear in three places:
Custom ® The trace itself

Channel

Names * Link Tracker window
Appear * Bus Usage window
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Custom Channel Names in the Trace - Custom channel names do not appear right
away in the trace: the original names continue to display. To see the custom channel
names, click in the first cell of the trace (the channel cell) and select Format from the
pop-up menu, then select Custom.

DORE (M
k258.5 D30.0

Rename Channel S
CLOSE (I

Color g Custom

Hide k25,5 D020

—

The custom names will then appear in the trace.

1 Frame
32 985.000 ns 00.000 035 567
985.000 ns 00.000 035 567

Frame
2

Init_1

Channel I1 renamed as Init 1.

Custom Channel Names in the Link Tracker Window - The Link Tracker window will
automatically show custom channel names as soon as they have been customized.

rame # 0
& Q| B | 5 6 10b RD

T
Text
| Time | Packetst | Init_1 T1
00.000 000 000 O {lnit_1] 1
00.000 000 026 [EE RN Features | 3 Gbps ...
00.000 000 053 Destination SA5 Address
00,000 000 075 | Destination SA45 Address

124 LeCroy Corporation



SASSuite User Manual

Version 6.25

Custom Channel Names in the Bus Usage Window - Custom Channel names
automatically appear in the Bus Usage window as soon as they have been customized.
The easiest way to see this is to open the Bus Usage window and then to open the

Properties dialog for the window. It will list the custom channel names.

To open the properties dialog box for the Bus Usage window, right-click in the window,
then choose Properties from the pop-up menu.

Graph area properties

.tFrame length on Channel T1
In_/’Frame length on Channel 12
]_Frame length on Channel T2
LFrame length on Channel 13
LFrame length on Channel T3
]_Frame length on Channel 14
]_Frame length on Channel T4

Mew | Delete | Restore defaults

Title: Appearance;

IFlame length on Channel Init_1 ILine ﬂ
Type: Colar:

IFrama length arver time from initiator on channel 1 ﬂ Il Ij

 Filter out

M Facket Tppes

[ ]Primitives

[ ]15ource Addresses

[ ]Destination Addresses

@ Hide selected items

€ Show selected items

—Ewent Groups————————————

Packet Types

Priritive

Q0B Signal

Open Address Frame
|dentify Addrezs Frame
S5P Frame

SMP Frame

Connect

Disconnect

STP Frame

Ok I Cancel

Apply
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Chapter 6: Display Options
Use the Display Options menu to specify the way data file information is displayed.

From the Setup menu, select Display Options.

Display Options
General | Calar # Format / Hidingl Level Hidingl Headersl

Zoom Level: : [T Compact Wiew — Trace Yiewing Level———————

W Enable Tips [ Right click cell contest menu ¥ Frame .

¥ ‘wiap ¥ Higrarchy Lines ™ Transport Layer Transaction
[~ SC5I Operation

Time Stamp Position: IMerge with Event number j I~ Management Transaction
[T ATA Command

[ 05 Deseelig [~ OOB Transmission
 ATAHS v ATAR

—Analyzsiz Tools

[ Emor Bepart [ Link Tracker
[ Timing Caleulator ™ Frame Tracker
[ Traffic Summary [T Data
[ Bus Utilization

— Fantz

Fields: Al

-] B| 1]
Data: |Courier New - B| 1]

Configuration M ame: ILeI:rcu_l,l default

Restore Factony Presets | Save... | Save Az Default | Load... |

Ok I Cancel | Applp |
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General Display Options

Use the General Display Options to specify the basic appearance of a view.

Zoom Level: Adjustable in discrete increments from 10% to 200%
percent.

Enable Tips: Select to enable Tool Tips with explanation text to pop up
when you position your cursor over various fields in the Trace View.

Wrap: Causes packets to wrap within the window if their length exceeds
the width of the window.

“ Transaction

Hierarchy Lines: Adds faint lines (shown at

left) to the left side of the trace showing the
hierarchical relationship of the Frames,
Transactions etc within the trace. When this
option is enabled, the lines display any time
you cascade higher level decodes.

Right click cell context menu: Activates
the right mouse button for opening cell
context menus.

Timestamp At The Beginning: Moves the timestamp from the end of
the Frame to near the beginning.

Trace Viewing Level: Allows you to select the hierarchical level at
which traffic is displayed.

Display Configuration Name: Comment field associated with the *.opt
file containing the current Display Options values. You can also create
and store your unique Display Options for future use.

To create a new Display Options file, follow these steps:

Step 1 Enter a comment for the new file in the Display Configuration

Name field.

Step 2 Click Save...
Step 3 Specify a filename (*.opt).
Step 4 Click Save.
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Setting Color, Formatting, and Hiding Options

Setting
Color
Display
Options

Display Options

General Color / Fommnat £ Hiding I Lewel Hidingl Headersl

Click the Color/Format/Hiding tab on the Display Options screen.

I

Format _Hidden

Dizplay Units
CRC

Tirne

Other
Pratacols
Address Frame
Primitives

S5P Frame
SMP Frame
Out Of Band Signals
STP/SATA
STPFIS
Channels

ATaA Comrnand
Tracker Fields
TCG Packet

Evpand &l | Collapse 4l |

—Datas*

— Bit Order

= Formmat

' Hevadesinal
! Decimal

' MSE o LSE
i~ LSE to MSB

! Biriany
) EST

— Hiding
" Hidden

= Calor

o calors available fon selected itenm.

Restore Facton Presets | Save.. |

Save Az Default | Load... |

Ok I Cancel |

Apply |

Use this window to customize the colors and formats associated with each field in the
Trace view. You can also use this window to hide fields within the trace.

To change the colors of elements in the trace, select an item in the Group and Color
column and use the color pallet screen on the right to make the desired changes.

Note: The color of an Invalid Data (packet error) field cannot be changed;

it is permanently set to red.

Use this window to customize the colors associated with each field in the trace. You can
experiment with these options to achieve the color combination best suited to a particular
graphic system.
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You can also customize the colors by using the options in the Custom tab.

Standard Custom

Colars:

Red: |1|]|] _l;
Sat: IE Greer: Iﬂ
Lum: |55 _l; Blue: IHEI _l;

Changing To change field formats, select an item under the Group and Color column. This action
Field will enable the formats radio buttons on the right. The format types change with respect
Formats to the item selected under the Group and Color column. For example, if Display Units is

selected, the following displays:

- Other

2

H

H

- Protocols

H- Address Frame
- Primitives

H-- 55P Frame

H- SMP Frame

t- Out Of Band Signals
H-STPFIS

i T s O O o O ey O IO O WO e O

The following formats are available:

— Data+Data
Format——— —Bit Order
¢ Hexadecimal ﬁ MSE to LSE
) Decimal L5SE ta MSE
I By Hiding
 asCl
™ Hidden

Note: Not every format is available for every item.
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Hiding To hide one or more fields in the trace, select the appropriate item Hiding

Display from the Group and color column, click the checkbox marked Hidden, _

Options and click the Save button. IV Hidden
You can also hide Frames from a trace by selecting the desired options from the
checkboxes.

Level Hiding Options

The Level Hiding tab allows you to hide various types of traffic. To hide traffic, select one
or more items from the Events Group list and from the list on the right, then click OK.

Display Options \ .1
General I Calor / Farmat / Hiding ~ Level Hiding I Headers I
— Event Groups
Packet Tupes
T
[(15ource Addreszes Dnung I;?gnd Y
[ 1D estination Addresses 00B Signal - Undetermined

0OB Signal - COMWAKE

0OB Signal - COMRESET
0C0EB Signal - COMSAS

Open Address Frame

|dentify Address Frame

Zone Broadcast Address Frame
Short Zone Broadcast Address Frame
S5P Frame

SMP Frame

ELECTRIC IDLE OFF
ELECTRIC IDLE ON

LI STP SATA Frame

Faw Data

[0 ata Length
[15MP Frames
[155F Frames

[1Gen Global Settings

% Hide selected iterns

" Show selected items

Restore Factory Fresets Save.. | Save Az Default | Load... |

QK I Cancel | Aipply |
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Display Options - Headers
The Headers tab lets you show header fields in either collapsed or expanded state. The

Headers tab also lets you change the order of the header fields.

Display Options

Generall Eolor.-’Formatx’HidingI Level Hiding Headers | %

¥

— Header Fields &ppearance

Select Header

Check ta allow field when header collapzed

Frame Type

[1Hashed Source Address
[Hashed Destination Address
["1Retry Data Fims

[1ReTran

[1Chng Diata Pt

[CIFill_CNT

w|Tag

[1TPT_Tag

[10ftzet

Move Up

b ove Diown

Restore Defaults For $5P Frame Header

LI

Restore Defaults For Al Headers

Restore Factory Presets Save... | Save Az Default | Load... |

oK I Cancel | Apply |

To change Header format,
Step 1 Select a header type from the Select Header drop-down menu.

A list of header fields appears in the pane below marked Check
to allow field when header is collapsed. Selecting fields in
this pane causes the fields to appear in collapsed format within
the trace.

Step 2 Select header fields from the pane marked Check to allow field
when header is collapsed.

Step 3 If you want to move the selected field within the header, click the
Move Up or Move Down buttons.

Step 4 Click OK to apply the changes.
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For example, below is a Frame where the Command field has been moved from the
Header field to the end.

beginning of the

Frarme
170

0x206A32

SOF MDD zH
CRC cor :
- 000000000 {28 bytes f| DxOCHIFIE 1372 ps 00000133 12330

Frarme
170

0x206A32 0xB4D463 0 0 0x0100 0xFFFF

You can restore

Offsat COMMAND CRC EOF :
oxooooo000_ [ |28 bytes || 0xs0C0SF1B 1.372 ps 00000.133 12330

the default field order by clicking the Restore Defaults buttons.

Saving Display Options

To complete your display options settings, use the features at the bottom of the Display
Options window. These features remain the same no matter which of the four Display
Options windows you are working in.

Click Save to save the currently specified display options for use in
future sessions. Any file name can be specified, but you must use the
.opt extension. If no extension is specified, .opt is added by default.

Click Load to load a previously saved *.opt file, thus restoring a
previous set of display options.

The Save as Default function is equivalent to the Save function,
specifying the file name default.opt. Whenever you start up the
Analyzer, it automatically loads the default.opt file if one exists.

Click OK to apply any changes you have made to Display Options and
close this dialog box.

Click Cancel to cancel any immediate changes you have made and exit
the Display Options menu.

Click Apply to apply your changes while keeping the Display Options
window open.

LeCroy Corporation
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Chapter 7: Reading a Recording

Frame Hashed Source Address Hashed Destination Address ReTran Fill_CNT Tag

! 170 SOFT) COMMAND 0205452 OxB4D4E3 0x0100
CRC EOF TimeDelta Time Stamp
OxFFFF 000000000 || 26 bytes || DE0CISFIE | (N 1372 ps 00000.133 12330
T Frame ACK TimeDelta Time Stamp
71 K28.5 D014 D014 D01 4 1023 ms 00000.133 12675

Recording View Features

SASSuite viewing software displays make extensive use of color and graphics to fully
document the captured traffic. Frames (for Avalanche or SAS Tracer files) or commands
(for SASTracker files) are shown on separate time-stamped rows, with their individual
fields both labeled and color coded. Data fields can be collapsed to occupy minimal
space in the display (which can in turn be zoomed in and out to optimize screen
utilization). Pop-up Tool Tips annotate Frame fields with detailed information about their
contents.

The display software can operate independent of the hardware and so can function as a
stand-alone Viewer that may be freely distributed.

Frame, Transport, SCSI, and Management Views

The default display mode for recorded traces is Frame view. The trace can also be
viewed in Transport Layer (Tra), SCSI Application Layer, Management Application, ATA
Application Layer and OOB (Out of Band) signaling views.

Changlng Display Levels _ Hﬁ Tra Scsi Mgt Ala Oob
To switch between the Frame, Transaction, SCSI, | ——— -
Management, ATA application and OOB views, click the

respective buttons on the Tool Bar.
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Frame Level
Frame Level view is the default decode level. Frame Level view displays traffic as shown
below:

TirneDelta Time Stamp
007.000 ns 00000400 55262

TirneDelta

TirneDelta Time Stamp
0082.000 ns 00000444 11765

TirneDelta Time Stamp
00000.461 7507

Transport Layer

When you click the Tra button, the Transport Layer traffic is decoded and presented as
shown below. To see Transport Layer transactions, you may need to scroll through the
trace or use the Find command (under Search).

Destination SAS Address
21050004 _CFB7DD53 | ACCEPTED 2.399 ms
i - Result
C EAD(10)
0000 READ(10) |y 575,356 pis

SCSI Application Layer
When you click the SCSI button, SCSI Application Level traffic is decoded and presented
as shown below

Management Application Layer
When you click the Mgt button, Management Application Layer traffic is decoded and
presented as shown below:

RFT_GEMERAL || ACCEFTED 2640 ps
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ATA Application Layer
When you click the ATA button, ATA Application Layer traffic is decoded and presented.

You can "open" any of these decode levels to reveal the components by clicking the small
triangle in the first cell. The following is an example of an expanded Management Level
view showrng its constituent Transport Layer Transactions and Frames:

Result
RPT_MFG_INFO | [ACCEPTED

You can also get additional information on fields by holding your mouse over selected
fields as shown in the following example:

Initiator ; " - F
EDDZDS?E 'IEFFECEB ; AONENAFER BECAACRS BEE
The SAS address ofthe initiator port

I..Emmmﬂmmmmn

OOB (Out of Band) Signaling View

The OOB view combines OOB scenarios (establishing link, speed negotiation, etc.) into
a simplified and integrated view. These scenarios typically occur at power on and after
hardware resets as devices initialize and initiate communications.

The trace view below shows the default trace display as a SAS target and SAS host
attempt to initiate communication. The SAS target powers on first, and starts sending
COMINIT repeatedly (in fact, in this example, over 1400 times). When the initiator
powers on it also sends COMINIT and then both devices immediately respond with
COMSAS to identify themselves as SAS devices. and then proceed to speed negotiation.

Frame 1435 k
m COMINIT/COMRESET
02:23.506 532 115 G 100.071 ms
Frarne 1436 k
m COMINIT/COMRESET
02:23.606 602 967 G 100.070 ms
Framme 1437 1 i
02:23.706 672 815 G e 24ims || O HCOMRESET

Frarne 14358
02:23.801 917 225 G 17.500 ns

Frame 1439 15

A0 917242 |G | COMINT/ICOMRESET
Frarne 1440 15

02:23.801 920 107 G 5.550 s CONTEAS
Frarne 1441 15 F

12:23.801 925 B57 G 1523 s CONTEAS

[[Fra e sl gl pn 0ub) [ @)@

ELECTRIC IDLE QRN
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Clicking on the "OOB" button simplifies this long stream of OOB signals into a higher level
summary, as follows:
|[Fre = sei gt A2 @ @ |

Frame 0 CTRIC IDLE Ob
00.005 266 737 32500 ns e
Q0B 0 -
00,005 266 770 G T43.797 sec Target iniia
02:23 BD1 927 180 G 2.443 ms
‘ﬂ Frame 1547 [3] [ Identify |[Phy D] SAS Ad
| 0223804363717 [G] 267 500 ns | ENDDEVICE || 0x00 | &0010B30 C
As with other views, you can get additional information on the event by holding your
mouse over selected fields or you can "open" any decode level to reveal the components
by clicking the small triangle in the upper left corner of the cell.
J e e gesl gt Ala O
Frame 0
00.005 266 737 32.500 ns
[a]e]=H1]
00.005 266 770 G 143.7597 sec
02:23.801 927 180 G 2443 ms
| Frame 1547 | 3 | Speed negotiation between host and target
‘T1| 01223 A4 369 717 5] 267 500 ns
Initiator | Target
}ZUHEN%EV\EE IZDne Bde:Dsé Ivlethod H DXFDE;RE Number of Aligns: P po=s
||1 | Frame 1548 | 3 | 'ﬁ e R | Time elapsed(in sec): 0.002442807
Opening the decode levels will first bring you to a list of all OOB signals, and further
opening the COMINIT events will show the actual times of the traffic bursts that comprise
the COMINIT, as shown below.
|[fre e sl it pi2 o] [@ @
E[:'ﬂ?mduct Manuals'SASSuite’ Yersion ...\ sas_init_sas_hba.sas ;Iglll
ELECTRIC IDLE ON :I
oo DDE QEE 770
Frame 1 [00B Burst | OOB Idle | OOB Burst |
00.005 266 770 0070 ms || COMMNMEOMRESET | 165 oobi | 473 oobi | 154 oobi |
[ 0OBIde [ OOB Burst \ OOB Idle [ OOB Burst \ 00E Idle | 00B Burst | O0B Idle | OOB Burst |
| 473 0obi | 154 oobi | 4E2o0ohi | 165 cobi | 462 cobi | 154 oobi | 473 oohi | 154 oobi |
Frame 2 1.5
00,105 336 BES G 100,071 m COMINT/COMRESET
This example shows the power of the SASSuite software in being able to summarize
details at a very high level, while allowing the user to easily "drill down" into the details
that comprise each displayed event to find more and more detail on events of interest.
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Setting Heirarchical View Level Using the Display Options Window

You can also set the hierarchical view by selecting checkboxes in the Trace Viewing
Level Options in the Display Options window.

x
General | Color / Farmat / Hidingl Lewel Hidingl Headersl

Tl el B T,  Trace Yiewing Level

¥ Enable Tips [ Right click cell contest menu ¥ Frame :

W Wrap ] v Lies ™ Tranzport Layer Tranzaction

[ SCSI Operation
Tirne Stamp Positior: IMerge with Ewent number j [~ Management Transaction
[ ATA Command
— ATA Decoding [~ O0B Transmission
= ATAR f* ATAR

—Analyziz Tool

[~ Eor Repart ™ Link Tracker

[ Timing Calculatar [ Frame Tracker

[~ Traffic Summary [~ Data

™ Bus Utilization
~ Fonts

Fields: fadal -] B|1]
Data: ICourierNew j B | I |
Configuration Mame: |LeCr0_l,l default
Restore Factory Presets | Save... | Save Az Default | Load... |
] I Cancel | Apply |
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STP Decoding

If STP traffic is present in a trace, you can see it by doing the following:
Step 1 Click the E button to display Transport Layer protocols.

Step 2 Select Search > Go To > Frame Types > STP Frame. The
trace will reposition itself so that the next STP frame appears at
the top of the Trace window.

" Transaction o
175 MORMAL 105.000 ns

STP and Traffic passing through an Expander may be STP on one side and SATA on the other
SATA Traffic side. Also, note that some Expanders support SAS Zoning, if so this information will be
Over Hosts  available to view in the trace (see “SAS Zoning” on page 143).

and

Expanders
Serial ATA Tunneling Pure SATA
Protocol (STP) Recording Recording
\ STP & SMP Traffi¢ \ qm
s —
Drives
SAS physical link(s) SATA physical link(s)

Traces of such setups will show different types of traffic depending on which link(s) were
being recorded.

STP Link Traffic - Traffic on the STP side will have STP transactions but with SATA traffic
embedded within it.

SATA Traffic - Traffic on the SATA side will be purely SATA and have no STP
transactions.
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View Raw Bits

SASSuite allows you to view low-level 8B/10B values for Serial Attached SCSI traffic. You
can expand a specific Frame to view the raw bits by right clicking on the Frame number
and selecting Show Raw Bits.

To view Raw Bits, follow these steps:
Step 1 Click on the first cell of a Frame.

Note: Raw Bits can be viewed only in Frames.

» Frama || ALICN (2
0130013 || 545685 ps|  DODOD.104 22020

(3) TirmeDelta Time Stamp
z el rerliep 02730273 -9.655 ps 00000.104 43865

T1 Fra Time From Trigger (1
E Doy .0 Do7.0 54,585 ps 00000.104 40003

Time From Marker

T Fra ——— N2 TimeDelta Time Starp
o (e dERTE 9,655 ps 00000.104 51548
Color 3
H Fra ; ) TimeDelta St
g Bids D10.2 027.3 44960 ps 00000.105 1710

Step 2 Select Show Raw 10b Codes.

The data 8b and 10b field can be displayed in several formats, as
shown below.

!’ﬂRaw 10b Codes Display For Frame # 118445 - |EI|1|
Physical L.
PRI — Data Appearance ——
B
0 " Byte
12 7 Serambled Byte
3 10 bit code
4
5  Symbol (R0
g (% Packet Fields
g Destination SA5 Address
9 Destination SA5 Address
10 Destination SA5 Address
1 Destination SA5 Address
12 Destination SA5 Address
13 Destination SA5 Address
14 Destination SA5 Address
15 D estinatio Address
18
17
Packet Fiunning Disparity Ermor
<-Prev | Mest - | ’V Frey | Mext | } Dane |
4

Data Appearance - To change the format of the data, select from following options:
¢ 8b - Click the column heading to show hexadecimal values.

* 10b - Click the column heading to show hexadecimal values.
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Running
Disparity

Navigation - To move to the previous or next packet in the trace, click one of the two
buttons at the bottom of the window:

* Prev - Displays data for the previous Frame in the trace.
* Next - Moves to the next Frame in the trace.

Running Disparity Error - If SASSuite detects Running Disparity Errors it will display in
red and have exclamation marks before and after the value.

The 8-bit codes change to 10-bit codes before they get transmitted.

Running Disparity is a binary parameter with either the value negative (-) or the value
positive (+). After receiving any encoded character, the receiver shall determine whether
the encoded character is valid using the running disparity parameter as a checksum. The
receiver will then calculate a new value that is either the opposite of the previous
character or neutral. The ability to view changes in Running Disparity polarity is an
important part of the debug process. The raw bits view displays the running disparity of
the 10bit code in the column following the raw bits.

Note: For a more complete definition of Running Disparity, please refer to the Serial
Attached SCSI Specification (available at www.t10.0rg)
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Expanding and Collapsing Fields

SAS Zoning

Many of the fields shown in each display may be expanded (to display additional detail)
or collapsed (to reduce extraneous information) with a single click. Fields which allow
expansion or collapse are indicated by a small solid white triangle located in the upper
left corner of the field, as shown below:

*

Start - Start

S 145,000 ns

>>expands to>>

End - Start Start - Stant Start - End End - End

41 660 ns 55.000 ns 65.330 ns 55.000 ns

As an example, if the Transport Layer is selected, typically individual frames are
collapsed into Transactions, as shown in the example below. If you wish to see further
detail about any specific transaction, simply click the white triangle next to any
Transaction number, and the Frames which compose that Transaction are displayed.

Destination SAS Address
847 500 ns || SMP S0060560_000000C1 ALC
>>expands to>>

Transaction 0 So Destination SAZ Address
0B.566 967 232 50060560_000000C1 ACCEPTED

3 Transaction 0
06.566 967 232 G

5 Frame 0 3 So Sils Destina
(06566 957 232 G 435.000 ns 50060
T3 Frame 1 3
(06,566 957 B67 G 145.000 ns
T3 Frame 2 3
(06566 957 512 G 55.000 ns K28.5 D27 .4 D30.0 D29.7
T3 Frame 3 3
(06,566 957 567 G 212,500 ns K28.5 D16.7 D16.7 D16.7

For Expanders that support zoning, the zoning information can be displayed by

displaying the trace in the Transport mode, then expanding the SMP Response Field to
provide details on the response. The fields ""Zoning Supported" and "Zoning Enabled"
are among the detailed fields that are displayed. [Note: Currently SAS Zoning is decoded

using SAS 2r05a.]
'SP Response Result  Respanse Length
147 500 ns RPT_GEMNERAL | ACCEPTED 0x00

>>expands to>>

0x00 0x00 NO | YES oooooooo Dx18 0x18
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Expandinga You can expand a Data Payload field to view it in greater detail or collapse it when you

Data want a more compact view. SASSuite allows you to expand and collapse the data
Payload payload information in four ways:
»  Clicking the small triangular arrows on the left side of the data payload
field
» Clicking and holding down the mouse button on the triangular button on
the left side of a data payload field. This action will expand or collapse
data fields for all Frames throughout the trace
» Double-clicking anywhere in the payload field
» Clicking in the data payload field and selecting Expand/Collapse Data
in the pull-down menu.
When you select "Expand Data," only the first 100 dwords are shown. To view all of the
dwords, select "View Data Block."
This section describes expanding or collapsing data payload by using the menu:
Step 1 In the Serial ATA trace, click in a Data Payload box.
i Data
518 bytes
Step 2 In the Data Field menu, select Expand Data.
Daka Field
Wiew Diata Block,
Expand all Data Fields
Collapse All Diata Fields
Farmat g
Calar »
Hide
The Data Payload box expands to show more detailed description of
the data:
0: 00 00 0O OO0 OO0 0o OO0 00 00 o0 OO OO0 o0 0o oo a
1l&: 00 00 00 00 OO OO0 OO0 DB|
To collapse data, follow the same steps described above, and select
Collapse Data.
You can also expand or collapse all data payload fields within a trace by
using the above menu.
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View Data Block Window

Description
of View Data
Block
Window

The View Data Block command opens a dialog box that lets you display and navigate the
data within Frames and Transport Layer transactions. This dialog box gives you several
format choices for the data: binary, hexadecimal, ASCI, and decimal. It also gives you
the ability to navigate through data fields within different Frames and Transport Layer
transactions.

To access the View Data Block window,
Step 1 Decode to the level of interest by pressing  Fra or Tma .

Step 2 Locate a Frame or Transport Layer transaction with a data field
such as the one shown below:

Frame | Type | Function | EOF
) [ SMP Request [RPT_RT INFO|[8 bytes || 0x1A495123 1.180 ps

Step 3 Click in the Data field to open a pop-up menu.

Step 4 Choose View Data Block from the menu. The View Data Block
window opens.

x J = | < > ”Em Dec Bin H’M_.ibﬂ|?“Updateonlyonrequest j“

Offset Hezadecimal
ooooo 0ooooooo 00000000 gle26364 BESEEGTES
00004 41424344 454454745 494A44B4C 4D4E4FS0
oooos 312E3050 504F4E4D 4C454449 45474645
goooc 44434241 Z0Z0z20zZ0

b=
=4
=]
=
B
@
o
=
T
b
[

The View Data Block window (henceforth called the View window) displays the raw data
for the selected Data field. Data is displayed in up to four formats, a column per format.
The window has several options for navigating through Data blocks.

E Save. Saves the currently displayed data block into a text file.

<] [ Previous and Next. These buttons cause the View window to
jump to the next Frame that has a data block and display that
data block.

gin Data Format Display. Creates a column for the specified data
format and then displays the currently selected data block in
that format.

’@_.S_b Lsb | MSB/LSB Format. Begins the data string with the Most
Significant Bit (MSB) or Least Significant Bit (LSB).

=~ Format Line. Opens a dialog box for setting DWORD length.
The default is 4 dwords.

| |'—'F":|'3tE on scrol j Synchronize Options. Configures the mouse's scrolling
behavior within the View window.

[L=111 L) M Call) [a]

Hex | Asci

[L=]1]1=]

Deg
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The menu presents three scrolling options:

¢ Update only on request - Locks whatever data block currently is on display
in the Data window unless overridden by a direct request. There are two ways
to make a request -- by clicking on the buttons or by right-clicking in the trace
on a data block and selecting View Data Block from the pop-up menu.

* Update on click - Repositions the Data window to whatever data block you
click on in the trace window.

¢ Update on scroll - Synchronizes trace scrolling with the Data window. As
you scroll the trace, the Data window will reposition to show the data block for

| ISB— f'\’ the Frame at the top of the trace window.
Scroll to Offset. Repositions the Data window to whatever offset you
enter in the Offset box. You can enter an offset value in decimal or
hexadecimal.

Incomplete Frames Handling and Display
If the analyzer captures a frame that was not transmitted properly according to the
protocol, it records the frame as an Incomplete Frame. This includes SSP, SMP, Address

or STP(SATA) frames without Start Of Frame and/or End Of Frame, or frames with
shorter payload that is dictated by the protocol.

The Incomplete frames are marked specifically in the Trace View. Here are some
examples of Incomplete Frames display:

Frame Incomplete e
122332 IDENTIFY AF - 24 bytes 44 160 ns 00.842 737 540
Frame Incomplete CRC
== EOAF
122333 OPEN AF 4 bytes|| 0xC3CF94D0 720.000 ns 00.842 737 677

Incomplete Address frames

T Frame k8N Packet Error Incomplete SOF
393352 G Delimiter SSP FRAME 0.000 ns 05.878 729 615

Incomplete SSP frame

ime EB Packet Error | SATA XMT Incomplete SATA SOF TimeDelta
el  10b Code SATA FRAME e 1028 bytes|| 104.160 ps 01:00.348 -
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Incomplete SATA frame

When incomplete frames are displayed, no field decoding takes place, only the raw
payload recorded for the incomplete frame is presented. However, in the Link Tracker
some field decoding can be performed, if possible (part of the frame header is received
intact). Here are some examples:

Frame Incomplete
— SOAF
122332 IDENTIFY AF 24 bytes 44 160 ns 00.842 737 540
Fra Incomplete EOAF
122333 - OPEN AF 4 bytes 0XC3CF94D0 720.000 ns 00.842 737 67

m Source SAS Address Destination SAS Address | Tag PB Cnt

Elpa i & l?ﬁ Syn Ox Ox 10b RD Texl
| Time | Packet# | I |
B FaT506

122332 (1) SOAF
Idetity | Type Restiicted ntiztor Ports TargetPors
- Resicted 0000 ]

SAS Address

122333 (1) PaylLd #0000
CRC

EQAF

Link Tracker shows some decoded fields for incomplete Identify Address
frame

| framo & SOF
0138 |6 SMP FRAME 8 bytes|| 125.000 ns 02.121 365
BB o e [ — oo —
An‘ldn K285 D24 QNI 7 N27 4 18 048 m 02 121 366 017

Link Tracker -Frame # 40139

B pa s % @ | Smox 0X 100 RD Text

[ Time | Packetz | i1 | T

40139 (1)
PayLd #0001

02.121 366 039

Link Tracker shows some decoded fields for incomplete SMP frame

LeCroy Corporation
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Split Frames Some frames - mostly STP (SATA) - can take a very long time on the bus. For SATA

frames it happens when Host and target go into long Hold periods while writing or reading
the data. In this case it is not viable for the analyzer to record the whole traffic sequence
as one frame, and the Split Frame approach is used. The long frame is broken into a
sequence of smaller frames, which are marked as Starting frame, zero or more Middle
frames and an Ending frame. This is highlighted in the Trace View like this:

Frame |3 |f Split FIS Type Port
SATA_SO
I 206049 bl Sibtall  D:tz | 0:0 | 2052 bytes|| 0.000ns 01:00.34
[ Frame |31 Hsmn

u 210376 SellimulE MID |[4096 bytes|| 0.000ns 01:00.347 694 890

Frame _[3 ] Hsmn TimeDelta

s

I 210472 SATAXIT END |[2048 bytes || 0xDDF3493C kbl | 15 920 us 01:00.34

A frame transmitted by SATA initiator is split into three frames.

Frame  [ENI FIS Type Port TimeDelta
SATA_SO H
198422 S | sArT | NSRRI | Dete | 0x0 || 6564 bytes|| 742.500ns 01:00.346 584 157
Frame i Split TimeDelta
L || >RV | [sTaRT || 306.090 s 01:00.346 584 900
By — o SATAXVT s SATA EQF | SIS :
202335 END |[1632 bytes || OxDDF3493C 570.000 ns 01:00.346 890 990
Frame F Split TimeDelta
202336 SRl END 33.945 ys 01:00.346 891 560
Frame i FISType Port TimeDelta
SATA_SO! H S
202378 ] Al | DA Activate | 0:0 | |4 bytes|| 0rAGrcS | [siadkeittlll | 165.000 ns 01:01
Frame i TimeDelta
u 202385 SATARCY 20.250 ps 01:00.346 925 690
Frame i Split FIS Type Port TimeDelta
203805 i (sarT | NSRRI | D7z | 0x0 7920 bytes|| 737500 ns 01:00.348 945 940
L Frfan?-e‘ F STAEEY Split TimeDelta ]
203836 START || 306.088 s 01:00.346 946 677
b Freme saTA VT | SATA_EOF [ hmeDelia
205472 END |[276 bytes|| 0xDDF3493C 582.500 ns 01:00.347 252 765
Frame F Split TimeDelta
205473 SATARCY END 4.192 s 01:00.347 253 347
o Frame CLOSE (NORMAL) Sequence TimeDelta
205483 K28.5 D02.0 D30.0 D27 4 3 307.500 ns 01:00.347 257 540
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SATA frames both on Transmitter and Receiver sides are split

The frames that are split get assembled together at the Transport level of
decoding/display. For example:

" Transaction - FIS Type Port” Data
1048 - Data | 0x0 [8192 bytes 01:00.346 584 157
Frame i Split FIS Type Port TimeDelta
S SO
n 198422 S TsTarT | ISRl Dot | 00 || 6564 bytes|| 742500 ns 01
Frame P HSpIiI TlrneDeIIa F@m
198515 ALY START 306.090 ps 01:00.346 584 900
Frame SATAXMT | SATA_EOF | tmeDeta
202335 END 1632 bytes|| 0xDDF3483C 570.000 ns 01
Frame i HSpIiI TlrneDeIIa F@m
202336 SAARCY END 33.945 ps 01:00.346 891 560
- " Transaction - TimeDelta
1057 = 20.435 ps 01:00.346 925 505
" Transaction — FIS Type Port” Data TimeDelta
1058 B Data | 0x0[8192 bytes|| 311.600 ps 01:00.346 945 940

In the example above, although SATA frames both on Transmitter and Receiver
sides are split, they are assembled together in the Transport Layer transaction.
The payload, that was split into 6564 and 1632 bytes is assembled together in
one 8192 bytes buffer.

Compact View

Some traces contain field headers which repeat from line-to-line (frame-to-frame)
even if the content of the fields are changing. The repeated display of the same
header information can occupy space on the screen that would be more useful if
presented in a tabular form.

The compact view provides a means of condensing repeating header information
into one line of headers, with the data arranged below in "spreadsheet" fashion.
Compact view automatically condenses repeating headers, but when the next
header that is different appears it will be shown as a new header.

Compact view can be selected in any of the following ways:
* From the View Menu, select Compact.

* Use the Ctrl-Q keyboard shortcut.

* With the mouse pointer positoned over the display area, right-click the mouse
and select "Compact" for the menu that displays.

To change back, repeat either the menu selection or the keyboard shortcut.

The following screens illustrate the use of compact view mode. In the screen below
(shown in normal view), the same header information repeats for each frame:
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J File Setup Record Generate Tracker Report  Search  Miew  Tools  Window  Help

|lo® | | & e il 4B S DR W E

=
1 Frame 312595 3 ALIGN (3)
02:06.702 813 797 G 22,490 ps K285 D27 3 D273 D273
T1 Frame 312596 3 ALIGH (1)
02:058.702 836 287 G 4817 ps k285 DO7.0 DO7.0 DOY.0
1 Frame 312597 3 ALIGN ([0
02:06.702 841 105 G 22503 ps k285 D102 D102 DZF.3
T1 Frame 312593 3 ALIGH (2
02:058.702 863 BO7 G 4.803 ps k285 DO1.3 DO1.3 DO1.3
1 Frame 3125599 3 ALIGN (1)
02:06.702 868 410 G 22518 ps k285 DOY.0 DO7.0 DOY.0
T1 Frame 312600 3 ALIGH (3)
02:058.702 890 927 G 4.790 ps k285 D27 3 D27 .3 D273
1 Frame 312601 3 ALIGN ()
02:06.702 895 717 G 22530 ps k285 D01.3 DO1.3 DO1.3
T1 Frame 312602 3 ALIGH {0
02:05.702 918 247 G 4777 ps k285 D102 D10.2 D27 .3
1 Frame 312603 3 ALIGN (3)
02:06.702 923 025 G 22540 ps K285 D27 3 D273 D273
[T Frame 317AMN4 RN Tiereis ALGH 1 I

When View>Compact (or Ctrl-Q) is selected, the trace file is now shown as follows, which
allow far more data to be displayed in the same screen:
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J File Setup Record Generate Tracker Report  Search  Miew  Tools  Window  Help

|@® | LG #E eS8 RE =
Ch Frame = TimeDelta Primitive
I 02:06.702 813 797 3| 22490 ps ALIGN (3)
T1 02:05.702 836 287 3 4.817 ps ALIGH (1)
I 02:05.702 841 105 3| 22503 ps ALIGN (0
T1 02:05.702 863 607 3 4.803 ps ALIGHN (2)
I 02:06.702 865 410 3| 22518 ps ALIGN (1)
T1 02:05.702 890 927 3 4.790 ps ALIGH (3)
I 02:06.702 895 717 3| 22530 ps ALIGN (2)
T1 02:05.702 918 247 3 4777 ps ALIGHN (0
I 02:06.702 923 025 3| 22540 ps ALIGN (3)
T1 02:05.702 945 565 3 4.760 ps ALIGH (1)
I 02:06.702 950 325 3| 20240 ps ALIGN (0
Ch Frame Sp Prirmitive
T1 02:05.702 570 565 3 2.307 ps ALIGHN (2)

Ch Frame = TimeDelta Primitive
T1 02:06.702 972 885 3 4.748 ps ALIGN (3)
I 02:05.702 577 32 3| 22573 ps ALIGH (1)
T1 02:06.703 000 205 3 4.732 ps ALIGN (0
I 02:05.703 004 237 3| 22588 ps ALIGHN (2)
T1 02:06.703 027 525 3 4.720 ps ALIGN (1)
I 02:05.703 032 245 3| 22600 ps ALIGH (3)
T1 02:05.703 054 845 3 4.708 ps ALIGN (2)
I 02:05.703 059 552 3| 22B15ps ALIGHN (0
T n7-NE 77 NE0 167 2 A REN e A1 IR 2

Note that the occurance of just one frame in the display with a different header ("Idle"
instead of "Time Delta") results in the header row being redisplayed.
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Export Options

Trace data captured by Avalanche or SAS Tracer can be exported for other uses,
including uses outside the system. These options are accessed through the File menu
by selecting Export, as shown below.

File Setup Record  Generats

Mew GenFile Chrln

M., ChrlH+O

T
iz

Close

Save fs...

=
S print... Chrl+p
@ Prink Prewyiew

Ptink Setup...

Edit Comment:. ..

Expork

Conwert 4

E Merge Trace files, .

Packets ko Text (Packet Yiew Farmat). ..

ko Generator File Format, ..
Packets ko EAS Format...

ko CSY Farmat...

1 SAsExpander_Init, sas
2 5as_to_sata_copy.sas
3 sas_drive_boot,sas

4 SASExpander_Init, sas

Exit

There are four export options supported. The data fields which will be present in the
exported files are determined by the current screen view. Please select the appropriate
data fields before exporting the data to ensure that the correct information is present in

the exported file.
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Packets to
Text (Packet
View
Format)

Export to
Generator
File Format

Packets to
EAS Format

This option is used to create a text version of the trace (e.g., for use when emailing a trace
section). Selecting this option brings up a screen to allow you to define the range of
events that you want to include in the text file. The range can be defined by frame
number, by markers, or by time.

Export Events to text ll
Fraom : Ta:

Frarme vl IE Frarme vl |2357"'8
Marker vl I Marker vl I
Time -| | 231908526175 secs  Time -| | 29.2741839625 secs
Resget Range to wWhole Trace | ITI Cancel |

Define the range of events (by frames, markers or time) that you would like in the
exported file and click "OK". A screen will appear for you to provide a filename for the
exported file, and allow you to navigate to the folder where you wish to store the file. The
exported file will have a ".txt" extension.

A feature of the SASTrainer is the ability to use a trace captured by the SAS Tracer as the
basis for traffic to be generated by the SASTrainer. In order to use this feature, the
captured trace must first be exported by using the "Export to Generator File Format"
command. See Generating Traffic on page 204 for a discussion on how to use this
feature with the SASTrainer.

This option creates EAS files based on the open trace. Selecting this option will bring up
a screen allowing you to name the files and navigate to the folder that you would like to
store the files. There are three files created, one file with a ".ecs" extension and two files
(one for each channel) with a ".eas" extention. The ".eas" files will have "_000_ch1" and
" 000_ch2" appended to the file name you provided.
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Export to Many users might wish to have the trace data exported into a formatted file (e.g., for
CSV Format importinto databases or spreadsheet programs such as Microsoft Excel). The "Transport
to CSV Format" option provides a means of generating a structured file from trace data
captured by Avalanche or by SAS Tracer.
Selecting this option will bring up a screen allowing the user to specify the information
from the current file to be exported and the destination file for the exported data.
Save ir: I I Sample Files j - &5 B
'J test trace fra and tra and magt.csy
2% |test trace fra and tra.csv
'J test trace fra only.csy
% |test trace to csv file.csv
File: name: | Save I
Save a3 bype: ICS\-" [Comma delimited) [*.cav) j Cancel |
Layer to export
% Transpart Laver ™ Do Not Export Hidden Packets
& ATA &pplication Layer
From : To:
Frame - | ID Frame vl |2?32
Marker = | IFrame # 0 [Marker #1] Marker v| IFrame 1 2732 [Marker #2]
Time v| | TTO0EETFI87G secs  Time -| | 79.0030722275 secs
A
Select the destination folder and enter the destination filename for the exported data.
Select the layer to export (either Transport or ATA Application Layer). Indicate whether
you would like hidden packets to be included in the exported file or just displayed packets.
Define the range of events (by frames, markers or time) that you would like in the
exported file and click "Save".
The exported file will have a ".csv" extension. The first line (or record) in the .csv file will
be a header indicating the name of each variable included in the file. Each following line
(or record) will contain only data.
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If opening the exported file from within Microsoft Excel, in the Open File window under
"Files of Type:" select "Text Files (....; *.csv)". When the file is opened, a spreadsheet is
shown with a large number of columns (each column representing one data type) and a
number of rows on the trace which was selected for export. A typical spreadsheet is
shown below. Once opened, the file can be later saved as any supported Excel file type.

Fl:. test trace to csv file.csv

A B c D F E H |

1 |Channel ITransactio Speed Protocol | Source Po Source 5S4 Destinatior Close Fram
2 N 1] 3 55P Open| 50006250 50000000 _00000001
3 |1 1 3 55P COMRI
4 T 2 3 55P MORMAL
5 |T1 3 3 55P OpenT 50000000_50006280_000002F5
& |T1 4 3 55P DATA
i 5 3 55P MORMAL
g |T1 ] 3 55P OpenT 50000000_500062680_000002F5
3 |T1 7 3 55P RESF
10N ] 3 55P MORMAL
RARI a 3 55P Open| 500065280 _50000000_00000001
121 10 3 55P COMM,
13 |T1 11 3 55P MORMAL
14 |T1 12 3 55P OpenT 50000000_500062680_000002F5
|15 |T1 13 3 55P DATA
16 |1 14 3 55P MORMAL
17 |T1 15 3 55P OpenT 50000000_50006280_000002F5
|18 | T1 16 3 55P RES
1911 17 3 55P MORRAL

201 18 ===Ns
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Chapter 8: Searching Recordings

SASSuite has several search commands that enable you to navigate a recording in
search of key events such as errors and triggers. These commands are launched from
the Search menu.

To view the search options, click Search in the Menu bar.

Search  Wiew  ‘Window  Help

2o ko Trigger
o ko Event..

Go ko Marker

Go ko

i Find...

B Find Hext

3

Search Direckion Forward

A TT = T

Go to Trigger

To display the Trigger Event, select Go to Trigger from the Search menu. The Trace
View is repositioned with the first Frame following the Trigger event (or the Frame that
caused the Trigger) at the top of your screen.

Go to Event ...

To display a specific Frame or higher decode level, follow these steps:

Step 1

Step 2

Step 3

From the Search menu, select Go to Event ...

The Go to Event window appears. GotoEvent x|
From the Go To pull-down menus, Bl
select Frame, Time, or Markers (if F . Im—
present). Ll

! - | 0.0000000000
If you select Frame, a menu of decode LI =
levels will appear. Select the decode ok | Cancel |
level of interest (if it does not appear,

you may have to press a decode button
on the toolbar). Then enter an event number in the text box to the right.

If you select Time, a text box will appear prompting you to enter a time
value.

If you select Marker, a list of Markers in the trace will appear. Select a
Marker from the list.

Click OK. The trace view is repositioned with the selected item
at the top of your screen.
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Go to Marker

To instruct the Analyzer to display a marked Frame, follow these steps:

Step 1 From the Search menu, select Go to Marker.

|§ear|:h Miew  Window Help

i @0 ko Trigget £l | MR J @ X
i Go ko Event...
a0 ko Marker Frame # 0 (Trigger)
a0 ko » Frame # 365 (ul)
| !! Find... Frame # 1133 (Uz)
- s Find et F3

all Markers. ..
Search Direction Forward | PS Qo0a0o. 102 so00¢

Step 2 Select the desired Frame from the displayed list.

Note:

The Trace View is repositioned with the selected item at the top of your
screen.

Selecting Search > Go to Marker > All Markers will cause a dialog box
to open with a list of all markers in the trace. The dialog box offers
options for editing, deleting, and copying markers.

The Go to Marker feature functions in conjunction with the Set
Marker feature. The comments within the parentheses following
each marked Frame are added or edited with the Set Marker
feature. Please refer to Set Marker in Reading a Recording.
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Go To

The Go To feature takes you directly to an event in a recording by allowing you to search
by a specific criteria. Only the items present in a recording will be displayed in the Go to
menu. If an item is not present in the recording, it is greyed out in the menu.

Search  Miew  Window  Help

Go ko Trigger
Go ko Event. ..

Go ko Marker

EI:I t|:|

' @ FEind...
B Find et

F=

Seatch Direction Forward

0x52331000 ||

00.000 000 292 E

00 001 577 =hiE

RF”

Packet Tvpes
55F Frames
SMP Frames
Primitives
Etrors

[rata Lengths
Speed

SATA FIS Type
SC5I Operation
ATA Command

To apply the previous Find parameters to the next search, select Find Next from the

Search menu.
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Find

Find is a utility for conducting searches of one or more events within a recording. In
SAS Tracer trace files, Find allows you to search different hierarchical levels within the
trace - Frames, Transactions, SCSI Operations, and Mgt Transactions. To start find,

» Select Find... under Search on the Menu Bar

OR
Click ¥ | in the Tool Bar.

You see the User-Defined Find Events screen:

Search far; —Frames To Search For

— Ewent Groups

Tranzactions
SCS5I1 Operations

M Packet Types

Packet Types

Mgt Tranzactions [ Primitives Primitive
ATA Commands [15ource Addreszes 00E Signal
[ ]Destination Addresses Open Address Frame
[ ]Data Length |dentify &ddrezs Frame
[]5MP Framesz 2oF Frame
SMP Frame
[155F Frames ;I Connect
Dizconnect
~Direction——————— Uncheck Al S 1P Frame

" Fonward Combining specified
" Backward Event Groups:

™ Union - Frames

- Drigin that match AN of the zpecified
¥ Top of the screen events
" Last match " |ntersection - Frames
™ Start of the file that match ALL of the specified
£~ End of the i Events
e [ Exclusion - Frames ;
™ Find &l that DO MOT match [opposite

to the intersection or wnion)

[ Search In Hidden

0K I Cancel

The Find window divides into three areas:

Left area -- Display options for setting the search level, direction and origin. The top left
box is context-sensitive. In order for the Transactions, SCSI Operations, and
Management Transactions to be active, you will need to decode these levels in the
trace.

The left area includes two options at the bottom:
¢ Find All - Finds all specified events and extracts the results to a new window.

¢ Search in Hidden - Searches for specified events in all of the trace -
including in traffic currently hidden from the display via the Hide buttons.

Center area -- Controls the event groups to be searched. The selection you make will
display further choices on the right side of the Find window. At the bottom are three
options called Union, Intersection, and Exclusion that are used with multi-criteria
searches. These options are explained below.
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Complex
Searches

Event
Groups

Union,
Intersection,
and
Exclusion

Right area -- Controls the specific events to be searched within the trace. The box in this
right section displays events from the selected Event Group.

The right area is context sensitive - the Event Group selected in the Center Area
determines what types of events display on the right. For example, if "Primitive Type" is
selected, the right area will display a list of Primitive types. Bold entries indicate items that
actually occurred in the trace.

In the example shown above, Primitive Types is selected. The right side of the screen
shows all of the Primitive Types that occurred in the displayed trace.

When conducting complex searches in the Find dialog box,
you first push a decode button in the toolbar to enable
Frames, Transactions, SCSI Operations, or Management
Transactions in the Search for... box.

Search for:

Transactions
SCSI1 Operations

In this example, three of the five "Search for..." choices are Mgt Transactions

enabled, and Frames is selected. The Event Groups box in AlA Lommands

the Find dialog contains available choices based on the
selection.

After you have selected a choice in the Event
Groups, the box on the right of the Find window will
present choices based on your selection. In the
following example, the box displays the frame
types that are available in the trace:

— Event Groups

[]Source Addresses
[ D estination Addresses
[0 ata Length
[]5MP Frames
[]155F Frames

Facket Tupez

0B Signal

Qpen Address Frame
|dentify Address Frame
S5SP Frame

SKP Frame

Event Groups are categories of events that can occur in a trace. Clicking on an Event
Group will display a list of Event types on the right side of the Find window that occur
within each Event Group.

If multiple events are selected, use the options Union, Intersection or Exclusion to
conduct the search.

Union is used to search for any selected event: "Find x or y." Union lets you tell the
Analyzer to search the trace for any of the selected items.

Intersection is used to search for all selected events: "Find x and y." Intersection lets you
tell the Analyzer to search the trace for any packet having all of the selected events.

Exclusion is used to exclude selected traffic from the trace. Exclusion is used with Union
and Intersection --i.e., you select Exclusion with Union or Intersection.

* Exclusion + Union -- Exclude packets with any of the specified events.

* Exclusion + Intersection -- Exclude packets with all of the specified events.
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Using Find Step 1 Select the display level to be searched from the Search For box on the
left side of the window.
For example, to search through Commands, select Commands.
The display level affects options presented in the Events Group
box.
Step 2 Select a search direction and origin.
Step 3 Select one or more events from the Events Group box.
Your choices will affect options displayed on the right side of the
dialog.
Step 4 If you have selected two or more criteria, then select either:
¢  Union: Find all packets that match ANY of the specified events.
¢ Intersection: Find all packets that match ALL of the specified events.
If you want to selected events from the trace, then select:
¢ Exclusion: Exclude all packets that match any of the specified events.
Step 5 Click OK. The search then occurs, and the results display.
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Find Next To apply the previous Find parameters to the next search,
Select Find Next (or F3) under Search on the Menu Bar
OR

4
Click &l on the Tool Bar.

When Link Tracker is open and Find Next is used, the software repositions the
LinkTracker (and other views) on the next frame containing the same primitive. For
example, when using Find Next to search for SATA_SYNC primitives - the display will
select the next primitive in time starting from the specified origin (top of the screen,
beginning of the file, last match), regardless of which frame and which recording channel
it occureds.

Figure 1: When using Find Next for primitives, the search order will be as shown

| 2 T2
SATA_ U (R_OK)
SATA_XU0K (R_OK) |
\ SATA XK (R_OK) |
SATA YU (R_OK) |
SATA XA (R OK)
SATA_SYNC
SATA_SYNC
SATA_CONT

SATA_SYNC
SATA_X_RDY
SATA_X_RDY
SATA_CONT
SATA_ XU (%_RDY)
SATA_JOUX (%_RDY)

TA_XGA (% _RDY)
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Chapter 9: External Interface for Trigger
In /Out

With each Avalanche or SAS Tracer analyzer, LeCroy includes two mechanisms for low
latency communications with general purpose test and measurement equipment:

BNC (or SMA) External IN/ OUT - This connection can be used to send
clocking information and recording commands from one analyzer to
another (see Setup for Cascaded Multiple Analyzer Use for SAS Tracer
in Chapter 11). The BNC/SMA interface can also be used for
transmitting and receiving trigger in / out signals from general purpose
instruments such as a LeCroy Oscilloscope or an InFusion Error
Injection system.

Breakout board - The breakout board utilizes a LV TTL level signal
which can provide a simple trigger in/out interface to the analyzer. It
can also be used to configure the analyzer to trigger on a specific bit
pattern received on the break out board data pins.

BNC/SMA External In / Out

The BNC/SMA External Out capability allows users to specify protocol level events as
Trigger Out signals to external instruments. This provides a mechanism for SAS or SATA
link layer errors detected on the analyzer to trigger an attached oscilloscope. The
BNC/SMA External In provides a similar mechanism allowing physical layer instruments
to signal the analyzer to trigger at a specific moment.

Using the Step 1
SMA Trigger
Out on an

Avalanche Step 2

Step 3

Step 4

Step 5

Step 6

Attach the SMA EXT OUT connector to an appropriate Trigger
In connector on a general purpose test instrument using the
provided SMA cable or an SMA-to-BNC cable, as appropriate

In the SASSuite software, under Recording Options
(Avalanche)..., select the Triggering/Filtering tab

In either the Global Rules or Sequence section, click on the
<Click here to add an event> link and select the event desired
to initiate the external Trigger Out signal, then click OK

Click on the <Click here to add an action> link and select the
SMA Output action, then modify the parameters under Output
Action and Pulse Length to be appropriate to the external
instrument, then click OK

If you wish the event to also be used to trigger the Avalanche
analyzer, select the <Click here to add another action> link
and select Trigger, then click OK

Start the recording on the Avalanche analyzer.
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Using the Step 1 Attach an appropriate Trigger Out connector on a general
SMA Trigger purpose test instrument to the SMA EXT IN connector using the
In on an provided SMA cable or an SMA-to-BNC cable, as appropriate.
Avalanche . . .
Step 2 In the SASSuite software, under Recording Options
(Avalanche)..., select the General Tab and click the radio
button Event Trigger under Recording Type.
Fecording Type
" Snapshot
" Manual Trigger
+ Event Trigger
Step 3 Select the Triggering/Filtering Tab. Under the Global Rules
section (or in one of the Sequence sections), click on the <Click
here to add an event> link
Step 4 Select SMA Input, adjust the parameters to match the signal
expected from the external device, and click OK.
Step 5 Click on the <Click here to add an action> link, select Trigger,
then click OK.
Step 6 Select Start from the Record menu.
Using the Step 1 Attach the BNC Trigger Out connector to an appropriate BNC
BNC Trigger Trigger In connector on a general purpose test instrument using
Out on the provided BNC cable
SASTracer Step 2 In the SASSuite software, under Recording Options (UPAS
10K)..., select the Recording Rules Tab
Step 3 Select the New Event button and specify the protocol level
event desired to initiate the external Trigger Out signal.
Eror  Actions | -l
Il EiEEE DD Internal Triggering Sequencing
Iv Trigger Analyzer ;
’I;:Tti External Triggering ; :estartAII
Chanrels: v Al f_ Eu:se Eigh Filtering
o & FiterIn
. " Pulze Toggle & Fiter Out
[™ Count: ’— ™ Mane s
[~ NOT
[Match on the opposite
of thiz event]
Desc: Any occurrence on channels 11, T1,12, T2,13, T3, 14, or T4 of any of the selected Ermars
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Using the
BNC Trigger
Inona
SASTracer

Step 4

Note:
Step 5

Step 6

Step 1

Step 2

Under the Actions Tab, Select the type of External Trigger
signal suitable for the external instrument. The chassis support
three external trigger-out signal types:

® Pulse High
® Pulse Low
® Pulse Toggle
In each case, the BNC signal transmits an LV TTL level signal

Select Trigger Analyzer on the Actions Tab if you intend to
record protocol level traffic simultaneously while using the BNC
External Trigger Out signal

Press the Record button to arm the analyzer. Trigger indicator
on the analyzer faceplate will indicate when the trigger condition
has been detected by the analyzer system.

Attach an appropriate BNC Trigger Out connector on a general
purpose test instrument to the BNC Trigger In connector using
the provided BNC cable.

In the SASSuite software, under Recording Options, select the
General Tab and click the radio button Event Trigger under
Recording Type.

Fecording Type
" Snapshot

" Manual Trigger

+ Event Trigger

Select the Recording Rules Tab. Remove all triggering events
from the Recording rules (Filtering options can be retained - see
Recording Rules screen image below)

SYMNC £ ALIGN
[nfrifefrefsjrsfufr

FILTER OUT
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Step 4 Press Record > Start button to arm the analyzer. The analyzer
will indicate it is waiting for a trigger. Any edge detected on the
Trigger In signal will stop the recording and fill the buffer on the

analyzer.

Note:: Voltage required on the edge condition is 0 t0.8V low, 2.0V to 3.3V high. 40nS
is the approximate detection threshold for the BNC Trigger In feature.

Note:: There is also a trigger indicator on the analyzer front panel that will indicate
when the trigger condition has been detected by the analyzer.

Breakout Board Trigger In / Out

The Breakout Board connects via a 25 pin
serial interface cable to the Data In/Out
connector located on the rear of the analyzer
unit. Each signaling pin is isolated by a 100Q
series resistor and a buffer inside the Analyzer
unit. Six ground pins and one 5-volt pin are
provided.

25 24 23 22 21 20 19 18 17 16_15 14

‘0000000000000
000000000000

Data In/Out Connector (on cable)
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Pin-Outs for the Data In/Out Connector

The following table lists the pin-out and signal descriptions for the Data In/Out connector
on a cable that connects to the Breakout board.

Data In/Out Connector — Pin-Out

Pin | Signal Name Signal Description
1 RSV Reserved
2 GND Ground
3 GP OUT General Purpose Output
4 TRGIN1 Trigger In 1
5 GND Ground
6 DATA 6 Data 6
7 DATA 4 Data 4
8 DATA 3 Data 3
9 DATA 1 Data 1
10 | GND Ground
11 | RSV Reserved
12 | RSV Reserved
13 | +5V +5 Volts, 250 mA DC Source
14 | RSV Reserved
15 | GND Ground
16 | TRG OUT Trigger Out
17 | TRGINO Trigger In 0
18 | DATA7 Data 7
19 | DATAS Data 5
20 | GND Ground
21 | DATA 2 Data 2
22 | DATAO Data 0
23 | GND Ground
24 | RSV Reserved
25 | RSV Reserved

Note: (*)Pins 4 and 17 have the same function: they allow external signals
to be used to cause triggering or recording. Pins 3 and 16 are used

to transmit output signals. Pins 6, 7, 8, 9, 18, 19, 21, and 22 (data

pins) are used to define data patterns for external input signals. See

External Input Signals in Chapter 6.
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External Interface Breakout Board
CATC UPAS 2500 O
Breakout Board 5 o - +
PCA210-0042-00 | 3 | O O
O |ene
o[Jo QO |epoutrur
oo O | TRIGGEROUT 0O 00O O 00O
O oo O |rieeerm ggggggggg
oo Q | TRIGGERINC OO OO 00000
—=T 4 000000000
og oo O |oamr 000000000
Og oo Q |pams 000000000
o 000000000
09 O [oams 000000000
Og oo Q |patag 000000000
(3 oo O |omms 000000000
o 000000000
g oo O |omm: 000000000
go o[Jo QO |opam ggggggggg
o0 oo | O jome 880808000
[o] o[—lo QO |ResERVED 0O OOOOOOO
oo | O | 888855358
O oo QO | reserven gg ggggggg
oL | o [eav 6600600600
o= | o |awe 006666600
QO |enp 000000000
O |ano
Prototype The Breakout Board contains a prototype rework area for making custom circuits for rapid
Rework development. The area consists of plated-through holes, 20 columns wide by 27 rows
Area long. The top row of holes is connected to GND and the bottom row is connected to +5V.

The remaining holes are not connected. Use the rework area to insert custom
components and wire-wrap their respective signal, power, and ground pins.

Configuring Input Signaling through the Breakout

Board

Triggering
an
Avalanche
System

To configure the Avalanche analyzer to trigger on an input signal from the breakout board,
perform the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Select Setup > Recording Options (Avalanche).... and select
the Triggering/Filtering tab.

Under Global Rules, click on the <Click here to add an event>
link

Select BOB Input - TRIG from the Events menu. Specify the
Trigger Source, Input Events and Pulse Length parameters to
match the expected signal from the external device, then click
OK

Click on the <Click here to add an action> link and select
Trigger, then click OK.

Select Start from the Record menu
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Triggering a To configure the analyzer to trigger on an input signal from the breakout board, perform
SASTracer the following steps:

System Step 1 Select Setup > Recording Rules to open the Recording

Options dialog. The Recording Rules page will display.
Step 2 Click the New Events button to open the New Events menu.

Step 3 Select Breakout Board Data from the New Events menu. This
will cause a button to appear in the Available Events area. The
button will be labeled Breakout Board.

Step 4 Drag the new button to the Global State Cell or to the cell faintly
marked Drag an event here to add another state. The Global
State Cell allows you to set conditions that are globally true (i.e.,
always enabled). The cell marked Drag an event here to add
another state is used to create event sequences - i.e., chains
of events leading to a trigger or other action. For further
explanation, see “Assigning an Action” on page 91.

Step 5 Right-click on the Breakout Board button to open a pop-up
menu.

Step 6 Select Properties from the pop-up menu. The Properties dialog
opens.

Recording Options

Generall Channel Settings  Recording Rules I Channelsl

wl Mew event ~|'}|G|Q|Q|’:|

Awailable Events

Specify Action(s) 3
Maove Evert To 3
Copy Event To »

i Delete This Event

Event Properties

Breakout Board | Actions I

£

Breakout Board

Mask Match

By

Label:

IBreakout Board
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Step 7 If you want to configure the analyzer to trigger on a specific bit
pattern, enter it in the box marked ByteO. Alternatively, you can
enter a hex pattern and mask into the boxes marked Mask and
Match. If no pattern is specified, the analyzer will trigger on ANY
input signal.

Step 8 Click the tab marked Actions.

Step 9 In the Internal Triggering section, select Trigger Analyzer. The
analyzer is now configured to trigger on an input signal.
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Chapter 10: Reports

The Report menu provides several reports to assist you in analyzing traffic recorded by

the Analyzer.

=
Il

File: Information
Errar Surmmary
Timing Calculations
Traffic Surimary
Bus utilization

Link. Tracker

b fm £ [ [ [

Frame Tracker

File Information

To display data on a trace, select Report >File Information from the menu.

File Information

File name : SampleData sas
Trace ocourred © Friday, Sept. 12, 2004 13:17.54
Number of frames: 63

Eecorded with '"CATC SASTracer' analyzer, version 2.00 { Buld 91
Number of markers : 0

Eecording Options

Crptions Mame  Default

Eecording Mode : Snapshot

Buffer Size : 16,000 MB

Post-trigger position © 50%

Base filename & path | C\Program Files\ZATCVI A S Tracer\data sas
Open Recording Options in a dialog

License mformation for the product, Senal Mumber 00000, used to record this trace file

Software mantenance hasn't been enabled.

Available Features
Feature L
Title Purchased Feature Description
2-link Mo Ability to record traffic on first and second SAS/SATA links of the
Recording analyzer

-

[
Save As... | Cloze I/
i

The File Information dialog opens and provides information about the recording such as

when it was made and version of the Analyzer Firmware and BusEngine.

Perhaps the most useful information listed in the dialog is the Recording Option settings
used to create the open trace. These settings are shown in the above screenshot. Also
shown in the screenshot is a hypertext link to the Recording Option settings themselves.
The link is marked with the text Open Recording Options in a dialog. Clicking this link
causes the software to open the Recording Options dialog and automatically populate the

dialog with the settings used to create the open trace.
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Traffic Summary

The Traffic Summary displays a report of traffic in the data file and appears at the bottom
of the SASSuite main window. The left side contains a tree view where you can expand
or collapse types of data you want displayed to the right of the Traffic Summary window.
You can print, e-mail, save to disk, or display data in a two-column table by using the
buttons in the Traffic Summary tool bar.

From the Report menu, select Traffic Summary.

Traffic Summary

BHo& \ it | Go g [0 = ot i - Frame fif
Protocol Units  # I Total
[ Fra, Frames Primitives 18

Address Frames :;'SS‘;S I ;,E
ignals
SR 55P Frames Connect Events
o [SHE SMP Frames Disconnect Events
:----STP STP Frames Transport Layer Transactions 4

SCSI Operations
Management Transactions
.- T8 Transactions ATA Commands

[#- ©Q  Primitives

Z

- C81 SCST Operations
2

2

bl Mgt Mgt Transactions
- ATA ATA Commands

(1) Ervars

All reports

Navigating

The Traffic Summary window also functions as a trace navigation tool. If you click one of
the numbers in the right side of the window, the trace will jump to the first instance of your
selection. Afterwards, click the up or down arrows at the top of the Traffic Summary
window to navigate forward or backward through the display.

Buttons
Buttons at the top of the Traffic Summary window serve to format the display and export
summarized data to email, file, or the printer:

HOo& |

The buttons have the following functions:

Save As - Saves Traffic Displays results tabular text format
E Summary results into an [ﬂj

HTML format

Email - Creates an Displays drop-down menu with:

[1 email with a “.html file Lﬂj Grid Lines - Displays/Hides grid lines
attachment of the

graphs Row Selection - Allows entire rows to be

selected

Tight Columns - Reformats column widths to
match data

% Print
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Error Summary

The Error Summary button opens the Traffic Summary window and displays a list of
errors analyzed throughout the recording.

Step 1 From the Report menu, select Error Summary.
The Traffic Summary window appears with Error information displayed.

Traffic Summary
BEoS& D | Goob [0 ot - Frame it
= B Allreparts Type / [ [m1 [z [tz [ [z [m
E| m Frames Packet Error: Idle Error a o 1) o o a o
Address Frames Packet Error: Bad CRC 2 1} 0 1} 1} il 1}
H Packet Error: Disparity Error a o o o o a o
--IS3E] 55 Frames Packet Error: Bad Code 1o 0 o 0o i
JSME. SMP Frames Packet Error: Alignment Error 0 i i i i ] i
L STE STP Frames Packet Error: Delimiter Error a a 1} a a a a
[#l- Q  Primitives
- Jr8, Transactions
- $C81 55T Operations
B M@t Mgt Transactions
- ATA ATA Commands

Step 2 Navigate to an error within the recording by clicking the number
of the Frame containing the error.

Step 3 Use the arrows to cycle though each occurrence of a particular
error.

Timing Calculations

The timing calculation measures timing between any two specified frames or markers.
The timing calculator feature is designed for tracking bus utilization and I/O performance
in current or previously captured trace files. By default the statistics will be calculated on
a complete capture file or one bounded between markers or between any two frames.

To run the Timing Calculator, perform the following steps:

Step 1 From the Report menu, select Timing Calculations.

From beginning of ToEnd of,

Frame. ~ | |22147 Frame: - | |22150
Marker | |Frame # 22147 [Host opens co Marker w | |Frame # 22150 [Marker #1]
Time - 1218292517850 secs Time - 1218292522425 secs

Total Time: 457500 |nanaseconds B

&

Calculate

Step 2 Select the range, and click the Calculate button. The results will
then display in the window.
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Bus Utilization

The Bus Utilization window displays information on bandwidth use.

To open the Bus Utilization window, select Report >Bus Utilization or click the button

marked iy . A window opens like the one shown below:

Bus Utilization - [scsi_ios_dlinks.sas]

HoS B &aaas @E@ian

Pending 5C51 10s, CHI1-T1 3 & Pending SCSI 10s, CHI2-T2 21& Pending 5CS| 10s, CHI3-T3 O & Pending 5CSI 10s, CHI4-T4 @®

Time:1483ms, Pending I0s5:2610s, SCSI 100554 (WRITE(10))

Link Utilization

. Y Scale Type
£ :
520 |-| : | | Hide
: Ll L | Lo o BIGE |
£, L ih IR e e
100 200 300 400 S00  e00  FOOO SO0 900 1,000 1,100 1,200 1,300 1,400 1,
4 | Froperties

gzu i : Go to SCSI 10 554

'_E',lg | ~ﬂ'l_‘—|v—\._._ﬂ"+'_'-'_\r"_r | ’—'\-—-.-—"—‘_'___,_..n—-._.. k e 3 =
2710 200 300 400 500 600 700 80D 900 1,000 1,100 1,200 1,300 1,400 1, B00 2,000 Time (ms)

o

4 | Zoom to Trace View r

®®

|
I S
ann 2,000 Time (ms)
3

Window Layout
The Bus Utilization window divides into two areas:

* Graph Area - Displays graphs. Initiallv. no graphs will be displayed.
To display one or more graphs, click [] and make a selection from
the menu. See “Graph Areas Menu” on page 179 for an explanation
of the types of graphs listed in this menu.

* Min/Max/Avg Area - Displays the minimum, maximum, and average
values for several parameters. Data is available only after you have
displayed the relevant graph. After displaying a graph, the
Min/Max/Avg information is calculated and is thereafter available to
the user even if the graph is closed. The user can close this section
by clicking [“1 and deselecting Statistics Accumulation from the
menu.
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Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of the displayed
data and for exporting data:

H oS | &

The buttons have the following functions:

=

]

Save As - Saves the
graphs as a bitmap file
(*.bmp)

Email - Creates an email
with a *.bmp file
attachment of the graphs

Print

Full Screen

View Settings - opens a
sub-menu with options for
formatting the display.
See “View Settings Menu”
below

Horizontal zoom in

Horizontal zoom out

& a & Q|

1
<«

hd

471

7%

%
E |

==l

Vertical zoom in

Vertical zoom out

Click and Drag zoom - Click diagonally to
select and zoom in on part of the graph.
The initial direction you begin dragging
the cursor determines whether the
horizontal or vertical axis is magnified.

Select Range

Sync and Graph areas - If two or more
graphs are displayed, this button will
synchronize the graphs to one another.
Once synchronized, the positioning
slider of one graph will move the other
graphs

Graph Areas - Presents a menu of
graphs for various types of bus data

LeCroy Corporation

177



Version 6.25 SASSuite User Manual

View Settings Menu

Clicking the View settings button mjl causes a menu to open g -
with options for formatting the display. Crient harizontally L
* Orient Horizontally - changes the orientation Tlle vertically
of bus usage to horizontal. After selecting v Show Markers
J{?i?—t'optliloq’ the menu will say "Orient | |
ericaty. Status rF
¢ Tile Vertically - tiles the two graphs vertically L
(i.e., side by side). Eifle L=z 4|
* Show Markers - Places "tick" marks along S enuep
the x axis of each graph. Fonts & Calars, .,
T ST TR

¢ Show Plumb Line - Displays a vertical line
that connects your cursor to the horizontal
axis. As the mouse is moved, the status bar will show the packet and
time frame to which the cursor is pointing.

* Status - Opens a sub-menu with the following options:
— Bar - Displays a status bar at bottom of graph.

— Tooltip - Causes a tooltip to appear if you position your mouse pointer
over part of the graph and leave it there for a couple of seconds.

— None - Turns off tooltips and the status bar.

* Grid Lines - Opens a sub-menu with the following options:
— Both - Displays both X and Y axis gridlines

— X Axis - Displays X axis gridlines

— Y Axis - Display Y axis gridlines

— None - Turns off gridlines

* Grid on Top - Moves the grid lines above the graph.

* Fonts and Colors - Opens a dialog box for setting the colors and fonts
used in the graphs:

x|
— Fant
Title:
ITimesNewHoman jl‘l‘l jIB I I
Az
| arial e =] B 1]
r— Color
Title: Background:
[— - [ -
Az Grid:
()8 I Cancel |
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Graph Areas Menu

The Graph Areas menu allows you to view different information in the Bus Utilization
window.

Cal
Step 1 Clickthe L. button.

The Graph Areas menu opens.

Mew. ..

Pending SCSI 10s

SCSI IO Response Time
SCSI IO Lakency Time
SCSI IO Throughput

SCSI IO Response Time & SCSI IO Lakency Time

+  Frame length

Link Ltilization
Data Throughput

Frames Count

Step 2 Select a graph type from the menu. Repeat for additional
graphs.

Note: Some graphs will only be available after decoding the logical SCSI or
ATA layer operations.

Modifying the Appearance of Graphs
To modify a Bus Usage graph, follow these steps below.

Step 1 With a graph displaying in the Graphs Area, right-click anywhere
in the graph and choose Properties from the pop-up menu.

zl
nit_ Title: Appearance:
(][ Frame length on Chanrel T1 IFrame length on Channel Init_1 ILine j
I oo tnon el 12| 22 Eol
([ Frame Iength on Chaneel 13 IFlame lergth awver time from initiator an channel 1 j | \j
LFrame length on Channel T3 — Filter out
(][, Frame length on Channel |4 —Ewvent Groups

[, Frame length on Channel T4

Packet Types

1 Primitives

1S ource Addiesses E”Dng“;?gnal
[1Destination Addresses Open Address Frame
[Data Length |dentify &ddress Frams
[15MP Frames 35P Frame

SMP Frame
[155P Frames Connect
[ 1Channels Disconmect
[CIFIS Types STP Frame

' Hide selscted items

" Show selected items

Hew I Dielete | Restore defaultsl

oK I Cancel Apply

The following dialog box opens.

Step 2 Select an a data type from the box on the left, then edit the Title,
Appearance, Type, or Color boxes as appropriate.

Step 3 Click OK to apply the changes.
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Creating a New Graph
To create a new graph:

Cd
Step 1 Click 3.
Step 2 From the menu, select New ...

Step 3 From the Title, Appearance, and Type boxes, select the
desired options.
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Link Tracker Window

The Link Tracker window displays a detailed chronological view of events. Events are
shown on a primitive-by-primitive basis within columns within the window, each column
represents a single upstream or downstream channel. Time is presented as rows. Idle
time is shown by empty rows in the window. Idles can be collapsed into gray strips
running across the window.

Each time slot in the vertical axis represents the minimum time required by a dword to
traverse the bus.

The time slots are not fixed in size: they vary depending on how zoomed out the display
is. When the Link Tracker is fully zoomed in, time slots for 1.5 G traffic measure 26.66
ns and time slots for 3.0 G traffic measure 13.33 ns.

When the Link Tracker window is fully zoomed out, the grid lines disappear and the scale
changes to 1 dword equaling a line measuring one pixel in height.

Opening the Link Tracker Window
To open the Link Tracker window, select Report > Link Tracker or click the button
marked él A window opens like the one shown below:

EE|pe iy & & | = e g | S 0% o 10b RD. Text

Time | Frame... | i} |
02:01.829 252 253
02:01.829 252 266 RRDY [MORMAL]
02:01.829 252 273 SO
02:01.829 252 293
02:01.829 252 306
02:01.829 252 113
02:01.829 252 333
02:01.829 252 346
02:01.829 252 353
02:01.829 252 373 ]
02:01.829 252 386 LUM[Hi]: 00000000
02:01.829 252 393 LUM[Lo): 00000000
02:01.829 252 413 a
02:01.829 252 426
02:01.829 252 433
02:01.829 252 453
02:01.829 252 466 COE DwWORD ao
02:01.829 252 473 CRLC: E2CCABF3
02.01.825 252 433
02:01.829 252 506

Window Layout
The Link Tracker window divides into two areas:

* Toolbar - Presents buttons for changing data format.

* Main Display Area - Displays traffic chronologically as it occurred in
the recording. The window divides into columns: the first column
shows time and traffic is shown on a channel by channel basis in the
columns on the right.
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Link Tracker Buttons
The Link Tracker window has a row of buttons for changing the format of the displayed
data and for exporting data:

o mEm
ba M1 & & | ed | sy ox 0 10b RD Text

The buttons have the following functions:

4]

o2

Full Screen

Synchronize Trace View.
Synchronizes the Trace View and
Link Tracker windows so that a
move in one window repositions
the other. Because of the
differences in scale and logic
between the Link Tracker and
Trace view windows, scrolling
produces different effects
depending on which window is
being scrolled. Scrolling in the
trace window causes the Link
Tracker window to rapidly jump
from event to event. Long periods
of idle time are skipped. Scrolling
in the Link Tracker window, in
contrast, causes small moves in
the trace window. Scrolling in the
Link Tracker window causes the
trace window to pause until the
start of a packet is displayed. At
that point, the trace window
repositions itself. While scrolling
through idle periods or the
contents of a packet, the trace
window will not move.

View Options. Opens a menu with
three options: Collapsible Idle
Time, Tooltip Display, and Reset
Column Widths. See View Options
Menu below for descriptions.

Zoom In

Zoom Out

Collapse Idles

0:5

10b

RD

o=
Text

Show Values

Show Scrambled Values

Show 10b Codes

Show Symbols

Show text decoding of frame
header fields

Collapse Idles plus. Further
condenses Link Tracker
display to show only first 5
DWORDs of each frame.
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View Options Menu

Clicking the View Options button [[ﬂ'.ll causes a menu to open with options for
formatting the display.

* Collapsible Idle Time - Opens a dialog box for setting the Idle time
value. By setting a value, you tell the analyzer when to collapse Idle
times and display them as grayed out strips within the Link Tracker
window. For example, if you had set the Idle time to value x then any
time an Idle time exceeded x it would be displayed as a gray strip across
the Link Tracker window.

* Tooltip Display - Opens a menu with options for adding content to
tooltips. Tooltips will display when you position the mouse pointer over
an item in the Link Tracker window. The options are:

Tooltip Display Values

Tooltip Display Scrambled Values
Tooltip Displays 10 bit Codes
Tooltip Displays Symbols
Tooltips Displays Text Decoding

The following screenshot shows a tooltip in which all five options have
been enabled:

Features | 3 Gbps C...

L LA bl

Packet 0 (113, dword #1 (10 dwords total)

_ Walue B100FFFF
Compatible Featus | o . - pled value | 43028972
10 hit Code 35 136 26D 13C
Symbols DO3.2¢) D186 ¢) DO9.4 ) D183
Text Decading Initiator Port | Protocol | Type

* Reset Column Widths - This option resets column widths to their
defaults.

Docking and Undocking the Window

You can undock the Link Tracker window by double-clicking on the blue title bar along the
left side of the window. Once undocked, the window can be dragged anywhere in the
application. To redock, double-click again on the title bar.
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Setting Markers

Markers can be set on any dword on any event within the Link Tracker window. To set a
marker, right-click on an event, then select Set Marker from the pop-up menu. Once
marked, events can be easily navigated to via the Go to Marker command in the Search

menu.

Calculating Time between Dwords

You can calculate time between dwords by clicking on a specific cell and then positioning
your mouse pointer over a second cell. A tooltip will display the time delta between the
two cells.

E EETHTET
Step 2 Scroll down through the trace to the second event and position
the mouse pointer over the event. A tooltip will appear showing

the time interval between the first and second events.
RRDY (HORMAL]
RRDY [MORRAL]

Frame Tone- (1

Frame 22362 (T1), Dword #0 (15 dwords total)

Text Decoding |SOF
Value BC18E46T

Tirne from g8lection: 00.000 404 240 —l—

(Selection: Dward#

0 Status: 00

More about Cell Selection

When searching for a frame or primitive within Link Tracker, the found cell will become
the selected cell. When a cell is selected, it will remain selected even if it's off the screen.
Keyboard actions in LinkTracker (scrolling, arrow key, etc...) will not affect the selection.
Once a cell is selected, it can only be deselected by switching the selection to another
cell.

Searching

When the Trace view and Link Tracker windows are synchronized, the Find and Go To
options in the Search menu will apply to the Link Tracker window. The Trace and Link
Tracker windows can be synchronized by selecting the Synchronize button EI
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Hiding Traffic

You can hide Aligns, Channels and other data from the Link Tracker window by clicking
the Hide buttons on the toolbar in the Trace window gl gl gl @ or by
selecting one or more of the various Hide options in the Display Options dialog box.

Zooming In and Out

Zooming out can give you a quick, high-level view of a trace. A fully zoomed out trace
will only show columns and colored lines. Using the colors you can see what types of
traffic running through the trace - for example, brown represents data, and dark green is
a Start of Frame.

Further information can be obtained on any point of interest in the trace by positioning
your mouse pointer over it. Tool tips provide detailed description of events.

Note that when fully zoomed out, the smallest graphical unit is the dword, represented by
a single line. Zooming out makes the trace appear smaller and increases the time scale
in the first column.

|[@eaits & @ |[ise] 5" 63 1o fo rem
I

Time [ Packettt | n | 11 | 12 [ T2 I 13 | 13 | 14 [ T4 |

7783 (T1)
I S e I I

[

7793112)

mmeasere 0
2550563 946 538
E58563E 75 oo (1)
Z5g5639u5912 | (212N
2558 563 847 098
mspmasarzes o)
2558563 947 471
2558563 947 658 7805112)
26595563947 845
2568663 348 031 s
2550563948 218
2550563 948 404
2558563 948 531
2650563948 776

2553 563 348 964
2556563943 151
2550563949 338
2550563 949 524
2659562943 711
2553 563 843 837
2550563 950 084
2558563 950 271
2550563 950 457
2659563 950 644
:553sezas0es | (o103
2550563951 017

255056395 04 | 7817(72)
2550563 951 330

%5956295 577 | 7818 (T1)
2553 563 361 764

mmseagsi 0 oo 1)
2550563952137

5EBSeash el Faz3l E—
2659563952510

2558 563 962 637 7825113

550563952683 | 7230(T2)

2558563953070 737 T3

2550563 953 257

2559563953 43

LTt

2558 563 959 415
g G ]
2659 563 959 728

55353953 ars | 793 (T3

2558563964 640 7836(1)
25.58 563 964 827
259,963 965 014
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Collapsing Idle Time, Enabling Tooltips, and Resetting Column
Widths
Click the View Options button @I to open a menu with options for formatting the
display. Three options are presented:

Collapsible Idle Time - Opens a dialog box for setting the Idle time thresholds. Setting
a value tells the analyzer when to collapse Idle times and display them as grayed out
strips within the Link Tracker window.
e E;EUEEU;E;U;E;E ‘dlit;:j [ ALIGN 01
Tooltip Display - Opens a menu with options for adding content to tooltips. Tooltips will
display when you position the mouse pointer over an item in the Link Tracker window.
The options are:
* Tooltip Display Values
* Tooltip Display Scrambled Values
* Tooltip Displays 10 bit Codes
* Tooltip Displays Symbols
* Tooltips Displays Text Decoding
The following screenshot shows a tooltip in which all five options have been enabled:
Inititor Port | Protoc.. IlﬂlF -
| Packet 0 {13, dword #1 (10 dwords total)
. alue S100FFFF
Lompatble Featlie [ - pled value | 43028972
10 hit Code 3146 136 280 13C
Syrbols D03.2¢) D186 () D094 &) D163 ()
Text Decoding Initiator Port | Protocol | Type |
Reset Column Widths - This option resets column widths to their defaults and enables
columns to resize themselves automatically any time the application window is resized.
Normally, columns will automatically resize themselves if the application window is made
larger or smaller. However, if you manually resize any columns in the Link Tracker
window, column widths become static. Thereafter, if you resize the application window,
the Link Tracker columns will not adjust automatically. Reset Column Widths
re-enables this automatic resizing capability.
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Frame Tracker Window

The Frame Tracker window displays a detailed chronological view of traffic on a
Frame-by-Frame basis. Events are shown within columns within the window, each
column representing a channel. Time is presented as rows. Idle time is shown by empty
rows in the window.

Each time slot in the vertical axis represents the elapsed time required by the Frame to
traverse the bus.

Opening the Frame Tracker Window
To open the Frame Tracker window, select Report > Frame Tracker or click the button
marked El A window opens like the one shown below:

|Efseit1@ &

| Tirne [ Framet | i}

00,353 630 235 132107

00353680717 132108 | SATA RCY, Frimitives: 3435
00.353 772 997 132113

00,363 773 260 132114 | SATA RCY, Primitives: 3449
00,353 865 640 132120

00.353 866 002 13211 [ SATA RCY, Primitives: 3475
00.3532 958 B26 132124

00,353 956 992 132127 | SATA RCY, Primitives: 3398
00.354 101 485 132163

00.354 101 245 132164 SATA RCY, Primitives: 87
00,354 193235 132221 P:0, FIS H->D, CMD RD FPDMA QUE
00,354 193637 132222

00.354 230 350 132283

00,364 231 287 132284 | SATA RCY, Primitives:80
00,354 07 237 132509

00.354 807 585 132600 | SATA RCY, Primitives:83
00.354 816 745 132609

00,354 817 110 132610 | SATA RCY, Primitives: 3382
00.354 407 380 132615

00.354 907 745 132616 | SATA RCY, Primitives:3411
00,364 938 EEQ 122618

00,354 230 027 132622 | SATA RCY, Primitives: 3432
00.355 032 070 132625

NN 2FF 97 AR 17ene CATH BEU Brirvikivee: 2977

Window Layout

The Frame Tracker window divides into two areas:
* Toolbar - Presents buttons for changing data format.

* Main Display Area - Displays traffic chronologically as it occurred in
the recording. The window divides into columns: the first column
shows time and traffic is shown on a channel by channel basis in the
columns on the right.
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Frame Tracker Buttons
The Frame Tracker window has a row of buttons for changing the
format of the displayed data and for exporting data: | E[”ﬂ‘_j @& Q
The buttons have the following functions:
Full Screen (ﬂ Zoom In
Synchronize Trace View.
e:*‘il Synchronizes the Trace View and El Zoom Out
Frame Tracker windows so that a
move in one window repositions
the other.
View Options. Opens a menu with
m three options: Collapsible Idle
Time, Tooltip Display, and Reset
Column Widths. See View Options
Menu below for descriptions.
View Options Menu
Clicking the View Options button Lﬂl causes a menu to open with options for formatting
the display.
Time Format- Opens a menu with options for setting the time format.
There are two options:
* Seconds
* Clocks
Reset Column Widths - This option resets column widths to their
defaults.
Normally, columns will automatically resize themselves if the application
window is made larger or smaller. However, if you manually resize any
columns in the Frame Tracker window, column widths become static.
Thereafter, if you resize the application window, the Frame Tracker
columns will not adjust automatically. Reset Column Widths
re-enables this automatic resizing capability.
Docking and Undocking the Window
You can undock the Frame Tracker window by double-clicking on the blue title bar along
the left side of the window. Once undocked, the window can be dragged anywhere in the
application. To redock, double-click again on the title bar.
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Calculating Time between Frames
You can calculate time between cells within Frame Tracker by clicking on an event and
then positioning your mouse pointer over a second event and reading the ensuing tooltip.

Step 1 Click on the time value for the first event.

| Time | 11
000,356 554 212
00,356 554 502 | SATA RV, Frimiives: 3411
00,355 545 470
00,355 E45 555 | SATA RV, Primitives 3341

Step 2 Scroll down through the trace to the second event and position
the mouse pointer above its time value. A tooltip will appear
showing the time interval between the first and second events.

00.356 554 B2 | SATA RCY, Primitives: 3411
00.356 645 470

00.356 645 855 | SATA RCY, Primitives: 3341
00.356 735017

00,356 735 37 | SATA RCY, Primitives: 3557
00.356 830 1&

00.356 530 53 . F
00,356 915 Bg Tirne from selected Frame #1331745: 00,000 089 905

Hiding Traffic

You can hide Aligns, Channels and other data from the Frame Tracker window by clicking
the Hide buttons on the toolbar in the Trace window gl gl gl @ or by
selecting one or more of the various Hide options in the Display Options dialog box.

Searching

When the Trace view and Frame Tracker windows are synchronized, the Find and Go To
options in the Search menu will apply to the Frame Tracker window. The Trace and
Frame Tracker windows can be synchronized by selecting the Synchronize button. EI

Zooming In and Out

Zooming out provides a high-level view of a trace. This allows users to display more
events on screen. Cell coloring can be used to distinguish between different types of
traffic on the bus.
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Chapter 11: Networking

SASTracer

BNC

N USsB

SASTracer UsB
USB SASTracer

Ethernet LAN (TCP/IP) \A

SASSuite has networking and cascading functions that are described in this chapter.

* Cascading -- Allows mutliple analyzers be linked (or "cascaded”) together
into a single, synchronized, logical unit in order to increase the number of
ports that can be monitored. To enable synchronized multi-analyzer
recording, the analyzers are connected together via their connectors on the
back of the analyzers. These connections are used to send clocking
information and recording commands are sent from one analyzer to another.

* Networking -- SASSuite can support analyzers connected remotely over an
IP LAN. Using the Network browse dialog, you can remotely control one or
more analyzers.

Working with Multiple Analyzers

Multiple analyzers can be set up in three ways:

Directly Connected by USB - Two or more analyzers can be connected to a single host
PC via USB. In this setup, no additional cables are used (as they are in a Cascaded
setup) and the analyzers function as non-cascaded, standalone units. Users toggle back
and forth between the units.

Cascaded - Two or more local analyzers linked together. One (or all) of the analyzers
then connect via USB to a host PC.

The link cable functions to transmit clocking and control information between the
analyzers, thereby allowing the analyzers to function as a cascade - i.e., a single, logical
analyzer. Cascading analyzers allows them to perform synchronized, multi-analyzer
recordings.

Connected Remotely over an IP Network - A PC connected to analyzers across an IP
network.
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Hardware Setup for Direct USB Connections

Connecting multiple analyzers to a single PC by USB gives you the convenience of being
able to control multiple analyzers from a single SAS Suite application. The application
provides you with a means of toggling back and forth between the different analyzers that
are connected.

To set up multiple analyzers via USB, you attach
USB cables between the analyzers and the host
PC as shown in the illustration on the right. If you
do not intend to group the analyzers together for
synchronized multi-analyzer recordings, no m
further hardware setup is required. If you do Osp | oASTracer
intend to group the analyzers, then you will need

to add connection cables as described in the section below under "Setup for Multiple
Analyzer Use." Once the analyzers are connected and started, you can browse to the
analyzers via the command Setup > Analyzer Network ...

SASTracer

USB

Note: The SASSuite software will allow you to toggle between the
analyzers but not run two copies of SASSuite software on your
screen simultaneously.

Setup for Cascaded Multiple Analyzer Use

Using SAS Tracer Analyzers are connected in a cascade using the "EXT IN" and "EXT OUT"
Multiple BNC connectors on the rear of the chassis. SAS Tracer supports up to four analyzers
SASTracer connected together in a cascade.
Analyzers If you add a BNC connection between the
analyzers shown, you create a cascade
which allows the analyzers to function SASTracer
together as a logical unit. Cascading BNC
. " USB
increases the numbers of ports that can be
simultaneously recorded. USB SASTracer
To set up a cascade, you connect a BNC =
cable between the External Output port on the back of one [ H
analyzer to the input port on the second. The first analyzer will T
serve as the controlling or master analyzer. It will transmit clocking ( =]
information, Recording Option commands and other data to the SR = ki m
other analyzers. If you plan to group three or four analyzers ]
together, daisy-chain the remaining analyzers together, and then ( ﬂ
loop the output of the last analyzer to the input of the first analyzer s e=ldy Il
as shown in the figure on the right. / =
Note: For SASTracer Analyzers, the BNC cables must O H
form a complete loop by connecting a BNC cable
from the last analyzer’s "EXT OUT" port to the first analyzer’s "EXT
IN" port.
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Using
Multiple
Avalanche
Analyzers

Avalanche Analyzers are connected in a cascade using the "SYNC IN" and "SYNC OUT"
DB-9 connectors on the rear of the chassis. Avalanche supports up to eight analyzers
connected together in a cascade.

If you add a DB-9 male-to-female cable
connection between the analyzers shown,
you create a cascade which allows the

Avalanche
analyzers to function together as a logical USB
unit. Cascading increases the numbers of z DB-9
ports that can be simultaneously recorded. Usg | /\alanche

To set up a cascade, you connect a DB-9

cable between the SYNC OUT port on the back of one
analyzer to the SYNC IN port on the second. The first
analyzer will serve as the controlling or master analyzer. It
will transmit clocking information, Recording Option
commands and other data to the other analyzers. If you
plan to group more than two analyzers together, daisy-chain
the remaining analyzers together using additional DB-9
male-to-female cables.

Note: For Avalanche Analyzers, the resulting
connection is an open daisy chain. Do
NOT form a loop by connecting an extra
cable between the first and last analyzers.

Note: As of the date of this release, Avalanche and SASTracer Analyzers
cannot be mixed together in a cascade.

Set Up for Remote Access over an IP LAN

Analyzers can be run remotely

over an IP network. Inan IP

network, the analyzers connect

their respective hosts via USB and SASTracer uss
. usB SASTracer

the hosts, in turn, connect to each

other via IP. - $

Setupinvolves installing SASSuite
software on each analyzer host, then enabling IP LAN connectivity between the hosts.

When the remote analyzer is powered on, you connect remotely control the analyzer via
its host. Your connection will be Local host => Remote host => Analyzer.

Use the command Setup > Analyzer Network to browse to the remote host.

You can cascade IP-connected analyzers by adding BNC connections between the
analyzers as described above in “Setup for Cascaded Multiple Analyzer Use” on
page 192.
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Configuring the Connection

Once you have completed the physical setup, you are ready to configure the analyzer

connection.
USB Configuration for two or more USB connected analyzers is minimal.
Connected In the following example, two SAS Tracer analyzers are linked via USB to a host PC. You
Analyzers

connect to one of the two analyzers.
Step 1 Start the SASTracer analyzers and the SASSuite software.
Step 2 From the menu, select Setup > All Connected Devices.

The Analyzer Network dialog box opens. To select an analyzer, check
the relevant checkbox on the left.

Analyzer Devices x|
Analyzer | Platform I ME | Slot 1 | Slat 2 | About |
SASTracer SH:21]  UPALOK I0:i0x1 ReviOx3
SASTracer SN:202 | UPALOK I0:0xd Revils Updeiz BE/F |

Update License: |
Fecarding Options|
Select analyzer devices you want to participate in the recording ;I

Step 3 Click Close.

The dialog box closes and the analyzer is selected. The SASSuite
software on your screen will now control the selected analyzer.

Note: You can update the Firmware, BusEngine and License from this
dialog by checking an analyzer and then clicking the appropriate
button on the right. You can also directly open and set Recording
Options for any of the analyzers by checking one or more analyzers
and then clicking the Recording Options button. The Recording
Options dialog will open. The settings you create will apply to all
selected analyzers.
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Remote To configure SASSuite to remotely control an analyzer over an IP LAN, you will need to
Analyzers use the Analyzer Network dialog to browse to the host controlling the analyzer and add
Over an IP both the host and its PC to the dialog.

Network Step 1 From the menu, select Setup > Analyzer Network.

The Analyzer Network dialog box opens. This dialog lists host PCs and
their analyzers. The listed devices are either currently connected or
were connected at some point previously.

Analyzer Network =
Computer I Analyzer devices | Add... |
Local machine  SASTracer SMi211, SASTracer SN:202
=) a-sBLT SASTracer SN:213 ml

Recannect |

Step 2 Remove any host (other than the Local Machine) from the list by
selecting the host and then clicking Remove.

You should keep in the list only the host(s) that you are planning to
immediately use.

Step 3 To add a host and analyzer to the list, click Add.

A browse dialog box opens.

x
| Computer | Comment |;|
= yotr-aL1 ali Babba
=ypaco DiscJockey CD Jukebox o
= V\DKARPKALOY  Derek Karkalov
=yoLeELD DAN LEELO
= psTuka Dritri Stuka
=)vipvont Diane Yori Select |
'l,'l,EFOOS Eugene Foosball
BIUEINENBL  Eric June =l

Step 4 Browse to the host that has an analyzer attached to it and
double click on it.

Step 5 The host will be added to the Analyzer Network dialog.
Step 6 Click Close to close the dialog box.

Step 7 Select Setup > All Connected Devices ... to open the Analyzer
Devices dialog box.

Analyzer Devices x|
Analyzer [ Platform [ M8 [ siat 1 [ Siot 2 | Aot
[ 5AsSTracer SN:211 | UPALOK 1001 Rewvi0x3
SASTracer SHi202 | UPALOK | IDiOx1 Rewild Updein B2/
Update Lisense:
Recording Options
Select analyzer devices wou want to participate in the recording ;I
»
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Step 8 Uncheck all boxes except for the one for the remote analyzer
that you wish to connect to.

Step 9 Click Close to close the dialog box and establish a connection
to the selected analyzer.

Recording To configure SAS Tracer analyzers to work as a group (i.e., into a cascade), attach BNC
Multi-Trace cables as described in “Setup for Cascaded Multiple Analyzer Use” on page 192, then
Files perform the following steps:

Step 1 Perform Steps 1 and 2 as described above in “USB Connected
Analyzers” on page 194.

The Analyzer Devices dialog box will open.

Step 2 In the Analyzer Devices dialog box, verify that the checkboxes
are checked for the cascaded analyzers.

Step 3 Click Close.
The dialog closes and the analyzers are selected.
Step 4 Test the setup by recording some traffic.

If the analyzers are not connected by the BNC cables, an error message
will appear prompting you to correct the problem.

Step 5 The SASSuite software will display traffic from each analyzer in
adjacent windows. The windows are synchronized together and
can be scrolled in tandem.

KRQUT (228 |x MK m |8 5T 20600

[B2 b sep Record Generate Report Seanch ew ook Wi

1 Initiator SAS Address

arg
50000010_00273360 50001
Initiator SAS Address Initiator SAS Address Ta re
50000D10_00273360 5000CCAD_0343C] 0 50000D10_00273360 50010890 00005/
Initiator SAS Address Targ Initiator SAS Address Ta re
50000D10_00273360 5000CCAD_0343C] 2 50000D10_00273360 50010890 000054
n Initiator SAS Address I Initiator SAS Address |
50000D10_00273360 50000D10_00273360
1 Initiator SAS Address Targ I Initiator SAS Address
50000D10_00273360 5000 50000D10_00273360
Initiator SAS Address Initiator SAS Address Ta re
50000D10_00273360 5000CCAD_0343C] 50000D10_00273360 50010890 00005/
Initiator SAS Address Targ Initiator SAS Address Ta re
50000D10_00273360 5000CCAD_0343C] 50000D10_00273360 50010890 00005/
n Initiator SAS Address I Initiator SAS Address |
50000D10_00273360 50000D10_00273360
1 Initiator SAS Address Targ I Initiator SAS Address
50000D10_00273360 5000 50000D10_00273360
Initiator SAS Address Initiator SAS Address Ta re
50000D10_00273360 5000CCAD_0343C] 50000D10_00273360 50010890 00005/
Initiator SAS Address Targ Initiator SAS Address Ta re
50000D10_00273360 5000CCAD_0343C] 9 50000D10_00273360 50010890 00005/
e
KN} Io|
Reac

Multi-Trace file before merge - two synchronized trace files
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Merging Traces

Traffic from each analyzer can also be merged together into a single
unified display (as shown below). See Merging Multi-Trace Files on
page 198.

Bf fle Seup Gecod Generste Report Seach Vew Dok Wndow e —lslx|

FHREE VKL [22/8 K 8w TRt Lo B LoEaewEEs |00

Initiator SAS Address
50000D10_00273360

Initiator SAS Address
50000D10_00273360

Initiator SAS Address
50000D10_00273360

Initiator SAS Address
50000D10_00273360

Initiator SAS Address
50000D10_00273360

Initiator SAS Address Target SAS Address
50000D10_00273360 50010890_0000542D

Initiator SAS Address T:
50000D10_00273360 50010890_0000542D

Initiator SAS Address T:
50000D10_00273360 50010890_0000542D

Ready Search: Fud

Multi-Trace file after merge - one unified trace file

The merged view includes the Link Tracker display providing time
correlated analysis of DWORD level data structures.

SASSuite v2.5 and later supports merging multi-trace files (*.smtt) recorded on an
Avalanche or SAS Tracer into a single trace display containing up to 16 bidirectional links
of traffic. The merge feature is ideal for analyzing 4 lane traffic moving both upstream and
downstream through a SAS expander device. It's primarily intended for use when
cascading multiple analyzers together. The BNC interface is used to synchronize the
timing information across multiple systems (for configuration information, see Setup for
Cascaded Multiple Analyzer Use on page 192).

Note:

Although this feature is intended for merging traces that have been
recorded as multi-trace files, it can be used for merging regular trace
files (that have a .sas or .sata file extension) as follows: Make sure
the files you want to combine are in the same folder. Select Open...
from the File menu. Choose all the files you want to combine by
holding down the "Ctrl" button and clicking on each file, then click
Open. This opens the files in a side-by-side display. Select Merge
Multi-trace... from the File menu. You will get a message saying the
file has not yet been saved, click OK and then provide a filename for
the combined trace file. You will then get the dialog shown in Step 2
below, allowing you to merge the files.
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Merging Multi-Trace Files
Merged files can be created either by selecting Merge Multitrace files... with a .smitt file
open or by selecting the .smtt file from the Select SAS Multitrace File for Merging...
dialog:

Step 1 Select 'Merge Trace files...' item in 'File' menu

Step 2 If an .smtt file is open, the 'Merge Multi-Trace recording' dialog
will open and automatically populate the Merge Trace Layout list
with the individual segments of the currently open .SMTT file.

& x|

Select Multi-Trace recording file for merging:

|C:\Progiam Files\CATCASAS Tracer\Sample Files\SAS_B:

terge trace layout | the order defines channel numbering |

Trace name: Channels:  Timestamp delta: Chor et
Trace 1: |dala228.sas | n-14 ‘ Ojns =
Trace 2: |datad73.sas [ 1878 | Olns = ﬂ
Trace 3 | | ‘ J
Trace 4: | | ‘
° Start Merge
Settings

[ Put merged files inta the special folder

[ Add serial numbers of recording devices to merged custom channel settings

[ Ovenaite silently if merged file already exists

™ Close the Merge dialog after merging

M Ext

Note: The application recommends the channel layout for the merged files. For steps
to change the channel layout; see Altering Channel Layout on page 201.

Alternatively, users may click the 'Select SAS Multitrace File for
Merging..." dialog to choose up to 4 different files to merge.

198
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Step 3 Click the Start Merge button to begin merging the selected files

All open trace files will be closed before merging begins. The time
required to complete the merge process is dependent on system
performance. The merging process can be stopped before merging is
complete either by clicking the button 'Stop Merge' or by exiting the
dialog. During the merge process, the Merge dialog will display:

@ Merge Multi-Trace recording E‘

Select Multi-Trace recording file for merging:

[C:\Program Files\CATC\SAS TracerSample Filss\SAS_B: |:|

Merge trace layout [ the order defines channel numbering |

Trace name: Channels: Timestamp delta:

Ch. d
Trace 1: [ nTe | e
Trace 2 ‘dala4?3.sas | 15-Td ‘ Olns = J
Trace 3: ‘ | ‘ J
Trace 4 ‘ | ‘ &

° Stop Merge

llllllllllllllllllllllllﬁlllllllllllllllllllllll

Settings
r
\

-

-

[ Close the Merge dialog after merging

m Exit

Step 4 When the merging process completes, the Merge File Output
dialog will invite users to open the resulting merged file:

o =

the lst of fles that were created duiing merging

the Dpen’ button (or double-click on the fls) i
i

Note: If the total recording has more than 32,000,000 frames or events, then the
merged file will be truncated and a new one will be started from that point. The
merge operation will produce as many files as necessary to complete the full
merge.
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The merge feature will only display channels that actually contain valid
SAS/SATA traffic. For example, a multi-trace file captured from 4
cascaded systems with real traffic in only the first channel (on each
analyzer) will result in a display with traffic on channels: (11/T1), (I5/
T5), (19/T9), and (113 /T13).

Adjusting Timestamps Between Merged Trace Files
When using more than one analyzer in cascaded configuration, the
segments are automatically synchronized by timestamp. It is possible to
adjust timestamps between different segments. This allows users to
customize the display (post-capture) to accommodate for latency that
may occur on one of the links in the system under test.

Step 1 Select the Timestamp Delta field

Step 2 Enter the amount of the delta to add to the trace file
Merge trace layout [ the order defings channel numbering |

Trace name; Charnels: — Timestamp dela;

Trace 1; ‘ddl.sas \ 11-T4

|
Trace 2 |dd.sas N WWns + ﬂ
|

Change order

Trace 2 ‘ ‘
Trace 4: ‘ ‘

Step 3 Select the time increment using the pop-up menu (ns, us, ms,
sec)

Step 4 Press Start Merge button.

Step 5 The designated time interval will be added to the first timestamp
in a selected trace.

It's best to rename the merged trace using Save as... after altering the
time delta in case the timing is changed unintentionally, the user can
revert back to the original and repeat the process.
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Altering Channel Layout

When a multi-trace file is selected for merge, the application recommends the channel

layout of the merged file. The ' Merge Multitrace Recording' dialog allows customization
of the display order. For example, some users may prefer to keep the initiator traffic on

links 1-4 with d
Step 1
Step 2

Step 3
Step 4

Note

Merge dialo

ownstream traffic on links 5-8.

Within the Merge Multitrace Recording' dialog, select the trace
file name that you wish to reposition to a different set of
channels.

Use the arrow key to move up or down in the Trace Order
display

Repeat to reposition other trace files in the display if needed
Press the start merge button

: The time required to complete the merge process is dependent on system
performance. At least 1048 MB RAM and SCSI or SAS-based storage devices
are recommended when merging large files.

g settings
Put merged files into the special folder

If checked, this setting instructs the application to put resulting merged
files into the specified folder. If it is not set resulting files will be saved in
the folder where the merged multi-trace file is located.

Add serial numbers of recording devices to merged custom
channel settings.

If checked, this option instructs the application to add the serial numbers
from the analyzers in front of the custom channel settings (different from
the default ones). If it is not checked, the channel settings are copied
without changes.

Overwrite silently if merged file already exists

If checked, this option instructs the application not to prompt user in case
if a file having the same name as a resulting merged file already exists
and overwrite it silently. If it is not checked, the application will prompt
user before overwriting it.

Close the merge dialog after merging

If checked, this option instructs the application to close the merge dialog
after merging is complete. If it is not checked, the merge dialog will
remain open.

Manually merging two or more regular trace files

Merging trace files is primarily designed for use with multi-analyzer
cascaded recordings. However, the merge feature can also be used to
combine regular trace files (*.sas) or multi-segmented files (*.smt ). To
manually merge up to 4 trace files follow steps in “Merging Multi-Trace
Files” on page 198 except click the 'Select SAS Multitrace File for
Merging..." dialog and choose up to 4 different files to merge.
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Network Chat

Analyzer Network Chat is a utility that allows users to conduct chat sessions over an IP
LAN.

In order to send and receive electronic text messages, each user must be working with a
PC that is attached to an analyzer. And each PC must, in turn, be connected to an IP
LAN.

To start a chat session,

Step 1 Select View > Analyzer Network Chat Bar from the menu. The
following dialog opens.

[MR-BILL] 51772004 3:13:49 Pt
I Send

Step 2 Clickin the cell at the bottom of the window and type some text.

Step 3 Click Send. The sent text will appear in the top of the window
next to your prompt.

202 LeCroy Corporation



SASSuite User Manual Version 6.25

Chapter 12: Traffic Generation with
SAS Trainer

SASTrainer is a traffic generator that can emulate a SAS initiator/target or SATA
host/device. Traffic generation enables engineers to test designs under realistic
conditions and to transmit known errors, allowing engineers to observe how devices
handle faulty link conditions. Traffic generation is performed via the execution of
text-based scripts. These scripts contain statements about the types of traffic to be
generated.

SAS/SATA Exerciser Hardware

LeCroy SAS Trainer requires both the SAS Analyzer module and the SAS Exerciser
module that plugs into the right slot of the CATC 10K chassis. Installing the SASTracer
Exerciser module will require that you remove ports 3&4 (if equipped with a 4 port
analyzer) or the blank face plate (if equipped with a 2 port analyzer).

Figure 2: SASTracer/Trainer 2 port Analyzer with Exerciser option installed

pm = = e s
'MODEL
/\ SASUMA SAS / SATA Analyzer Model 10000

[=%2 ¥ o’
' I‘/, MODEL SAS00IMG $45 / SATA Exercize,
WTUTOR  Tancey b TAToR
TARGET b

Setting Up SAS/SATA Exerciser for Initiator Emulation

Connect the SAS cable from the

SAS/SATA Exerciser To Target port to e eaddpibicy,
the Target port on the unit under test. sTaTUS

This transmits the Traffic Generator ® ==
stream from the To Target port on the —f

SAS Tracer/Trainer to the target-side

port on the unit under test. TARGET ACTIVE%TIAYOR >
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Setting Up SAS/SATA Exerciser for Target Emulation

Connect the SAS cable from the ~——————

SAS/SATA Exerciser To Initiator port to S 1 Cx W00 aatoren. SAS [ SATA Exerciier

the Initiator-side port on the unit under =

test. This transmits the Traffic Generator ~ - o TOTARGEY

stream from the To Initiator port on the T S
(2

SASTracer/Trainer to the initiator-side
port on the unit under test.

TARGET  ACTIVE @AITIATOR

Generating Traffic

Generating traffic using SASSuite is a two step process. First, a text-based Traffic
Generator file must be created. This file can be created through a special conversion
command in SASSuite that converts a trace file captured by a SASTracer analyzer into a
traffic generator file. Alternatively, you can edit an existing file or write your own.

This text file is named with an .ssg extension. Once the file has been created, in can be
opened and displayed in the SASSuite application. You can invoke the SASSuite
application to transmit the traffic generation file by using the Traffic Signal button EI .

File Export As Generator Format ﬂil
Save in; | ‘3 Sample Fies <] « & ok B

F test 1,550

File: marne: |test2.ssg Save I
Save as type: ISASTrainer Generator Files (*.s3g) j Cancel |

Link &nd Direction

[ Do nat expart hidden packets
IH j v Use &uto Alignment
Fram : Ta:

Frame v| IlJ Frame v| |35
b arker v| I b arker v| I
Tirme - | I 0.0000000000 secs Time - | I 00000383025 secs

4
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Creating a The easiest way to create a Traffic Generation file is to convert an SASTracer trace file

Traffic (*.sas) into a *.ssg file. This is done with the Export function in SASSuite.
Generation ,
File with Step 1 Open a trace file.

SASSuite Step 2 From the menu, select File>Export>to Generator File Format
(-ssg). The Export to Generator Text screen appears (.ssg).

There are several options .
File Name - Enter a user-defined file name.

Save As Type - There is but one option: SASTrainer Generator Files
(-ss9).
Link and Direction - Select the source and direction of the traffic you

are going to export into a traffic generation file. You can only export a
single uni-directional link (for example, 11).

Do not export hidden packets - If selected, will only export traffic that
is currently displayed onscreen. Traffic hidden via the various hide
buttons will not be exported into the traffic generation file.

Use Auto Alignment - If selected, exports Auto Aligns to the traffic
generation file.

From - (Optional) Enter the range of traffic (in Frames, Markers, or Time)
to be exported. The default is to export all traffic in the open trace.

Step 3 Select the desired options, the click Save.

A Generator file (*.ssg) has now been created and can be read with the SASSuite
application.
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Opening a Traffic Generation File

Once the Traffic Generation file (*.ssg) file has been created, you can then open itin the
SASSuite application.

To open a Traffic Generation file,

Step 1 Select Open under File on the Menu Bar

OR
|
Click =2 | on the Tool Bar.

Step 2 Select a Generator text file (*.ssg) and click Open. If needed,
navigate to the install directory. For samples, see the install
directory. The Generator file appears in a Trace view, shown

below:

“ﬁ File Setup Record Generate Report  Search  Wiew  Tools  Wwindow Help _|51|x||
e |[pE sifaqE 2o xan] | [BLodEeuds
[femswaloode@@06®] |2 EEE: s

-

RateMatching ‘ MultiSpeed

|
[ OFF \ OFF

Auto00B AutoHOLD AutoDMAT AutoHndShk

OFF OFF OFF
008 Settings - COMINIT H Murn Bursts \ Burst Length | ldle Length \ Megation Len |
I & | 160 | 480 | 800 |
006 Settings - COMWAKE ‘ | Mum Bursts ‘ Burst Length | Idle Length ‘ Megation Len |
I & | 160 | 160 | 280 |
00B Settings - COMSAS H Murm Bursts \ Burst Length | Idle Length \ Megation Len |
[ 5 \ 160 | 1440 \ 2400 |
Align Time 010.2 Time
100000 100000
Align1 Time AlignQ Time Interspeed
61520 81920 750000
SAS Connect Command Settings ‘ | SNLT ‘ SNTT | RCDT ‘
[ 15300 [ 1s3m0 [ 7sooon |
Auta Wait ¢ CLOSE | CLOSE EOF | ACK EOF | ACH OPEN | ACCEPT
OFF OFF OFF OFF
OPEN | REJECT = IdenFr|ldenFr  SMPReq | Resp
OFF OFF OFF K|
[« T 0|
Mo devices [ [
Ready [ [ [ Search: Fwd A4
Layout The .ssg file will show several colored bars across the screen that represent global

settings. The bars serve to show how the generation file is currently configured. These
settings include the link speed (1.5 Gbps vs. 3.0 Gbps), the type of device (for example,
SAS Initiator or SATA Device), COMINIT, COMWAKE and some other settings. As
changes are made and saved to the traffic generation file, the bars will immediately
update.

The actual traffic pattern that is about to be generated appears below the bars as a series
of Frames. In the generation file shown in the above screenshot, the first generation
Frame is a Start of Address Frame labeled as Frame 8.

You can edit the traffic generation file to add, edit or remove frames.
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Starting the Script Editor

To edit an .ssg file, use the Script Editor. The Script Edit is an editing tool that will display

the .ssg file and its supporting Include files.

To launch the Script Editor: click the Script Editor button on the toolbar

in the trace window and choose Edit as Text.

or right-click

The Script Editor window will open and display in the lower portion of the trace window.

Jm Fle Setup Record Generate Report Search Yew Tools  Window Help

il

lereeE|pvE =il |ese | me| ]

J

GEyC)

W

(=] %]

AutoHOLD AutoDMAT

[Emewnonoe@n®a| |2 EEE:
LINK SPEED - 1.5Ghps |[ RateMatching | MukiSpeed |
OFF | OFF |

008 Settings - COMINIT || Mum Bursts ‘ Burst Length | ldle Length ‘ Negation Len |

| & | 160 | 480 | 500 |

OCE Settings - COMWAKE |[ Mum Bursts | BurstLength | ldle Length | MNegation Len_ |
| g | 160 | 160 | 200 |

008 Settings - COMSAS || Num Bursts ‘ Burst Length | ldle Length ‘ Negation Len |
| & | 160 | 1440 | 2400 |

i

ipt Editar

palf] f BB e oo e E R s

B 8| e

# This SASTrainer generation script is exported from the trace file
# C:\Program Files\CATC\SASTracer\Sample Filesidata.sas ,
# Frawes O to 100 .

%include "Generation) Include'\PrimitivesDecl.inc'
zinclude "Generation Include' AddressFramesDecl.inc™
%include "Generation) Include' SSPFramesDecl.inc'™

9 zinclude "Generation’ Include) SMPFrawesDecl.ine'

1]
2
3
4
5 zinclude "Generation) Include)Seccings. inc™
[
7
=}

11 et GeneracionMode = GEN MODE SATL HOST
12, et Speed = LINK_SPEED_1_SG

14; Generation

il

C
W[ 4| #[m[\ data.ssg K]

I

The Script Editor divides into three areas: the toolbar, the script window, and the file tabs
at the bottom of the window. If errors occur, a log will open at the bottom of the window.
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Toolbar The toolbar contains buttons for saving your edits, navigating, searching and other
functions.
=X L o e EERRE MRS e
The buttons have the following functions:
Save. Saves your edits and
| = | immediately updates the setting K | Go to next bookmark.
bars and Frames shown in the
trace window.
View Options. Opens a menu with
m]l three options: Enable Outlining, i | Go to previous bookmark.
Toggle Outlining, and Line
Numbers. See View Options Menu
below for descriptions.
& | Cut. & | Clear all bookmarks.
Copy. M | Find.
2 |
Paste. !b Find and Replace.
ﬂ'l Undo. & | Print.
ﬁ"l Redo. —iil Go to Definition.
Add/Remove bookmark. Allows - Open File Under Cursor.
= | markers to be set or removed to L Opens whatever file has been
aid in navigation. pointed to with the mouse in
the script. This command
works with Include
statements.
View Options Menu
The View Options button has a menu with three options:
¢ Enable Outlining - Adds an expandable/collapsible tree W| y B
structure to the left side of the Script Editor showing the .L : -
hierarchical relationship of the script lines. | Bl "t G T
* Show Line Numbers - Adds line numbers to the left side of the [ show e enbers
Script Editor window. | Bl S e 1
* Show Tooltips - Displays tooltips in the editor window. Toggle Cutlining
¢ Toggle Outlining - Toggles the outline tree between collapsed and expanded states.
208 LeCroy Corporation



SASSuite User Manual Version 6.25

File Tabs

Error Log

Pop-up Menu
Right click anywhere in the script

. . et

window to open a pop-up menu withthe - C:w

following options: 1@ pacte

Cut - Cuts selected text. “| ) oo DeFintion of

COpy _ COpieS Selected teXt. l FI:,‘?( Open File Ct\Program Files\CATCYSASTracer\Generation Include\PrimitivesDecl.inc
. ﬂ Close File

Paste - Pastes selected text. 2 D
|~ Enable Gutlining

Go to Definition of - Repositions the Togalz Cutlning

script window to whatever definition '.|T W Rl

has been selected.

Open File - Opens whatever file has been pointed to with the mouse in the script. This
command works with Include statements - for example, "%include
"Generation\Include\PrimitivesDecl.inc".

Close File - Closes whatever script file is currently being displayed.

Enable Outlining, Toggle Outlining, and Line Numbers - Enables the three options
described above under View Options Menu.

At the bottom of the window are a series of tabs that allow the .ssg file and its supporting
Include files to be opened and edited. The Include files open automatically when the
software first reads the script.

[ 4 #]m[+ test2.ssg & Settings.inc PrimitivesDeclinc AddressFramesDeclinc

Whenever you create a scripting error, a log will open at the bottom of the application
window. When the error is corrected, the window automatically closes.

ZEneration Scripk Editar

Bl ¢ BR| oo |[ 4% %% BB S
& IDLE (239) B
7 i
8 set ssc = NotTodayThanks
H -
|<|q|)|>||nl5rimitiues.ssg Settings inc PrimitivesDecline ]| « | ]
| File (Line) | Diescription |

B C:\Program Files\CATC\SASTraceriGe, . \Primitives.ssg {-10  Undefined identifier NotTodayThanks' used For setting 'ssc’
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Overview of Generation and Global Settings Files

Sample .ssg files and Include files reside in two directories called
\Samples and \Include that are typically installed in:
C:\Program Files\LeCroy\SASTracer\Generation.

{:l Samples

Traffic The .ssg traffic generation files are text files consisting of include statements, a
Generation generation block and, optionally, global statements.
(*.ssg) Files

The generation block is the code responsible for the actual traffic generation. Itis marked
by the tag "Generation." The composition and format of the generation block is described
later.

Yoinclude "Generation\IncludelSettings inc”

Seneration

{
}

The include statements provide links to the Include files which, in turn, provide the
definitions for primitives, frames, and "global settings" - i.e., settings that hold for most or
all of the generation session.

The definitions for SAS and SATA traffic are contained in five LeCroy-provided Include
files: Settings.inc, PrimitivesDecl.inc, AddressFramesDecl.inc, SSPFrames.inc,
SMPFrames.inc and SSPFrames.inc.

210 LeCroy Corporation



SASSuite User Manual

Version 6.25

Settings.inc
File

The Settings.inc file contains global statements about the link, the type of device being
emulated, and other conditions that are to exist throughout part or all of the traffic
generation. This file must be included in the traffic generation file.

There are fifteen groups of settings in this file:

AutoMode
COMINIT/COMRESET OOB Signal
COMWAKE OOB Signal
COMSAS OOB Signal
Generation Commands
Link Speed
SATA Link Initialization
SAS Speed Negotiation
SATA Speed Negotiation
Autowait:

*SAS After

*SAS Before

*SATA After

*SATA Before
Wait Command Timeout

Scrambling Mode

Details about each group of settings are described in the following chapter Traffic
Generation Language.
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Editing Settings.inc
Text in the Settings.inc file can be edited directly or copied into the beginning of the traffic
generation file and edited there. Many users opt for this latter approach.

Yoinclude "Generation\Include’PrimitivesDecl inc”
Yoinclude "Generation\Includel\Settings inc”

=et Generationddode = GEMN_MODE_SATA HOST

Generation

{
}

When editing global settings, keep in mind the following rule:

* The last line encountered before the generation block takes precedence. Thus,
if the following two lines about the device emulation were added just above the
generation block, the second would take effect:

set GenerationMode = GEN_MODE_SATA_HOST
set GenerationMode = GEN_MODE_SAS_INITIATOR

Zinclude "Generstion Include) 3ettings.inc”
Zinclude "Generstion’ Include' 33PFrameshecl. inc”

. . Get GenerationlMode = GEN_MODE_SATA HOIT
This will Set GenerationMode GEN MODE 545 INITIATOR

take effect

Feneration
{
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The Global Setting "AutoAlign"

AutoAlign is a global setting that may be on or off depending on the type of device
you are emulating. There is an AutoAlign setting for SAS and one for SATA - for
example, "set AutoAlignSAS = ON" and "set AutoAlignSATA=0OFF."

SAS - Sends AutoAligns every 2048 dwords.
SATA - Sends AutoAligns every 256 dwords.

If you plan to set and reset AutoAlign in the middle of traffic generation, then you need to
know what the defaults are for AutoAlign. The defaults are as follows:

For SATA host/device emulation, then
* AutoAlignSATA is assumed to be ON
* AutoAlignSAS is assumed to be OFF.
For SAS emulation, then the assumptions are opposite:
* AutoAlignSATA is assumed to be OFF
* AutoAlignSAS is assumed to be ON
For STP,
* AutoAlignSAS and AutoAlignSATA are assumed to be ON
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Placing Global Settings in the Generation Block

Some global settings such as AutoAlign = On/Off can be set and reset in the generation
block. For example, a user might want to set SASAutoAlign = ON prior to traffic
generation and then have it change to OFF half way through the generation session.

Yoinclude "Generation\Includel\Settings inc”
Y¥oinclude "Generation\Includel\35FFramesDecline”

Generatien
{
# SendsSFPFramelata
#1
# Data={ 21223344 535667788 39 AABBCC )
#1

send=SPFrameXferEdy

{
Data = { 51223344 55667788 RO AABBCC )

}
Generation :
- _ Global Setting added
Set Auto AlignSAS =0FF 4—
Block & to generation block

send3SPFrameCommand
send>5PFrameResponse

send3SPFrameTask

j Data = { 31223344 55667788 P9 AABBCC }

K Send3SPFrameVendor
i

When placed within the generation block and then viewed in the trace window, global
settings appear as colored bars interspersed amidst the traffic.

ag [ crc ]
0 hytes || 0x74258E65 - 0.000 hs 00.000 000 320
Auto 00

m HCRC m_ m

00000 _|[0 hytes || x53404RD4 - 0.000ns 00.000 000 560
[_CrRc__| [

Dxnnun 12 bytes DxC486DEI1D - 0.000 ns 00.000 000 800

Tor

00000 |[0 bytes |[ OxBCFIGE0F | [ 00.000 001 120

TASK
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Primitive

Special
Conditions
for Frames

While most global settings can be set in the generation block, three will be ignored if
placed within the generation block:

set Link Speed =
set GenerationMode =
set SSC =

These commands should be configured either in the Setting.inc file or at the beginning of
the traffic generation file as a global statement.

and Frame Definitions

Five other Include files are provided that define the most of the known templates for
Primitives and Frames. The five are:

* PrimitivesDecl.inc
* AddressFramesDecl.inc
* SSPFramesDecl.inc
* SMPFramesDecl.inc
* STPFramesDecl.inc.
Each of the Frame templates defines header and field structure.

The default value for all Frame fields is zero.

There are three conditions about Frames that need to be kept in mind when configuring
Frame generation:

1. Frame delimiters need to agree - At the present time, when defining a Frame, make
sure that the Frame Prologue and Frame Epilogue agree. Do not mix types. For
example, do not mix a SAS Start of Frame (SOF) with a SAS End of Address Frame
(EOAF).

A SAS SOF should be matched to a SAS EOF, a SAS SOAF should be matched to a SAS
EOAF. If generating SATA traffic, a SATA_SOF should be matched to a SATA_EOF.

At the present time, if you mix different types of prologues and epilogues for any given
Frame, the Frame will be ignored.
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2. Data Length Fields can be fixed-length or variable - By default, data frames are
of a fixed length. If you want to generate variable length frames, then place an asterisk
in the Data definition field in the SSPFramesDecl.inc file:

- %
Data :
39!
40! DATA
‘11 Data HE # Variable length field, can be assigned to an array of DWORDs

4z
43!

If you replace the asterisk with a value, then the field becomes fixed length.

3. CRC Calculations will be calculated by SASSuite unless told otherwise - If the
CRC is not explicitly set in the traffic generation file, SAS Suite will assume that you want
it and will calculate and display it in front of the generated frames.

If the user provides a CRC value, SAS Suite will use that value even if it is incorrect. This
gives the user the option of configuring the generator to create errors.

If the generation file was created through the Export command (i.e., File > Export > To
Generator File Format ...), the CRC is calculated but commented out. If the source trace
has a bad CRC, the CRC is exported into the generation file and is not commented out.

Primitives The PrimitivesDecl.inc file defines Primitives. The file consists of a declarations (left) and
Decl.inc the corresponding byte stream (right).
& Primitiwve SO0ALF = kEC 15 1E 51
7 Primitiwve EOQAF = kEC 18 &7 9F
=1
=l Primitiwe TALIGH (0O)' = kEC 4L 44 VB
10 Primitiwe TALIGH (1)' = kEC 07 07 07
11 Primitiwe TALIGH (2" = kEC 81 61 A1
12 Primitiwe TALIGH (3" = kEC 7B 7E 7B
To generate Primitives, copy relevant portions of text on the left (i.e., not the bytes shown
right) from this file into the generator block section of the .ssg file.
For examples of usage, see primitives.ssg in the Samples directory.
Address The AddressFramesDecl.inc file defines Address Frames.
I?:::meSDeCI For examples of usage, see AddressFrames.ssg in the Samples directory.
SSPFrames The SSPFrames.inc file defines SSP Frames.
-Inc For examples of usage, see SSPFrames.ssg in the Samples directory.
SMPFrames The SMPFrames.inc file defines SMP frames
-Inc For examples of usage, see SMPFrames.ssg in the Samples directory.
STPFrames The STPFrames.inc file defines STP frames
-Inc For examples of usage, see STPFrames.ssg in the Samples directory.
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Working

with Generation Files

The easiest way to generate traffic is to start with one of the sample generation files and
edit the settings to see how the script file behaves. As you make and save changes, the
trace view of the generation file is automatically updated.

The following screenshots shows the sample file SSPFrames.ssg as it appears in the
script editor and trace window.

#include "GenerationhIncludenSSPFramesDec].inc'
Generation

sendssPFrameData

3 H

Data = { 21223344 GSEE7785 S9RABBCC }

H H

SendssPFramexTerkdy

Darta = { 51223344 L5E67788 99AABBCC 1

SendsSPFrameCommand
ZendsSFPFramerespanse
SendssPFrameTask

Data = { 51223344 GEEESFEE 99AABBCC ]

sendssPFramevendaor

AUOHOLD  AutoDMAT - AutoALIGN - AutoHndShk By
OFF OFF ON OFF ON

OOB Settings - COMINIT ][ Mum Bursts [Burst Length [ Idle Length [Negation Len|
1 [ 2 [ 3 | 4 |
0O0B Seftings - COMWAKE | [ Mum Bursts [Burst Length [ Idle Length [Negation Len|
e [ 7 ] 8 |
OOB Seftings - COMSAS ][ Mum Bursts [Burst Length [ Idle Length [Negation Len|
[ | 10 | 1 | 12 |

Link Initialization Settings Align Count D10.2 Count

Speed Megotiation Settings J[ sMT [ swim [ RCDT |

I 15 | 16 | 17 |
cor
0:0000 |[12 bytes || Ox669F7A35 0.000 ns 00.000 000 000
cor
0 bytes || 0x74258E55 - 0.000 ns 00.000 000 320
cor
O bytes || 0x534048D4 - 0.000 ns 00.000 000 560
— —
0x0000_|[12 bytes || 0xC4850D810 - 0.000 ns 00.000 000 800
cor
0 bytes || 0xBCFI8BOF - 00.000 0071 120

0x0000

K]
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In the lower screenshot, global settings make up the eight bars at the top of the window.
Below that are five frames. If you look at the script itself, you will see that there are six
frame commands, five active and one commented out.

Generating Traffic

Once the .ssg file has been opened onscreen, recording and traffic generation can begin
at any time.

Step 1 Click ﬂ to begin the recording.

Step 2 If the script does not have a connect block built into it, connect
the exerciser to the DUT by clicking the Connect Link button
vﬁ%nl- Clicking this button will cause the generator to invoke the

us settings in your script (for example, the global settings)
and then establish a connection.

Step 3 Click the Start Generation button El on the Tool Bar.

While generating traffic, a bar appears on the right of the trace view, indicating that traffic
generation is taking place (The green light on the Traffic signal button also blinks during
traffic generation).

Stop Traffic  Normally, traffic generation stops automatically when SASSuite reaches the end of the
Generation  Generator file.
To manually stop traffic generation, Click the Stop Generation button il

Resume If traffic generation is stopped prior to the end of the script, it can be resumed.

Traffic . To resume traffic generation, Click the Stop Generation button 32 .
Generation
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Chapter 13: SASTrainer Generation
Language

The SASTrainer File Generation Language is an API that allows you to separate traffic
into text commands. These commands are used construct primitives and frames that are
sent to the host or the device.

File Structure

Traffic Generation files (*.ssg) should have the following structure:

Declarations +  Global generation settings
+ Constants
« Data patterns
»  Chain of symbols (primitives, raw data, etc)
* Packet templates

Note: Some declared objects could be used in further declarations as long
as they are previously declared. No forward declarations are
allowed at this time.

Generation « List of generation instructions
blocks
Note: It is possible to create many generation blocks - but at current time
only a block with the name 'Generation' will be executed. (Calls of
some blocks from another blocks are not currently allowed)
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Language

Comments:

'#' - Comment symbol. The line remainder after this symbol will be ignored.
'1*' ™[ - Comment Block. All the text between /' ™' and ™' '/ is ignored.
[
This is an example of a block of comments.
*/

Includes: %include "FileName.inc" - This directive includes the file "FileName.inc". This lets the
user add common definitions and templates into new scripts.
Language parser makes sure the same file is not included more than once.
EXAMPLE:
%include "Somelnc.inc" # This directive will actually include file 'Somelnc_1.inc'
%inline - The same as %include, but without the Language parser check.
Settings Using the "Set "Constant Name" = Value" statement, users can set different
constants/modes using the following value types:
*  Predefined constants (TRUE/FALSE/ON/OFF/INFINITE/etc)
*  Numbers
EXAMPLES:
Set AutoAlignSATA=ON
Set WaitTimeOut=239
Constants Only unsigned integers can be defined as constants. Some constants are predefined in
SASTrainer.
EXAMPLES:
Const SOME_HEX_DATA = 0xAABBFFEE # defines hexadecimal
constant
Const SOME_DEC_DATA =12 # defines decimal constant
Const "SOME DEC DATA" =64 # defines decimal constant
Const "Some Hex Data" = OxCDCDBEBE
Predefined + TRUE
Constants . FALSE
+ ON
« OFF
* INFINITE
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Data
Patterns

Primitives

Data patterns are streams of hexadecimal values. Using '["]' lets the user include
constants or predefined data pattern in another pattern.

EXAMPLES:

DataPattern PATTERN_1 = AAAABBBB [SOME_HEX_DATA] EEEEFFFF
1210ABB1 AAAABBBB 1210ABB1 AAAABBBB 1210ABB1 AAAABBBB
1210ABB1 ['SOME DEC DATA"] 1210AB

DataPattern PATTERN_2 = 00000000 11111111 22222222 33333333
AAAABBBB 55556666 FEFEFEFE CDCDCDCD 9999BBBB 12343434
6767676B 56BBFF

DataPattern PATTERN_3 = [PATTERN_1] FFFFFFFF EEEEEEEE
[SOME_HEX_DATA]

DataPattern SOME_PATTERN = BBBBBBBB DDDDDDDD

Primitives can be defined using the following:
* Byte values (k' indicates control symbol). The 10b codes are calculated
based on the current running disparity
+  Primitives are completely interchangeable with SymChains.
EXAMPLE:

Primitive "CHAIN (ONE)" = kBC 1E 1E 1E kBC 1A OF
SymChain ChainTwo = k28.5 D12.3 D10.2 D11.6
SymChain ChainThree = k28.3 3EA 25 k18 IFA
Primitive SOF = kBC 18 E4 67
Primitive EOF = kBC 18 FO 9B
* Raw 10 bits codes. This definition might cause running disparity errors.
EXAMPLE:

Primitive "CHAIN (TWO)" = 305 2D4 1E4 362

* Mixed bytes and 10b codes. This definition might cause running disparity
errors.

EXAMPLE:
Primitive "CHAIN (TWO)" = 305 2D4 1E4 362 ["CHAIN (ONE)"]
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Packets/ Using the "Frame" or "Packet" keyword, user can define a frame of traffic to be used in
Frames the generation stream. Declarations of prolog and epilog may be mixed with field
declarations.

Frame "name" : "parent name"

{
Field Definition O: "Field Name : Field Length = Default Value"

Field Definition n: "Field Name : Field Length = Default Value"
Primitive Definition 0: "Primitive name, offset, count”
Primitive Definition m: "Primitive name, offset, count"

Prolog = "primitive name"
Epilog = "primitive name"
}

* Field Definition

» Field length is in bits, "' means that the length is variable and will be set
based on the assigned value

» Field starting offset is calculated from frame start based on the length of
the previous fields

EXAMPLES:

Field32 : 32 = OxAABBFFEE
FrameType :8 =12
HashedDest : 24 = HEX_DATA
Reserved1 :8 =0xDA

Field16 116 = OXAAAA
Reserved2 :8 =0xAD
CRC 132

+ Data field Definition
+ "Data = { pattern }" - Pattern is assigned to Data

+ "Data = count, value" - A pattern of "count" times "value" is assigned to
Data

+ "Data = count, start value, step" - A pattern of values starting with "start
value" with steps of "step” and a length of "count” is assigned to Data

*  Primitive definition. Primitives are inserted into the frame payload. Primitive
definitions are inherited by descended frame templates

* Assigning "™ clears all previous settings (maybe from parent frame
template).

+ Offset specifies the dword offset where this primitive will be inserted in
the Frame

*  Count specifies how many times to repeat the primitive

222 LeCroy Corporation



SASSuite User Manual Version 6.25

EXAMPLES:
Primitive : *
Primitive : SOF, 48 # where 48 = offset
Primitive : "CLOSE (NORMAL)", 36, 5 # where 5 = repeat
» Prolog and Epilog define Primitive chains to be used at the beginning
and end of the frame
EXAMPLES:

Prolog = SOF # For this frame primitive 'SOF' is used as a Prolog.
Epilog = EOF # For this frame primitive 'EOF' is used as a Epilog.

» Frames can be derived from other Frames, therefore inheriting the layout of
the parent Frame. In this case, the user may:

» Change Prolog and Epilog
* Change default field values
* Add new fields

FRAME EXAMPLES:

Frame Some Frame

{
Field32 : 32 = OxAABBFFEE
FrameType :8 =12
HashedDest : 24 = HEX DATA
Reserved1 : 8 = 0xDA
Field16 1 16 = OXAAAA
Reserved2 : 8 =0xAD
Data : *=PATTERN_1
CRC 132
Primitive : *
Primitive : SOF, 48
Primitive : SOF, 96
Primitive : "CLOSE (NORMAL)", 36, 5
Prolog = SOF
Epilog = EOF

}
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Frame Some_Frame_1: Some_Frame

{
Field32 = "Some Hex Data"
Data ={ 11111111 22222222 33333333 44444444 55555555 }
Opcode 1128, 8, 0x2A
LBA 164
Primitive : *
Primitive : "CLOSE (NORMAL)", 24, 48
Prolog = "CHAIN (ONE)"
Epilog = "CHAIN (ONE)"
}

Generation Block

SAS Trainer will generate the stream that is defined in this block.

Generation

{

Chain Definition (Repeat = N, Idle = M)
Chain Definition (N, M)

Chain Definition

Frame Definition

Frame Definition (RunningDisp = ON/OFF)
Frame Definition

{

Field Definition

Data Definition

} (Repeat = N, Idle = M, RunningDisp = ON/OFF)
}
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Definitions
*  Chain Definition:

»  Without any parameters, the chain is sent once

*  With "Repeat" and "Idle" parameters, the chain is sent N times and then
nothing is sent (idle) M times. "Repeat" and "ldle" are optional.

* Frame Definition

»  Without any parameters, send the frame based in default values

»  With "RunningDisp" ON, send the frames based on default values and
insert a running disparity error.

»  With parameters overriding or adding to a template frame, with or
without injection of an overriding or adding to a template frame, with or
without injection of running disparity error.

Field You can declare a variable (var_name) as a frame of type (frame_type)
Variable

. var name = frame type
Declarations $var_ —yp

Note: Framevariablescanbedeclared/re-declaredandusedmanytimes.

Changing You can change some fields in a frame variable
E:r:m: Change var_name { field_name = value }
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The user can declare DWORD variables, make arithmetic operations and use them in
Preprocess field and parameters assignments
or_lntege_r Note: Arithmetic expressions are allowed only in numeric variable assignments.
arithmetic
EXAMPLES:
Legal Operations
X=2
y=(z=12)+ (SOME_DEC_DATA+36)/8
z=0x1<<5
s = "Some Hex Data" # constant may be used in operations
X++
y__
z+=(x+y)
x=((y&OxFF)>>5)/12
SOF (Repeat =x, Idle =y)
X
{
Field16 = OXEEEE # Example of the data payload assignment which uses
both integervariables, constants, hex literals and data patterns
Data = {yyyy7a7a7a7a"Some Hex Data" "Some Hex Data" 8b8b8b8b
zzzz [PATTERN_3]}
}
(Repeat =10, Idle =y ) # uses integer variable for parameter/setting
lllegal operations
X=y+2
SOF ( Repeat = (x+y)*7 ) # - illegal, use z = (x+y)*7 SOF ( Repeat =z ) instead
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Loops Loops can be used in two modes:

1. Using an integer number, loop a specified number of loops. This number has to be
smaller than 64K.

2. Using the word "infinite", loops for ever.

Loops ( loop_count/Infinite )
{

send instructions
assignments

change values

send instructions

}
EXAMPLE:
LOOP( 50 )
{
"CHAIN (ONE)"
"CHAIN (TWO)"

Some_Frame

$Y = Some_Frame { Data = 256, OXFEFEFEFE }
Y

Change Y { Field32 = x }

Y

Y
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SASTrainer Generation Commands

General
Commands

IDLE (n) Generator will insert n idle dwords into gen stream

CLEAR_CREDIT_AVAIL | This commands clears the credit established with the command
WF_CREDIT_AVAIL. (See WF_CREDIT_AVAIL in following section
on Wait Commands for explanation).

RD_POS Generator will insert one idle dword into gen stream, which will bring
current RD to positive level

RD_NEG Generator will insert one idle dword into gen stream, which will bring
current RD to negative level

RD_ERROR Generator will insert one idle dword into gen stream, which will
intentionally break RD sequence creating RD error

CONNECT Generator will go through connection sequence using current
GenFile settings (gen mode, speed e.t.c.) Generation will not
resume until connection is established

DISCONNECT Generator will break existing connection to DUT

PAUSE Generator will come to a break and the user will be able to resume
generation by pressing Resume button on Generation toolbar.
Generator shall transmit idle dwords while in the Pause.

OUTPUT_ON Takes the Trainer out of Electric Idle state. If it is already out of
Electric Idle, this is a NOP.

0O0B Commands

COMINIT Generator will send COMINIT OOB signals using current COMINIT
settings.

COMRESET Generator will send COMRESET OOB signals using current
COMRESET settings.

COMWAKE Generator will send COMWAKE OOB signals using current
COMWAKE settings.

COMSAS Generator will send COMSAS OOB signals using current COMSAS
settings.

SATA_ALIGN Generator will go through SATA_ALIGN stage of SATA SpeedNeg

process using current SATA_ALIGN settings.

SATA D10 2 Generator will go through SATA_D10_2 stage of SATA SpeedNeg
process using current SATA_D10_2 settings.

SPEED_NEG_RCDT Generator will go through SPEED_NEG_RCDT stage of SAS
SpeedNeg process using current SPEED_NEG_RCDT settings.
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SPEED_NEG_ALIGNO

Generator will go through SPEED_NEG_ALIGNO stage of SAS
SpeedNeg process using current SPEED_NEG_ALIGNO settings.

SPEED_NEG_ALIGN1

Generator will go through SPEED_NEG_ALIGN1 stage of SAS
SpeedNeg process using current SPEED_NEG_ALIGN1 settings.

SATA
Commands

Look at STP sample file for syntax.

+ SEND_SATA FRAME
« SendSATAFrame

+ SATAData

* SATA Data

+ SATACRC

+ SATA CRC
*  SATAXXXX

¢ SATA XXXX
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Primitive
Commands

The following is a list of SAS and SATA primitives declared in "Primitives.Decl.inc" as
Symbol Chains. If you want to use these primitives in your script you must also include

"Primitives.Decl.inc" in your script.

SOF
EOF
SOAF
EOAF
ALIGN (0)
ALIGN (1)
ALIGN (2)
ALIGN (3)

NOTIFY (ENABLE SPINUP)
NOTIFY (RESERVED 0)
NOTIFY (RESERVED 1)
NOTIFY (RESERVED 2)

ACK
NAK (CRC ERROR)
NAK (RESERVED 0)
NAK (RESERVED 1
NAK (RESERVED 2)
CREDIT_BLOCKED
RRDY (NORMAL)
RRDY (RESERVED 0)
RRDY (RESERVED 1)
SATA_SOF
SATA_EOF
SATA_CONT
SATA_DMAT
SATA_HOLD
SATA_HOLDA
SATA_PMACK
SATA_PMNAK
SATA_PMREQ_P
SATA_PMREQ_S
SATA_R_ERR
SATA_R_IP
SATA_R_OK
SATA_R_RDY
SATA_SYNC
SATA_WTRM
SATA_X_RDY
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SATA ERROR
AIP (NORMAL)
AIP (RESERVED 0)
AIP (RESERVED 1)
AIP (RESERVED 2)
AIP (RESERVED WAITING ON PARTIAL)
AIP (WAITING ON CONNECTION)
AIP (WAITING ON DEVICE)
AIP (WAITING ON PARTIAL)
BREAK
BROADCAST (CHANGE)
BROADCAST (RESERVED 0)
BROADCAST (RESERVED 1)
BROADCAST (RESERVED 2)
BROADCAST (RESERVED 3)
BROADCAST (RESERVED 4)
BROADCAST (RESERVED CHANGE 0)
BROADCAST (RESERVED CHANGE 1)
CLOSE (CLEAR AFFILIATION)
CLOSE (NORMAL)
CLOSE (RESERVED 0)
CLOSE (RESERVED 1)
ERROR
HARD_RESET
OPEN_ACCEPT
OPEN_REJECT (BAD DESTINATION)
OPEN_REJECT (CONNECTION RATE NOT SUPPORTED)
OPEN_REJECT (NO DESTINATION)
OPEN_REJECT (PATHWAY BLOCKED)
OPEN_REJECT (PROTOCOL NOT SUPPORTED)
OPEN_REJECT (RESERVED ABANDON 0)
OPEN_REJECT (RESERVED ABANDON 1)
OPEN_REJECT (RESERVED ABANDON 2)
OPEN_REJECT (RESERVED ABANDON 3)
OPEN_REJECT (RESERVED CONTINUE 0)
OPEN_REJECT (RESERVED CONTINUE 1)
OPEN_REJECT (RESERVED INITIALIZE 0)
OPEN_REJECT (RESERVED INITIALIZE 1)
OPEN_REJECT (RESERVED STOP 0)
OPEN_REJECT (RESERVED STOP 1)
OPEN_REJECT (RETRY)
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OPEN_REJECT (STP RESOURCES BUSY)
OPEN_REJECT (WRONG DESTINATION)
DONE (ACK/NAK TIMEOUT)

DONE (CREDIT TIMEOUT)

DONE (NORMAL)

DONE (RESERVED 0)

DONE (RESERVED 1)

DONE (RESERVED TIMEOUT 0)

DONE (RESERVED TIMEOUT 1)

SAS Specific Script-Defined Constants
SAS_AF_DT_NO_DEVICE_ATTACHED
SAS_AF_DT_END_DEVICE
SAS_AF_DT_EDGE_EXPANDER_DEVICE
SAS_AF_DT_FANOUT_EXPANDER_DEVICE
SAS_AF_FT_IDENTIFY
SAS_AF_FT_OPEN
SAS_AF_PROTOCOL_SMP
SAS_AF_PROTOCOL_SSP
SAS_AF_PROTOCOL_STP
SAS_AF_PROTOCOL_UNKNOWN
SAS_AF_RATE_1_5_GBPS
SAS_AF_RATE_3_GBPS
SMP_FRAME_TYPE_REQUEST
SMP_FRAME_TYPE_RESPONSE
SMP_REPORT_GENERAL
SMP_REPORT_MANUFACTURER_INFO
SMP_DISCOVER
SMP_REPORT_PHY_ERROR_LOG
SMP_REPORT_PHY_SATA
SMP_REPORT_ROUTE_INFO
SMP_CONFIGURE_ROUTE_INFO
SMP_PHY_CONTROL
SSP_FRAME_TYPE_DATA
SSP_FRAME_TYPE_XFER_RDY
SSP_FRAME_TYPE_COMMAND
SSP_FRAME_TYPE_RESPONSE
SSP_FRAME_TYPE_TASK
SSP_FRAME_TYPE_VENDOR
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Wait Syntax: WAIT_FOR { <command1> <command2> ... <group1> <group2> ... }
Commands
WaitCommand Name Description
WF_TIMEOUT Timeout Credit Available

When WF_TIMEOUT is requested in WAIT_FOR command
the wait session will be released after timeout has elapsed.

The Timeout value can be set two different ways:

1. Through the global WaitTimeout setting that can appear
anywhere in generation. Default value is 1000 microsec-
onds.

Syntax:

Set WaitTimeout = <value> (in microseconds)

2. Through local WaitTimeout value for this specific wait
session.

Syntax:

WAIT_FOR ( <number_of _microseconds> ) {
WF_TIMEOUT <other_wait_commands> }

In this case wait for other commands will be released no
later then after number_of microseconds, but global Wait-
Timeout value remains unchanged for future use.

See Generation\Include\

WaitCommands.inc in your SASTracer program folder for

the samples of syntax.

WF_SOF primitive
WF_EOF primitive
WF_SOAF primitive
WF_EOAF primitive
WF_ACK primitive
WF_NAK_CRC_ERROR primitive
WF_NAK_RESERVED_0 primitive
WF_NAK_RESERVED_1 primitive
WF_NAK_RESERVED_2 primitive
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WaitCommand Name Description

WF_CREDIT_AVAIL Credit Available
This function is based on a 10-bit counter whose value can
range from -512 to +511 (twos-complement). This counter
is cleared by sending or receiving an OPEN_ACCEPT
primitive, or by execution of a CLEAR_CREDIT_AVAIL
command in the script.
This counter is incremented by receiving any SAS RRDY
primitive and is decremented by sending SAS SOF. The
wait_for command will wait for this counter to have a posi-
tive value between +1 and +511. This wait_for condition is
intended to be used before sending a SAS frame within a
connection.
CIEAR_CREDIT_AVAIL clears this credit function.

WF_CREDIT_BLOCKED R | CreditBlocked Received

ECEIVED This function is based on a flip-flop which is cleared by
sending or receiving an OPEN_ACCEPT primitive. It is set
by receiving a CREDIT_BLOCKED primitive. It is intended
to be used in conjunction with wf_credit_avail to prevent
script hangs in those cases where there is not going to be
any more credit granted.

WF_CREDIT_BLOCKED primitive

WF_RRDY_NORMAL primitive

WF_RRDY_RESERVED 0 primitive

WF_RRDY_RESERVED _1 primitive

WF_BREAK primitive

WF_CLOSE_CLEAR_ primitive

AFFILIATION

WF_CLOSE_NORMAL primitive

WF_CLOSE_RESERVED 0 | primitive

WF_CLOSE_RESERVED_1 | primitive

WF_DONE_ACK_NAK _ primitive

TIMEOUT
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WaitCommand Name Description
WF_DONE_CREDIT _ primitive
TIMEOUT
WF_DONE_NORMAL primitive

WF_DONE_RESERVED_0 | primitive

WF_DONE_RESERVED_1 primitive

WF_DONE_RESERVED_ primitive
TIMEOUT_O

WF_DONE_RESERVED_ primitive
TIMEOUT _1

WF_ERROR primitive
WF_HARD_RESET primitive
WF_AIP_NORMAL primitive
WF_AIP_RESERVED_0 primitive
WF_AIP_RESERVED _1 primitive
WF_AIP_RESERVED_2 primitive

WF_AIP_RESERVED _WAIT | primitive
_ON_PART

WF_AIP_WAIT_ON_CONN primitive

WF_AIP_WAIT_ON_ primitive

DEVICE

WF_AIP_WAIT_ON_ primitive

PARTIAL

WF_IDENTIFY_FRAME Identify Address Frame
WF_OPEN_FRAME Open Address Frame
WF_SMP_REQUEST SMP Request Frame
WF_SMP_RESPONSE SMP Response Frame
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WaitCommand Name Description
WF_REC_RESOURCES _ Advanced Wait Condition A
OUTPUT_A This command causes generation to wait for Event "A" to

occur that you defined in the Generation Options dialog
described at the end of this chapter.

WF_REC_RESOURCES _ Advanced Wait Condition B

OUTPUT_B This command causes generation to wait for Event "B" to
occur that you defined in the Generation Options dialog
described at the end of this chapter.

WF_REC_RESOURCES Advanced Wait Condition C

OUTPUT_C This command causes generation to wait for Event "C" to
occur that you defined in the Generation Options dialog
described at the end of this chapter.

WF_REC_RESOURCES _ Advanced Wait Condition D

OUTPUT_D This command causes generation to wait for Event "D" to
occur that you defined in the Generation Options dialog
described at the end of this chapter.

WF_REC_RESOURCES Advanced Wait Condition E

OUTPUT_E This command causes generation to wait for Event "E" to
occur that you defined in the Generation Options dialog
described at the end of this chapter.

WF_REC_RESOURCES Advanced Wait Condition F

OUTPUT_F This command causes generation to wait for Event "F" to
occur that you defined in the Generation Options dialog
described at the end of this chapter.

WF_COMRESET_COMINIT | COMRESET OOB Signals

WF_COMSAS COMSAS 0OB Signals
WF_COMWAKE COMWAKE OOB Signals
WF_BLOCK1_MISC_ reserved

RESERVED_0

WF_BLOCK1_MISC_ reserved

RESERVED _1

WF_BLOCK1_MISC_ reserved

RESERVED_2

WF_BLOCK1_MISC_ reserved

RESERVED_3
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WaitCommand Name Description
WF_BLOCK1_MISC_ reserved
RESERVED_4
WF_SATA CONT primitive
WF_SATA_DMAT primitive
WF_SATA EOF primitive
WF_SATA ERROR primitive
WF_SATA_HOLD primitive
WF_SATA_HOLDA primitive
WF_SATA PMACK primitive
WF_SATA_PMNAK primitive
WF_SATA_PMREQ_P primitive
WF_SATA PMREQ_S primitive
WF_SATA_R_ERR primitive
WF_SATA_R_IP primitive
WF_SATA R _OK primitive
WF_SATA_R_RDY primitive
WF_SATA _SOF primitive
WF_SATA SYNC primitive
WF_SATA_WTRM primitive
WF_SATA_X_RDY primitive
WF_OPEN_ACCEPT primitive
WF_OPEN_REJECT_ primitive
BAD_DESTINATION
WF_OPEN_REJECT_ primitive
CONN_RATE_NOT_

SUPPORTED

WF_OPEN_REJECT_ primitive
NO_DESTINATION
WF_OPEN_REJECT_ primitive
PATHWAY_BLOCKED
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WaitCommand Name Description

WF_OPEN_REJECT_ primitive
PROTOCOL_NOT_
SUPPORTED
WF_OPEN_REJECT_ primitive
RETRY
WF_OPEN_REJECT _ primitive
STP_RESOURCES_BUSY
WF_OPEN_REJECT_ primitive
WRONG_DESTINATION
WF_OPEN_REJECT_ primitive
RESERVED_ABANDON_0
WF_OPEN_REJECT_ primitive
RESERVED_ABANDON_1
WF_OPEN_REJECT_ primitive
RESERVED_ABANDON_2
WF_OPEN_REJECT_ primitive
RESERVED_ABANDON_3
WF_OPEN_REJECT_ primitive
RESERVED_CONTINUE_O
WF_OPEN_REJECT_ primitive
RESERVED_CONTINUE_1
WF_OPEN_REJECT_ primitive
RESERVED_INITIALIZE_O
WF_OPEN_REJECT_ primitive
RESERVED_INITIALIZE_1
WF_OPEN_REJECT _ primitive
RESERVED_STOP_0
WF_OPEN_REJECT_ primitive
RESERVED_STOP_1
WF_ALIGN_0 primitive
WF_ALIGN_1 primitive
WF_ALIGN_2 primitive
WF_ALIGN_3 primitive
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WaitCommand Name Description

WF_NOTIFY_ENABLE_ primitive
SPINUP

WF_NOTIFY_RESERVED_0| primitive

WF_NOTIFY_RESERVED_1| primitive

WF_NOTIFY_RESERVED_2| primitive

WF_BROADCAST _ primitive
CHANGE

WF_BROADCAST _ primitive
RESERVED 0

WF_BROADCAST_ primitive
RESERVED _1

WF_BROADCAST _ primitive
RESERVED_2

WF_BROADCAST _ primitive
RESERVED_3

WF_BROADCAST_ primitive
RESERVED_4

WF_BROADCAST _ primitive

RESERVED_CHANGE_0

WF_BROADCAST_ primitive
RESERVED_CHANGE_1

WF_BLOCK2_MISC _ reserved
RESERVED_0
WF_BLOCK2_MISC_ reserved
RESERVED_1
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Wait
Command
Groups

Wait Command Group

Group Contents

WF_TIMEOUT

WF_TIMEOUT_BLOCK_ONE
WF_TIMEOUT_BLOCK_TWO

WF_ALL_SOF

WF_SOF

WF_SOAF

WF_ALL_EOF

WF_EOF

WF_SOAF

WF_NAK

WF_NAK_CRC_ERROR

WF_NAK_RESERVED_0

WF_NAK_RESERVED_1

WF_NAK_RESERVED_2

WF_RRDY

WF_RRDY_NORMAL

WF_RRDY_RESERVED 0

WF_RRDY_RESERVED_1

WF_CREDIT_OK

WF_CREDIT_AVAIL

WF_CREDIT_BLOCKED_RECEIVED

WF_CLOSE

WF_CLOSE_CLEAR_AFFILIATION

WF_CLOSE_NORMAL

WF_CLOSE_RESERVED_0

WF_CLOSE_RESERVED _1
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Wait Command Group

Group Contents

WF_DONE

WF_DONE_ACK_NAK_TIMEOUT

WF_DONE_CREDIT_TIMEOUT

WF_DONE_NORMAL

WF_DONE_RESERVED_0

WF_DONE_RESERVED_1

WF_DONE_RESERVED_TIMEOUT_0

WF_DONE_RESERVED_TIMEOUT _1

WF_AIP

WF_AIP_NORMAL

WF_AIP_RESERVED 0

WF_AIP_RESERVED_1

WF_AIP_RESERVED 2

WF_AIP_RESERVED_ WAIT_ON_PART

WF_AIP_WAIT_ON_CONN

WF_AIP_WAIT_ON_DEVICE

WF_AIP_WAIT_ON_PARTIAL

WF_REC_RESOURCES

WF_REC_RESOURCES_OUTPUT_A

WF_REC_RESOURCES_OUTPUT_B

WF_REC_RESOURCES_OUTPUT_C

WF_REC_RESOURCES_OUTPUT_D

WF_REC_RESOURCES_OUTPUT E

WF_REC_RESOURCES_OUTPUT_F

WF_RCV_STATUS

WF_SATA_R_ERR

WF_SATA R_OK

WF_PM_REQ

WF_SATA_PMREQ_P

WF_SATA_PMREQ_S
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Wait Command Group Group Contents

WF_PM_STATUS WF_SATA_PMACK

WF_SATA_PMNAK

WF_OPEN_REJECT WF_OPEN_REJECT_BAD_DESTINATION
WF_OPEN_REJECT_CONN_RATE_NOT_SUPPORTED
WF_OPEN_REJECT_NO_DESTINATION
WF_OPEN_REJECT_PATHWAY_ BLOCKED
WF_OPEN_REJECT _PROTOCOL_NOT_SUPPORTED
WF_OPEN_REJECT_RETRY
WF_OPEN_REJECT_STP_RESOURCES_BUSY
WF_OPEN_REJECT _WRONG_DESTINATION
WF_OPEN_REJECT _RESERVED_ABANDON_0
WF_OPEN_REJECT_RESERVED_ABANDON_1

WF_OPEN_REJECT WF_OPEN_REJECT_RESERVED_ABANDON_2
(continued...) WF_OPEN_REJECT _RESERVED ABANDON 3
WF_OPEN_REJECT_RESERVED_CONTINUE_0
WF_OPEN_REJECT_RESERVED_CONTINUE_1
WF_OPEN_REJECT_RESERVED_INITIALIZE_O
WF_OPEN_REJECT_RESERVED_INITIALIZE_1
WF_OPEN_REJECT_RESERVED_STOP_0
WF_OPEN_REJECT_RESERVED_STOP_1

WF_OPEN_RESPONSE | WF_OPEN_ACCEPT
WF_OPEN_REJECT

WF_ALIGN WF_ALIGN_0
WF_ALIGN_1
WF_ALIGN_2
WF_ALIGN_3
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Wait Command Group Group Contents

WF_NOTIFY WF_NOTIFY_ENABLE_SPINUP
WF_NOTIFY_RESERVED 0
WF_NOTIFY_RESERVED_1
WF_NOTIFY_RESERVED 2

WF_BROADCAST WF_BROADCAST_CHANGE
WF_BROADCAST RESERVED 0
WF_BROADCAST RESERVED _1
WF_BROADCAST RESERVED 2
WF_BROADCAST RESERVED 3
WF_BROADCAST RESERVED 4
WF_BROADCAST RESERVED CHANGE_0
WF_BROADCAST RESERVED CHANGE_1
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Predefined

Constants

Predefined Constant Internal Value

GEN_MODE_ERROR 0
GEN_MODE_SATA HOST 1
GEN_MODE_SATA DEVICE 2
GEN_MODE_SAS_INITIATOR 3
GEN_MODE_SAS TARGET 4
GEN_LINK_SPEED_1 5G 0
GEN_LINK_SPEED_3G 1
SCRAMBLING_MODE_NONE 0
SCRAMBLING_MODE_SAS 1
SCRAMBLING_MODE_SATA 2
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Generation
Settings

Setting

Default
Value

Description

Global Settings

GenerationMode

>>>>>

Generation Mode - must be defined or no
generation will take place. Possible Values:
GEN_MODE_SATA HOST
GEN_MODE_SATA DEVICE
GEN_MODE_SAS_INITIATOR
GEN_MODE_SAS TARGET

Default Value: GEN_MODE_ERROR -
undefined mode

SSC

Spread Spectrum Clocking mode for SATA.
Can only be set outside Generation block.

MultiSpeedMode

When set, the change of speed within
Generation block is allowed with following
syntax: set Speed = LINK_SPEED_1_5G/
LINK_SPEED_3G.

Output Disable

This very poorly named register bit forces the
Trainer to output data. It is a little like the
output_on script command except that its
effect cannot be undone for the duration of the
script. If this is turned on, none of the
out-of-band commands will work, as the output
enable is forced on.

AutoMode Settings

AutoOOBMode

When set, the generator will go through the
stages of bringing up the link automatically,
including waiting for and responding to the

device or host it is connected to.

AutoHoldMode

When set, the generator will respond
automatically to Hold requests. Not supported
for version 1.1 (reserved).

AutoDMAT

When set, the generator will respond
automatically to DMAT requests. Not
supported for version 1.1 (reserved).

AutoHandshake

When set, the generator will respond
automatically to TBD commands. Not
supported for version 1.1 (reserved).
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Setting

Default
Value

Description

AutoSpeedNeg

0

When set, the generator will automatically go
throughthe speed negotiation process, for the
speed set in the PINTERFACEC_SERDES
register for the Trainer.

AutoAlignSATA

When set, the generator will automatically
inserting the stream 2 Align(0) primitives every
254 dwords, as specified in the SATA spec.

AutoAlignSAS

When set, the generator will automatically
inserting the stream Align primitives every
2048 dwords, as specified in the SAS
spec.Two Align modes can be turned on
simultaneously, to support STP

COMINIT Settings

COMINIT_NegLen

800

The number of bursts to send as part of this
OOB type.Each Burst is followed by an Idle.
The Burst-Idle pairs are repeated the
requested number of times, and then followed
by the Negation_length of Idle.

COMINIT_IdleLen

480

Burst time between each OOB idle in
OOBIs.During the specified period, the
generator will send ALIGN(0) at the specified
speed.

COMINIT_BurstLen

160

Idle time between each OOB burst in
OOBIs.During the specified period, the
generator will keep the line at electric idle.

COMINIT_NumBursts

Negation time at the end of the OOB signal in
OOBIs.During the specified period, the
generator will keep the line at electric idle.
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Setting

Default
Value

Description

COMWAKE Settings

COMWAKE_NegLen

280

The number of bursts to send as part of this
OOB type.Each Burst is followed by an Idle.
The Burst-ldle pairs are repeated the
requested number of times, and then followed
by the Negation_length of Idle.

COMWAKE_IdleLen

160

Burst time between each OOB idle in
OOBIs.During the specified period, the
generator will send ALIGN(0) at the specified
speed.

COMWAKE_BurstLen

160

Idle time between each OOB burst in
OOBIs.During the specified period, the
generator will keep the line at electric idle.

COMWAKE_NumBursts

Negation time at the end of the OOB signal in
OOBIs.During the specified period, the
generator will keep the line at electric idle.

COMSAS Settings

COMSAS_Neglen

2400

The number of bursts to send as part of this
OOB type.Each Burst is followed by an Idle.
The Burst-ldle pairs are repeated the
requested number of times, and then followed
by the Negation_length of Idle.

COMSAS _IdleLen

1440

Burst time between each OOB idle in
OOBIs.During the specified period, the
generator will send ALIGN(0) at the specified
speed.

COMSAS_BurstLen

160

Idle time between each OOB burst in
OOBIs.During the specified period, the
generator will keep the line at electric idle.

COMSAS_NumBursts

Negation time at the end of the OOB signal in
OOBIs.During the specified period, the
generator will keep the line at electric idle.
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Default
Setting Value Description

SATA Link Init Settings

OOB_SATA D102_Time 100000 D10.2 time for SATA link synchronization in
OOBIs.During the specified period, the
generator will transmit D10.2 symbols.

OOB_SATA_Align_Time 100000 ALIGN(0) time for SATA link synchronization in
OOBIs.During the specified period, the
generator will transmit ALIGN(Q) primitives.

SAS Speed Negotiation Settings

OOB_SAS_Align1_Time 81920 ALIGN(1) time for SAS speed negotiation in
OOBIs.During the specified period, the
generator will transmit ALIGN(1) primitives.

OOB_SAS_Align0_Time 81920 ALIGN(0) time for SAS speed negotiation in
OOBIs.During the specified period, the
generator will transmit ALIGN(Q) primitives.

OOB_SAS _Interspeed 750000 Interspeed time for SAS speed negotiation in

Time OOBIs.During the specified period, the
generator will keep the line at electric idle.

SATA Speed Negotiation Settings

OOB_SpeedNeg RCDT 750000 Maximum time in OOBIs during the speed
negotiation window for a transmitter to reply
with ALIGN(1).

OOB_SpeedNeg_SNTT 163840 Time in OOBIs during which ALIGN(0) or
ALIGN(1) is transmitted at each physical link
rate during the speed negotiation sequence.

OOB_SpeedNeg_SNLT 153600 Time in OOBIs during which the transmitter
shall transmit idle between rates during speed
negotiation.

Speed Settings

Speed >>>>> Link Speed Possible Values:
LINK_SPEED_1_5G LINK_SPEED_3G
Default Value: LINK_SPEED 1 5G

RateMatching 0 When set, the generator will automatically
inserting the stream Align(0) primitive after
every dword.
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Setting

Default
Value

Description

Scrambling Mode Settings

ScramblingMode

>>>>>

Raw Data Scrambling Mode - Only those raw
dwords will be scrambled that contain only
data bytes (no 10bit symbols or 'K' bytes.
Scrambling is reset by changing
ScramblingMode or by any valid SAS or SATA
frame. Possible Values:
SCRAMBLING_MODE_NONE
SCRAMBLING_MODE_SAS
SCRAMBLING_MODE_SATA Default Value:
SCRAMBLING_MODE_NONE

Wait Timeout Settings

WaitTimeout

1000

Sets global WaitTimeout value in
microseconds

AUTO_WAIT_SAS_AFTER Settings

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR

AFTER _ CLOSE command immediately after each

CLOSE_FOR_CLOSE CLOSE primitive.

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR

AFTER_EOF_FOR_ACK ACK command immediately after each EOF
primitive.

AUTO_WAIT_SAS _ FALSE When set, the generator will insert WAIT_FOR

AFTER_EOF_FOR _ ACK or NAK command immediately after each

ACK_OR_NAK EOF primitive.

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR

AFTER_OPEN_FOR _ OPEN_ACCEPT command immediately after

OPEN_ACCEPT each Open Address Frame.

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR

AFTER_OPEN_FOR _ OPEN_REJECT command immediately after

OPEN_REJECT each Open Address Frame.

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR

AFTER_IDENTIFY_ Identify Frame command immediately after

FOR_IDENTIFY_ each ldentify Address Frame.

FRAME

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR

AFTER_SMP_REQ_
FOR_RESP

SMP Response Frame command immediately
after each SMP Request Frame.
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Default
Setting Value Description

AUTO_WAIT_SAS_BEFORE Settings

AUTO_WAIT_SAS _ FALSE When set, the generator will insert WAIT_FOR
BEFORE_ CLOSE command right before each CLOSE
CLOSE_FOR_CLOSE primitive.

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR
BEFORE_ CREDIT command right before each SOF
SOF_FOR_CREDIT primitive.

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR
BEFORE_ Identify Frame command right before each
IDENTIFY_FOR _ Identify Address Frame.

IDENTIFY_FRAME

AUTO_WAIT_SAS _ FALSE When set, the generator will insert WAIT_FOR
BEFORE_OPEN_ Open Frame command right before each
ACCEPT_FOR_OPEN OPEN_ACCEPT primitive.
AUTO_WAIT_SAS_ FALSE When set, the generator will insert WAIT_FOR
BEFORE_OPEN_ Open Frame command right before each
REJECT_FOR_OPEN OPEN_REJECT primitive.

AUTO_WAIT_SAS FALSE When set, the generator will insert WAIT_FOR
BEFORE_AIP_FOR_ Open Frame command right before each
OPEN primitive of AIP group.

AUTO_WAIT_SAS _ FALSE When set, the generator will insert WAIT_FOR
BEFORE_ SMP Request Frame command right before
SMP_RESP_FOR_REQ each SMP Response Frame.

AUTO_WAIT_SATA_AFTER Settings

AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR
AFTER_X RDY_FOR _ SATA R _RDY command immediately after
R_RDY each case of SATA_CONT primitive following
SATA X RDY primitive.
AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR
AFTER _ SATA_R_ERR or SATA_R_OK command
WTRM_FOR_STATUS immediately after each case of SATA_CONT
primitive following SATA_WTRM primitive.
AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR
AFTER_PMREQ_S SATA_PMACK or SATA_PMNAK command
FOR_RESPONSE immediately after each case of SATA_CONT

primitive following SATA_PMREQ_S primitive.

250 LeCroy Corporation



SASSuite User Manual

Version 6.25

Default
Setting Value Description
AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR
AFTER_PMREQ_P_ SATA_PMACK or SATA_PMNAK command
FOR_RESPONSE immediately after each case of SATA_CONT
primitive following SATA_PMREQ_P primitive.
AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR

AFTER_
SYNC_FOR_SYNC

SATA_SYNC command immediately after
each case of SATA_CONT primitive following
SATA_SYNC primitive.

AUTO_WAIT_SATA_BEFORE Setting

7]

AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR

BEFORE_ SATA_PMREQ_S or SATA_PMREQ_P

PMACK_FOR_PMREQ command right before each SATA_PMACK
primitive.

AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR

BEFORE_ SATA_PMREQ_S or SATA_PMREQ_P

PMNAK_FOR_PMREQ command right before each SATA_ PMNAK
primitive.

AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR

BEFORE_ SATA_R_ERR command right before each

RERR_FOR_WTRM SATA_WTRM primitive.

AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR

BEFORE_ SATA_R_OK command right before each

ROK_FOR_WTRM SATA_WTRM primitive.

AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR

BEFORE_RIP_FOR _ SATA_R_IP command right before each

SOF SATA_SOF primitive.

AUTO_WAIT_SATA _ FALSE When set, the generator will insert WAIT_FOR

BEFORE_
R_RDY_FOR_X_RDY

SATA_ X RDY command right before each
SATA_R_RDY primitive.
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Setting Complex "Wait For" Conditions

The Generation Options dialog lets users define complex "Wait For" events and assign a
letter value ("A" through "F") to the definition so that you can refer to the definition by letter
instead of by textual name.

Once a letter value has been assigned to an event, the letter is referred to in your
generation script using the following command syntax:

Wait_For {WF_REC_RESOURCES_OUTPUT_A}
where "A," in this case, is the defined condition.

Setting To set a complex condition, open the Generation Options dialog:
Cf)t?‘(:lﬁfns Step 1 Select Generate > Generation Options from the menu. The
g:—:-nerat'on Generation Options dialog opens. The Generation Options
. ! dialog looks very similar to the Recording Rules dialog:
O pt ions Generation Options x|
Dialog Generalion Rulss |
@heweren: |0 | @| Q]| | Configis valid_|
Available Events
Save. | SaveAsDelaultI Load. | Cancel
Step 2 Click the New Events button and select an event from the menu.
The selected event should appear in the Available Events area
along the left side of the dialog box.
Step 3 Drag the new event button to the Global State cell.
252 LeCroy Corporation



SASSuite User Manual Version 6.25

Step 4 Right-click on the new event button and select Specify Action(s). A
menu appears showing the letters A through F and the option "No

H "
action.
Bceneraton ooons x
| Generation Rules |
| oreween M[o|c|alalm &
i Available Events
| Glohal State (active at all times)
| Prirnitive MO ACTION
! Mave Ewent Ta L3 B
| Copy Event To » <
- D

B Delete This Event .
| Properties... F
i Mo Action
| | Click ta Select. Right-Click for menu, Double-Click for Properties
| Save I Save As Default | Load I Canesl

Step 5 Select a letter from the menu. Global State (active at all times)

The menu closes. The event

button should now point to a

neighboring button that has the
letter value you assigned.

Step 6 Once the condition has been defined, you can then add the Wait
For command line (with whatever letter you assigned) to your
script. For example:

Wait_For {WF_REC_RESOURCES_OUTPUT_A}
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Chapter 14: SASTracker Systems

The SASTracker Command Analyzer option for SAS Tracer systems is designed to track
commands in a SAS or SATA network that can involve up to 8 initiators and up to 128
targets. Within this matrix, SAS Tracker will track all commands issued and completed,
included queue depths up to the full 16 bit depth provided for in the SAS specification.

Product Configurations

SAS Tracker capability is supported on the same hardware modules that support
SASTracer systems (see “Analyzer Hardware Description” on page 7). Running the
SATracer option uses a different BusEngine and cannot operate simultaneously with
SAS Tracer on the same CATC 10K system. A simple menu selection converts back and
forth between the two capabilities.

Theory of Operation

The SASTracker Command Analyzer option monitors traffic and identifies all new
commands issued and command completions sent in an active SAS/SATA environment.
Every command issued is tracked, and when any command exceeds a user-defined
timeout (which can vary based on command type), the system triggers and provides a
Command Log File of up to the last 8 million commands issued.

SAS Tracker monitors live traffic in a SAS or SATA network, and each time a command is
issued SAS Tracker records information on that command and begins to track that
command to determine when it is completed, how it is completed, and to trigger on any
command that fails to complete within user-defined timeout periods.

The Command Log File generated by SAS Tracker will contain information about every
command initiated and completed during the session. In addition, the Command Log File
will contain "command fragments" of two types:

Incompletes: Command Start Events that were not completed during the recording
session. These may include commands which exceeded the
user-defined timeout, or simply commands that were issued near the
end of the recording and did not have time to complete before
recording was stopped.

Orphans: Command End Events that do not correspond to any issued command
thatis presentin the recording. Called "orphans", these typically occur
when recording is started during live traffic, resulting in command
completions being observed for commands that were issued prior to
the start of recording. Orphans also occur in recordings that "wrap",
where the available memory space has been exceeded and the user
has specified that the recording should continue until a trigger
condition is encountered.

For command timeout purposes, the SAS Tracker Analyzer actively tracks all commands
which have been issued, but for which no Command End Event has yet occurred. Once
a Command End Event that terminates that command has occurred, the command is no
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longer actively tracked, but the information on that command will still be present in the
Command Log File (provided the Command Log File does not wrap and overwrite the
data).

Note that Command End Events may not all be successful command completions.
Events such as CHECK_CONDITION result in termination of a command in a way
consistent with the SCSI protocol, and will result in the command being terminated
without generating a timeout trigger condition.

When a trigger condition is reached (or when the desired recording size is reached when
in "snapshot" mode), the recording will stop and the Command Log File will be available
for viewing.

Note: Catastrophic events such as Bus Resets which result in all
commands being terminated are not supported by SASTracker.

Installing the SAS Tracker Command Analyzer

The SASTracker Command Analyzer option is installed and connected to systems in
exactly the same way as the SASTracer Protocol Analyzer (see “Installation” on page 7).
Both systems reside in the traffic pathway on a SAS/SATA link.

If not already installed, the SASSuite software should be installed on the host PC as
described in “Installing the SASSuite Software” on page 17.

Changing If the system is being operated as both a SAS Tracer Protocol Analyzer and a SAS Tracker

the Command Analyzer, the BusEngine will need to be changed each time the unit is

BusEngine converted between the two functions. As noted previously, the same hardware can
support both functions, but the two functions cannot coexist at the same time. If both
tracing and tracking are required simultaneously, two separate CATC 10K platforms must
be used.

To check which BusEngine is currently loaded, select the About... option from the Help
menu.

To switch from one BusEngine to the other, select the Switch ... to ... option under the
Setup menu. This option will display whenever a SAS Trainer or SAS Tracker System is
connected to the host PC. If multiple systems are connected, a selection will show for
each connected analyzer. Make sure that the analyzer you wish to update is connected
to the host PC and is turned on.
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J File | Setup Record  Gemerate  Tracker  Miew T

=

@«

Display Optians. ..

Recarding Options. ..

=E =t 5

Tracker Options. ..

Update BEJFW...
Probe Contral. ..

Channel Settings

Analyzer Metwork, ..

! Al Connected Devices. ..

racker SkA00 ko SASTracer

Once selected, a screen will appear asking you to confirm the choice. Select "Yes".

Would vou like to proceed with automatic update?

Yes Mo

@ Switching SA5Tracker device (SM:E00) ko 58S Tracer mode requires updating of Bus Enaine.

]

A progress bar will show the progress of the update.

Updating Analyzer Device...

SASTracker SH:E00
IIpdating BusEngine. ..

= I

When the update completes, the analyzer will be restarted and a screen will appear

confirming the update process. Click on "OK".

X

@ BusEngine for 3A3Tracker ShiE00 updated successhulky
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Preparing to Track a Command Sequence

Before starting to track commands with the SAS Tracker Command Analyzer, you should
first set up the recording options by selecting Tracker Options under the Tracker menu
(or under the Setup Menu--but do not use "Recording Options", that selection applies to
SASTracer only).

|Tra_|:kﬂr Wiewe Tools  Help

@ Skart Tracking

|§Ei Shop Tracking

Note: If you have more than one SAS Tracker System attached, you will
see a submenu allowing you to choose whether to set the Tracker
Options for all systems, or for a specific system only.

| Tracker Wiew Tools  Help
Ef start Tracking E E!: [g] e il

[EIOENCIRI

[ﬂﬂ all Devices. ..

|§Ei Shop Tracking

Sa5Tracker SK:E01

Note: In this and the following sections, the menu selections available in
the Tracker menu are also available as icons in the Tracker Toolbar,
as follows:

Tracker Buttons

Tracker Options (if multiple
SASTracker systems are
connected, this button is used for
"All Devices" by default).

]
o=

= Start Tracking

lEEi Stop Tracking
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Selecting the Tracker Options menu selection brings up the following screen:

Tracker Options - All devices x|

General Tracker Options | Channel Settingsl Advanced Dptinnsl

— Tracking Type — Mizcellaneousz Options
) Shapshat
e Tere [T Beep'when Trigger Ocours
£+ Timeout Trigger
— Tracker fuchive Memomny Size
8.000 ME
1 "‘bl' 1 1 1 1 1 1 1
o
— Time Out Triggerning Optionz
¥ SSP Read: | 250 |Microsecs (064.587.718] 7|
¥ S5P wiite: | 250 |Micrasecs (064587.718] ¥ |
v S5P Other: |25|:| IMichsecs [0-64.537.713) j
¥ SATA Read: | 250 |Microsecs (064.587.718] 7|
v SATA Wiite: IEEEI IMin::rn:nse::s [0-B4 5E87.718) j
[ SATA Other: | 250 |Micrasecs (064587.718] 7|
¥ ShP: |250 |Microsecs (064.587.718) x|
— Optionz Mame —— Command Log Filename & Path
IDefauIt |7|::"'.F'r|:|gram FilesiLelCropk5.. Mdata, shik Browse... |
Save... | Save Az Default | Load... | | ] I Cancel |
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Tracking
Type

Misc.
Options

Tracker
Archive
Memory
Size

Time Out
Triggering
Options

There are two types of tracking, differentiated by the way the recording is terminated, as
listed below.

* Manual Trigger: In this mode, recording continues until Stop Tracking is
selected in the Tracker menu. If the recording memory (defined in the
Tracker Archive Memory Size selection) is exceeded, the recording wraps
and recording continues, overwriting the oldest contents of the recording
memory. The recording will continue to wrap (multiple times if necessary)
until the manual trigger is pressed or recording is otherwise stopped.

¢ Timeout Trigger: In this mode, recording normally continues until one of the
commands issued fails to complete within the user-defined Trigger Timeout
period. In this mode, recording can also be stopped by using the Stop
Tracking selection in the Tracker menu.

Under Miscellaneous Options, there is an option for the SAS Tracker to provide a beep
to alert the user when a trigger occurs.

Under Tracker Archive Memory Size, the user may decide how large a recording file to
generate by specifying the maximum file size in MB. The maximum value for this setting
is roughly 1024 MB (1 GB). This setting affects when recording is terminated while using
snapshot mode, and affects when recording wraps when using either trigger mode. Each
1MB of recording memory represents information on approximately 10,000 completed
commands.

Under Time Out Triggering Options, the user may specify the trigger timeout to use with
each of seven command classes. This value in each class may vary from 0 to 32
seconds, and can be specified in integer units of seconds, milliseconds, microseconds or
nanoseconds. Very small values are likely to result in almost immediate termination of
the recording when Timeout Trigger mode is selected.

The seven command classes are as follows:
* SSP Read
* SSP Write
® SSP Other (any SSP command other than Read or Write)
¢ SATA Read
*  SATA Write
* SATA Other (any SATA command other than Read or Write)
* SMP

Any of the seven command classes can be included as a trigger condition by selecting
the checkbox to the left of the command class. Each selected command class is treated
as a trigger condition such that any command timeout violation in any selected class will
result in the system triggering.

For example, the user may specify that SSP Read commands that fail to complete within
100 microseconds are a trigger condition, but that SSP Write commands are allowed 1
second to complete. This allows the user to "fine tune" the trigger conditions to focus on
specific command classes.

When the system triggers, tracking is stopped and the user is informed that a trigger has
occurred.
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Command Under Command Log Filename & Path, the user can define the name of the file to be

Log used for storing the recording when completed.

Filename

Saving When a specified set of Tracker Options has been established, the conditions may be
Tracker saved by giving the options a name (under Options Name) and then choosing "Save..."
Option or "Save as Default". A previously saved set of options can be reloaded by selecting the
Settings "Load..." button.

By selecting the "Channel Settings" tab, the following options are displayed:

Tracker Options - All devices x|
General Tracker Options  Channel Settings |.-“-‘-.|:I'-.fan|:ed I:Iptil:unsl
— Speed Settings
Lirks
1 2 3 4
Auta Detect Link Rate o+ (G O v
156G/ Link Rate [ [ i
300G/ Link Rate - . [
— Channel Seftings
Charnnels
1 T1 2 T2 12 T3 4 T4
Inhibit rr ¥ v VIV
Speed The SASTracker system supports Autodetect Link Rate which is designed to pass
Settings through the speed negotiation signaling allowing the initiator and device to determine the

link speed using the method defined in the SAS specification. In general, this is the most
convenient setting to use because it ensures the traffic will get recorded at the negotiated
rate. Alternatively, users may force the analyzer to record at the 1.5G or 3G rate.
However, if the negotiated link speed is higher or lower than the speed selected in this
tab, SASTracker will not decode the traffic properly. The user will know if devices are
negotiating successfully by getting clean recordings.
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Channel
Settings

Tracker
Sweeping

These options allow you to inhibit recording on a channel by channel basis.

Inhibit - Inhibits recording of traffic from selected channels. For example, if you check
the option for T1, it means "record all channels except for Target channel 1 (T1)."

By selecting the "Advanced Options" tab, the following screen is displayed:

Tracker Options - All devices x|

General Tracker Dptiu:unsl Channel Settings  Advanced Options |

|-| Microzecs [0-432]

Tracker Sweeping
’]7 Enable Sweeping

Under Tracker Sweeping, the user may select whether to enable sweeping and the
sweeping interval. "Sweeping" refers to the rate at which SAS Tracker checks for
incomplete commands which have exceeded the timeout trigger period. The SASTracker
BusEngine divides available processing time between the tasks of (a) processing
incoming commands and command terminations, and (b) monitoring for any commands
that have exceeded the trigger timeout period. If the incoming traffic has a large number
of very short commands with little data interspersed, or has a large number of complex
command termination situations where multiple commands are ended with a single
event, more time may be needed for command processing in order to keep up with the
command flow. In such situations, the user can increase the interval of tracker sweeping
to allow a larger portion of processing time to go towards command processing.

Note: If Tracker Sweeping is disabled but the Timeout Trigger mode is
selected, the SAS Tracker system will still trigger when a Command
End Event occurs that exceeds the defined Timeout Trigger value.
However, in this situation the system will not be able to detect a
timeout trigger due to commands that never receive a Command
End Event (i.e., lost commands).
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Viewing Command Log Files

Command Log Files are displayed by SASSuite in a format very similar to trace displays
captured by SASTracer (discussed in “Reading a Recording” on page 135).

A typical SAS Tracker Command Log File is shown below.

JI;J File Setup Record Generate Tracker Report  Search  Miew  Tools  Window  Help
|SHE |[PHE| o m L[5 (wt|f|[faressing i [@@ | &R
" 3 ChWD Start Initiator 545 Address
10120 415730 G B.277 ps 0x000000a0 00345678 9ABCDEFOD
T1 3 CMD Complete
10120 422 007 G 11.948 ps Ox0000000 GOoD
" 3 ChWD Start Initiator 545 Address
10120 433 925 G B.277 ps Dx0000001 00345678 9ABCDEFOD
T1 3 CMD Complete
10120 440 232 G 11.858 ps Ox0000001 GOoD
" 3 ChWD Start Initiator 545 Address
10,120 452 090 G B.572 ps 0x0000002 00345678 9ABCDEFOD
T1 3 CMD Complete
10120 453 BRZ G 11.563 ps Ox0000002 GOoD
1 3 A0 = Initiator 545 Address
10120 470 225 G B.280 ps 0x0000003 00345678 9ABCDEFOD
T1 3 CMD Complete
10120 475 505 G 11.945 ps Ox0000003 GOoD

In this file, we can see a simple set of events (commands and completions) taking place
between one initiator and one target device. The value under the "CMD START" and
"CMD COMPLETE" headings is the Command ID which is assigned by SAS Tracker
(when the command is first issued) as a unique ID number for that particular command.

A more useful way to view this file (and many other SAS Tracker Command Log Files) is
to select the transaction-oriented view by selecting Transport Layer under the View
menu. The resulting view is as follows:
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E File  Setup Record Generate  Tracker Report Zearch Wiew  Tools  Window  Help
=

HE[PEE e m L[5 wt|fhmmsunmgo|aaz

" 3 || Compl Tirme COMMAND Initiz
10,120 415730 € 5,395 ps 18.225 ps Q0000000 o034

1 3 [ Compl Time COMMAND ssp Initia
10.120 433 955 €} 5.398 ps 18.135 ps 0x0000001 = o034

" 3 || Compl Time COMMMAND Initiator SAS Address
10.120 452 050 € B.572 s Ox0000002 00345678 9ABCDEFD

ChWD Start [nitiator 545 A

3 m
10.120 452 090 G B.572 ps 0x0000002 O0345678_9ABI
T1 3 CMD Complete
10.120 458 BE2 G || 11863 ps 0x0000002 GOOD
Command 3 Compl Tirme COMMAND
10,120 470 225 G || 5.400 ps 18.225 ps

0x0000003
In this view, related events are grouped together as commands, and each command can
be expanded to show the Command Start Event and Command End Event, as has been
shown above in Command 2. To expand (or combine) commands, click on the small
arrow in the upper left corner of the "Command XX" box.

Initia
0034

SSP

When grouped as commands, the command completion time is shown for each
command.

In this display, command fragments (see “Theory of Operation” on page 255) are shown
as individual events that are not grouped into commands. However, if a command has
caused the timeout trigger condition to be violated, that trigger event will be shown as a
command in which the second "event" is a special trigger condition summary. This
situation is illustrated in the following display:

JE File  Setup Record Generate  Tracker Report Zearch Wiew  Tools  Window  Help

|z BE |V e nm LB fal||fefrasuivgie| i@HER6®

m 3 [ Compl Time COMMAND ssp Initia
01:46.604 953 722 5 || 339.863 ps 18.617 ms 0x0012B00 0y 500¢

" 3 || Compl Time COMMAND Initia
01:46.823 571 135 5 || 261.760 ps 512.842 ps 0x0012BD5 500¢

3 [ Compl Time COMMAND . . Initiator 5.

14 SSP [ TIMED DUT | ey
01:46.624 053 977 G || 14.047 ms Ox0012B07 50006260

[t

Event 12 CMD Start
01:46.824 083 977 G || 14047 ms 0x0012B07

ChD Tirmeout
01:46.828 130 910 -13.786 ms Dx0M2BD7

A Command End Event is inserted by the SASTracker System when timeouts are detected
and no Command End Event was recorded.

TIMED QUT
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In this Command Log File, the command initiated in "Event 12" did not complete, and as
a result the system has indicated this by flagging the event as "TIMED OUT". Expanding
the transaction shows the result as "CMD TIMEOUT" to indicate that no command

completion for this event was present in the Command Log File. A Command End Event
is inserted by the SAS Tracker System to indicate that the trigger condition was violated.

A command may complete with an execution time longer than the trigger timeout period,
but before the system has stopped recording. These late commands will have both a
Command Start Event and a Command End Event, but the execution time still exceeds
the trigger timeout. An example of this is shown in the display below:

JI;J File Setup Record Generate  Tracker Repart  Search Wiew  Tools  Window  Help

| HE|pHE o m L5 fat|fferesstisin| @0 @®OGB

m 3 || Compl Time COMMAND Sap Initia
01:46.804 953 722 5 || 339.863 ps 18.617 ms 0x0012B00 = S00C
m 3 || Campl Time COMMAND Initia
01:45.823 571 135 G || 261.760 ps 512.842 ps 0x00126D5 500C
m 3 | |Compl Time COMMAND TIMED OUT Initigtar S
01:46.824 033 977 5| 14.047 ms 0:x0012B07 500065260

ChD Start

01:46.824 053 977 E; 14.047 ms 0x0012B07
T4 3 CMD Complete
01:46.833 130 595 G || -13.786 ms Ox0012B07 00D

This display shows that the Command End Event was recorded, but since the execution
time exceeded the trigger timeout, the command was flagged as "TIMED OUT".

It

4 TIMED QUT

When viewing a large number of commands to determine a timeout violation, use of the
Compact View is helpful. Select Compact from the View menu, or use the Ctrl-Q
keyboard shortcut. The resulting display is shown below.

“;J File Setup Record Generate  Tracker  Report Search Wiew  Tools  Window  Help

=8 E | PHE e b5 (at |y |[farssivg da)| ()@@ @

Campl Time Start - Start COMMAND Initiator £
13:18.610 350 730 3| 3053 ps 84.813 ps 0x0000054 5000628
13:18.610 435 542 3| 3645 ps 517.952 ps 0x0000055 5000628
13:18.611 053 495 3| 2723 ps 84.453 ps 0x0000056 5000628
13:18.611 137 947 3| 3678 ps 121173 ps 0x0000057 5000628
13:18.611 259120 3| 4435 ps 77595 ps 0x0000055 5000628
13:18.611 336 715 3| 4150 ps 121.713 ps 0x0000052 5000628
13:18.611 458 427 3| 4173 ps 77145 ps 0x0000054, 5000628
13:18.611 535 572 3| 4353 ps 120720 ps 0x0000056 5000628
13:18.611 656 292 3| 3498 ps 70.288 ps 0x000005C 5000628
13:18.611 726 580 3| 4518 ps 120.450 ps 00000050 5000628
13:18.611 847 030 3| 3.805ups 240,813 ps 0x000005E 5000628

Sp Start - St D

13:18.612 057 842 3 35571 0x000005F
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Command Log File Reports

As with trace files collected with SAS Tracer, command log files generated by SAS Tracker
have access to reporting capabilities within the SASSuite program.

One of the more useful reports available for SAS Tracker Command Log Files is the "Bus
Utilization" report, which in the case of SASTracker files will show the following:

* The number of pending commands at all times during the period that the
Command Log File was recording. This display is useful to determine the
outstanding commands that existed at any point in time, and to determine
times at which the number of pending commands was larger than usual for
the system.

* The command duration for all completed commands contained within the
command log file, shown against the time they occurred within the recorded
trace. This display highlights commands which were taking unusually long
times to complete, and by having this data aligned with the pending
command data mentioned above, the user can determine whether long
command completion times are related to the number of pending commands,
or due to some other effect.

To display the Bus Utilization report, select the Bus Utilization menu selection in the
Report menu, or click the Bus Utilization button |, in the Analysis toolbar.

The following graphs are displayed in the bottom half of the screen:

Bus LIkilizakion

[ =N==0

VPi:nvl:lini;l Commands, CHI1-T1 ] & Pending Commands, CHIZ-TZ = & Pend... & &
2 i~

& a @i @y

=

160 180 200 220 240 260 z50  Time ()

« | i
|

vl:1:||mm-5|n||:| Duration, CHI1-T1 (£ & Command Duration, CHI2Z-T2 = & Cont... & &

Pending IDs (I0s)

o -
Ea0

m

220

=

E1IZI -
20 :

L 160 150 200 220 240 260 2g0  Time (s)
g 4 | i

The graph display can be customized to focus on areas of particular interest using the
tools provided in the icons at the top of the graph. By double-clicking at any point within
the graph area, the Command Log File display in the top half of the screen will jump to
that section of the file. For more information on manipulating this display, see “Bus
Utilization” on page 176.
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Exporting Command Log Files

As with trace files, Command Log Files from SAS Tracker can be exported for use by
other data analysis programs (such as MicroSoft Excel). The data that is exported
depends, to an extent, on the data displayed on the screen.

In the default SAS Tracker display, the timestamps for each event are combined (for
convenience in reading the log file) with the command number, as shown below.

Comrnand 233 Compl Time
02:24 152 402 752 E; 2.855 ps 52150 ps Ox00000EE

If timestamps are desired in the exported data file, the first step in exporting the data is
to separate the timestamp into its own field. To do this, select Display Options... from
the Setup Menu. Under the "General" tab, change the field marked "Time Stamp
Position" to be "At the beginning”, and click "OK". The display will now appear as follows:

" Comrand Compl Time
38 02:24 152 402 752 2855 ps 52150 ps

In a similar fashion, the user can have some control over the data which is exported by
expanding and/or contracting data files as described in “Expanding and Collapsing
Fields” on page 143.

To export the Command Log File, select Export.. to CSV Format... in the File menu.

File Setup Record Generate  Tracker  Repork  Search Yiew

New GenFile Chrl+h l@ |® | (2 | T | (B) |®

= Open... Chrl+0 Iﬁ,__
s
Close
I saveas... | Cornpl Tirme
~ 02 752 2.855 ps
Print. .. Ckrl+P -
& & _ _ Compl Time
(8 Print Preview £4 902 3645 ps
Prink Setup... ——
Cormpl Time
Edit Comment. .. 28 617 2827 ps
Expork L ko 25 Format. .. F irme
Convert p [oTEOo [T oo s

The next screen will allow you to specify a filename and location for the exported file, and
also to limit the data exported to some portion of the file if only a portion is required.
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Working The file type which is exported from SASSuite is a generic text data file (.csv) which can
with be imported into many applications. In this example, we will use Microsoft Excel, but the
Exported same procedure can be used with many database and spreadsheet applications.

Data Files Once the file has been saved, open Microsoft Excel. Select Open.. from the File menu,

which will bring up a screen allowing you to navigate to the folder in which you saved the
file. (If you have forgotten where you saved the file, go back to the SASSuite program and
select File... Export to CSV Format... again and note which directory and folder contains
the exported file.)

open 21|
Loak in: I[:l Sample Files j = | @ > ﬁf * Tools =

% | dakagsn
e L ——
«panderbootsassataS3006

My Documents

¥4 )sas_timeout_response_late
J ternp_expork
%% |tracker_3HBAxEDrives

File name: I j = Open vI
Files of bype: |Text Files =l cancel |

At the bottom of this screen, under "Files of Type:", select "Text Files". This will produce
a display of all .csv files contained in the folder. Click on the correct file to highlight it,
then click on Open.
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When the file is opened, a large spreadsheet similar the following will appear:

-lolx]

A B C D E F | & | H | 1=

1 |Channel ITransactio Speed Protocol  |Source PoSource SADestinatior Close S5F
2 |13 3 SWP
3 (13 3 5MP
4 |13 3 SWP
5 (12 3 5MP
B |12 3 SWP
712 3 5MP
a2 3 SWP
a2 3 5MP
10 |12 3 SWP
11 (12 3 5MP
12 |12 3 SWP
13 |12 3 5MP
14 |12 3 SWP
15 |12 3 5MP
16 (12 3 SWP

17 |12 3 5MP -

7 '|_|1 iF‘ |HI\e:-:panderhuutsassataSSEl]gnm 14l é

This spreadsheet will have a large number of columns (most of which are blank). This
format is used for all SASSuite data exports, and many of the columns will not have
application to SASTracker data files.

The first row of the spreadsheet contains the titles for each column. Remaining rows
contain information on each completed command that was present in the exported data.

Since there are many blank columns (for data values which are not used in SASTracker
Command Log Files), these columns can be deleted to simplify the spreadsheet. If a very
large number of events has been exported, it may be difficult to be sure that no data exists
anywhere in a column. In such cases, insert an extra row just below the column titles and
enter a formula similar to "=1000 - COUNTBLANK(A3:A1002)", and copy this value
across all columns. In this example (which assumes 1000 exported events), all blank
columns will show "0" as the result of this function and may be deleted. Any column with
data will show the number of cells that contain data in that column.

Some data is exported as text fields which represent numeric values. For example, the
command completion time will be exported as fields such as "234.245 us" or "3.456 ms".
In order to convert these text fields to values which can be sorted and otherwise
manipulated, create a new column next to the "COMPL TIME" column and enter a
formula such as the following into the first data row of the new column:

=IF(P2="",""IF(RIGHT(P2,2)="ms",1000*"VALUE(LEFT(P2,LEN(P2)-3)),
VALUE(LEFT(P2,LEN(P2)-3))))

This formula assumes that the original data value is in cell P2. The formula first checks
to see if P2 contains any data (if not a blank value will be inserted--this is typically the
case for command fragments such as incomplete commands or orphans). If data exists,
the formula determines whether the units used are millisecs ("ms"), in which case it
extracts the numeric value of the cell and multiplies it 1000. If the units are not ms, then
the formula extracts the numeric value as microseconds. The result (for data that
contains only millisec and microsec values), is a column with completion times all in
microseconds.
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Copy this formula down the length of the column, and all original text data is converted
to numeric data expressed in microseconds.

Note: If the data fields contain other units such as seconds or nanseconds,
the formula will need to be modified to account for all units used.

The commands in the file can now be sorted in increasing or decreasing order of
command completion time by selecting all rows containing data, then selecting Sort from
the Data menu in Microsoft Excel. Choose the column which contains the numeric
completion times, and select "Ascending" or "Descending".

Creating a Microsoft Excel and other database and spreadsheet programs often have sophisticated
Histogram statistical functions useful for analyzing the data produced by SAS Tracker. For example,
using it may be useful to have a histogram of command completion times for a Command Log
Microsoft File, to show the range and the pattern of variation of the command completion times. A
Excel histogram is a chart which shows the frequency of occurance of values within a specified
data range, and allows the user to easily see which completion times cluster around
certain values, and which are unusual.
One way to create this chart is to begin by converting all command completion times into
data values as described above. Once this column is created, some basic statistic values
can be determined using Excel formulas, such as the following (in this example, the data
is contained in column Q, rows 2 through 512):
* The number of valid datapoints can be determined by using the formula "=511
- COUNTBLANK(Q2:Q512)"
¢ The maximum value in the range of command completion times can be
determined by the formula "=MAX(Q2:Q512)"
* The minimum value in the range of command completion times can be
determined by the formula "=MIN(Q2:Q512)
Once the minimum and maximum values are known, the histogram can be prepared by
deciding on the "buckets" to be used to collect the data.
An example is shown below. In this example, the measured command completion times
varied from 1.645 microseconds to 36,852 microseconds. Data "buckets" were set up for
the following ranges:
* Lessthan2us
e 2-3us
e 3-5us
* 510us
* 10-100 us
* 100-1,000 us
¢ 1,000-10,000 us
¢ 10,000-50,000 us
These values were entered in cells Q519 through Q526.
To create the histogram, first select all cells which will contain the data, in this case cells
R519 through R526. Type in the following formula:
=FREQUENCY(Q2:Q512,Q0519:Q526)
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but instead of pressing ENTER to enter the formula, press CTRL+SHIFT+ENTER. This
enters this formula into the entire array of cells you selected. The values shown are the
number of datapoint that fall between each "bucket" value.

You can produce a graph of this data by using the Excel Chart Wizard. Select the cells
containing the histogram data. Click on the Chart Wizard icon and follow the instructions.
On the second step, click on the "Series" tab, then on the "Category (X) axis labels:" field,
select the list of "buckets" in Q519 through Q526, and enter them as axis labels.

The result is the graph shown below:

&l expanderbootsassata530068

F Q R s T L b Wy X
1505(2.595 ps 2.595
1505(3.505 ps 3.505
1510(3.675 ps 3.678 300
1511(2.580 ps 258
512(3.603 ps 3.603
m 250
1514 | Datapaints 489
1515 Max 36B52 200
516 (Min 1.645
517 150
1515 Bins Freguency
519 2 2
520 3 o | 1
1521 5 270
1522 10 a a0
1523 100 15
524 1000 72 o
525 10000 25 2 3 5 10 100 1000 10000 50000
1526 50000 4

This graph shows an interesting bimodal distribution in command completion times, with
a large set of commands completing within less than 5 microsecond, and another set of
commands requiring 1-20 milliseconds to complete. By sorting and analyzing this
pattern, the user can more easily understand which commands are resulting in long
completion times and causing performance degradation.
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Chapte

Software,

r 15: Updates and Licensing

From time to time as modifications are made to the SASSuite Analyzer Software, it may
become necessary to update the SASSuite software. You can obtain new software from
the LeCroy website:

www.LeCroy.com

When you download new SASSuite software, firmware and BusEngine files are included
as part of the software package. Occasionally, LeCroy will update these files. The new
files will install automatically following installation of the new analyzer software. If you
prefer, however, you can manually update firmware and BusEngine. This chapter
describes both automatic and manual updates.

Note: LeCroy SAS analyzers include downloads of new SASSuite
software releases that are made available during the 12 months
after purchase. Following that time, software releases are included
when the LeCroy Maintenance Agreement is purchased. Contact
LeCroy for details.

Firmware and BusEngine Versions

The Readme.txt file on the installation CD and on the installed directory on your hard
drive gives last-minute updates about the current release. Included with each release are
the most recent downloadable images of the Firmware and the BusEngine.

Once the SASSuite Analyzer has completed the self diagnostics and is connected to the
PC, you can check the latest version of the software and BusEngine.

To check information about the current software, select
About SASSuite... from the Help menu.

The About SASSuite window appears.

About SASSuite x|

LeCroy SASSuite™
Serial Attached SCSI Suite

Software Version 6,00, Build 212
3 devices connected
Mo remote nodes in analyzer network

Z007 LeCroy Corporation OK I
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About SASSuite details revisions of the following software and hardware:

» SASSuite Software Version, Build Number

» Firmware Version of Analyzer (if connected)

» BusEngine Version, Build Number (if connected)
» Unit Serial Number (if connected)

Note: When contacting LeCroy for technical support, please have available all
the revisions reported in the About SASSuite window.

Software Updates

When a new software release is available, it is posted on the Support page of the LeCroy
website at www.LeCroy.com/support.html.

To update the software, follow these steps:

Step 1 Find the latest released software version on the LeCroy website
under Support.

If you are running the latest version of the software, no further action is
needed.

If you are not running the latest version, continue to Step 3.
Step 2 Download the installer file from the website.

Step 3 Unzip the files into your choice of directory (if required).

Step 4 Click Start, then Run, and browse to where you unzipped the
files.

Step 5 Select the program named Setup and click Open.
Step 6 Click OK to run the Setup and begin the installation.
Step 7 Follow the on-screen instructions to complete the installation.

Step 8 Read the Readme file for important information on changes in
the release.
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Automatic BusEngine and Firmware Updates

Updating
the
BusEngine

Updating
the
Firmware

Automatic
Updates

BusEngine and Firmware updates often need to be performed when you update the
SASSuite software. These updates can be performed automatically or manually. Both
processes are described.

The BusEngine core is the heart of the LeCroy SAS Analyzer. Using FPGA technology,
it incorporates both the high speed recording engine and the configurable building blocks
that implement data/state/error detections, triggering, capture filtering, external signal
monitoring, and event counting and sequencing. Both the BusEngine program and the
Firmware that manages the internal microcontroller are fully field updateable.

Within a new software release, it may be necessary to update the Analyzer’s BusEngine
hardware for proper operation. The Readme file lets you know if this is necessary.

Within a new software release, it may also be necessary to update the Analyzer’s
firmware for proper operation. The Readme file informs you if this is necessary.

When the SASSuite software is updated, the software may become incompatible with the
BusEngine and Firmware. If a recording is attempted, SASSuite displays an error
message and then automatically begins an update process for the BusEngine and
Firmware.

To perform an automatic BusEngine and Firmware update, follow these steps:

Step 1 If needed, update the SASSuite software, following the steps
outlined in "Software Updates."

Step 2 Turn on the Analyzer.
Step 3 Select Start > Record from the menu.

Because the BusEngine and/or the Firmware are incompatible with the
current SAS Suite software version, an error message appears showing
your current versions and indicating what versions you need to install.

SRSTracer Help

& Cannot recard.

The Firrmware and/or Buz Engine on the analyzer iz
incompatible with thiz software release.
Firrmare: Required = 1.02 Actual= 1.02
BusEnaine: Required= 1.22 Actual= 091

Hit ¥ES to update them.

] me |
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Step 4 Click Yes.
The Analyzer Setup window appears.

Update Analyzer x|

~ ¥ Update BusEngine

IE: “WProgram Files\CATCAVSAS Tracer\sastrmbe. bin Browse. ..

~ ¥ Update Fimware

IE:\F‘ngram Files\CATCAVSAS Tracer\sastmiv, hex Browse. .. |

" Update” Cancel |

Step 5 Click Update.

You can select only one item at this point. If both the BusEngine and the
Firmware need to be updated, the update will complete for the first item
and then return to the above window so the second update can be
performed.

Note: Once you have started updating the BusEngine or Firmware, do not
interrupt the update!

When the second update has finished, the following message appears
and tells you that the update is complete.

B x|

@ pdate Complete!

The BuzEngine has been successfully updated!
Flease power the analyzer off and back on
for the update to take effect.

276 LeCroy Corporation



SASSuite User Manual Version 6.25

Step 6 To complete the update, power cycle the SASSuite (turn the unit
off then back on).

If you are running Windows 2000, the Analyzer will automatically
reboot, and the following message will appear:

& Unsafe Removal of Device 21 x|

Y'ou have unplugged or ejected a device without stopping it.
Urplugging or ejecting devices without first ztopping them can
often cauge pour complter to crash and loze valuable data.

T zafely unplug or eject any of the following devices, first uze the Hardware
wizard in the Control Panel to stop the device.

I—NCATC UPAS SASTracer

[f you frequently need to unplug thiz device, Windows can give you an icon
on the tazkbar to quickly unplug or eject your device. If pou would like to use
thiz option, check the fallowing:

¥ Show Unplug/Eject icon on the taskbar,

|5| 2:01 PM |

Step 7 Click OK.

In this instance, you do not need to power cycle the Analyzer (turn off
then back on).

License Information

Licensing information for SASSuite can be viewed by selecting Display License

Information from the Help menu. The License window provides maintenance expiration
for SASSuite.
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Updating the Software License

A current License agreement with LeCroy entitles the analyzer owner to continued
technical support and access to software updates as they are published on the LeCroy
website.

If your license expires, a License Key must be obtained by LeCroy (refer to the contact
information at the back of this manual.)

Once the License Key is obtained, follow these steps to install it:

Step 1 From the Help menu, select Update License. The Update
License dialog appears.

Step 2 Enter the path and filename for the License key or use the Browse button
to navigate to the directory that contains the License Key.

Step 3 Select the *.lic file, and then click Update Device.

Check for Updates

In the application, you can set the software to automatically check for software updates.
Select Help > Check for Updates... to display the Software Update window.

Register Product Information

To register the product online, select Help > Register Product Online.
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Limited Hardware Warranty

How to Contact LeCroy

Type of Service Contact
Call for technical US and 1 (800) 909-2282
support... Canada:

Worldwide: 1(408) 653-1260
Fax your questions... Worldwide: 1 (408) 727-6622
Write a letter... LeCroy

Protocol Solutions Group
Customer Support

3385 Scott Blvd.

Santa Clara, CA 95054

USA
Send e-mail... support@CATC.com
Visit LeCroy’s web site... http://www.lecroy.com/

Limited Hardware Warranty

So long as you or your authorized representative ("you" or

"your"), fully complete and return the registration card mc

provided with the applicable hardware product or peripheral roy
hardware products (each a "Product") within fifteen days of
the date of receipt from LeCroy or one of its authorized
representatives, LeCroy warrants that the Product will be free from defects in materials
and workmanship for a period of three years (the "Warranty Period"). You may also
complete your registration form via the internet by visiting
http://www.lecroy.com/support/register/. The Warranty Period commences on the earlier

of the date of delivery by LeCroy of a Product to a common carrier for shipment to you or
to LeCroy's authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover

This warranty does not cover damage due to external causes including accident, damage
during shipment after delivery to a common carrier by LeCroy, abuse, misuse, problems
with electrical power, including power surges and outages, servicing not authorized by
LeCroy, usage or operation not in accordance with Product instructions, failure to perform
required preventive maintenance, software related problems (whether or not provided by
LeCroy), problems caused by use of accessories, parts or components not supplied by
LeCroy, Products that have been modified or altered by someone other than LeCroy,
Products with missing or altered service tags or serial numbers, and Products for which
LeCroy has not received payment in full.

Coverage During Warranty Period

During the Warranty Period, LeCroy or its authorized representatives will repair or replace
Products, at LeCroy's sole discretion, covered under this limited warranty that are
returned directly to LeCroy's facility or through LeCroy's authorized representatives.
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How to Obtain Warranty Service

To request warranty service, you must complete and return the registration card or
register via the internet within the fifteen day period described above and report your
covered warranty claim by contacting LeCroy Technical Support or its authorized
representative.

LeCroy Technical Support can be reached at 800-909-7112 or via email at
support@catc.com. You may also refer to LeCroy's website at http://www.lecroy.com for
more information on how to contact an authorized representative in your region. If
warranty service is required, LeCroy or its authorized representative will issue a Return
Material Authorization Number. You must ship the Product back to LeCroy or its
authorized representative, in its original or equivalent packaging, prepay shipping
charges, and insure the shipment or accept the risk of loss or damage during shipment.
LeCroy must receive the Product prior to expiration of the Warranty Period for the
repair(s) to be covered. LeCroy or its authorized representative will thereafter ship the
repaired or replacement Product to you freight prepaid by LeCroy if you are located in the
continental United States. Shipments made outside the continental United States will be
sent freight collect.

Please remove any peripheral accessories or parts before you ship the Product. LeCroy
does not accept liability for lost or damaged peripheral accessories, data or software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new and/or
reconditioned parts, at its sole discretion, made by various manufacturers in performing
warranty repairs. If LeCroy repairs or replaces a Product, the Warranty Period for the
Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product returned
or that the returned Product is not eligible for warranty coverage, LeCroy will inform you
of its determination. If you thereafter request LeCroy to repair the Product, such labor
and service shall be performed under the terms and conditions of LeCroy's then current
repair policy. If you chose not to have the Product repaired by LeCroy, you agree to pay
LeCroy for the cost to return the Product to you and that LeCroy may require payment in
advance of shipment.

General Provisions

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE
ADDITIONAL RIGHTS THAT VARY BY JURISDICTION. LECROY'S RESPONSIBILITY
FOR DEFECTS IN MATERIALS AND WORKMANSHIP IS LIMITED TO REPAIR AND
REPLACEMENT AS SET FORTH IN THIS LIMITED WARRANTY STATEMENT.
EXCEPT AS EXPRESSLY STATED IN THIS WARRANTY STATEMENT, LECROY
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY PRODUCT
INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF AND
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, AND ANY WARRANTIES THAT MAY ARISE FROM ANY COURSE OF
DEALING, COURSE OF PERFORMANCE OR TRADE USAGE. SOME
JURISDICTIONS MAY NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH IN
THIS LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT LIMITATION, ANY LIABILITY
FOR THIRD PARTY CLAIMS AGAINST YOU FOR DAMAGES, PRODUCTS NOT
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BEING AVAILABLE FOR USE, OR FOR LOST DATA OR SOFTWARE. LECROY'S
LIABILITY TO YOU MAY NOT EXCEED THE AMOUNT YOU PAID FOR THE
PRODUCT THAT IS THE SUBJECT OF A CLAIM. SOME JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO
YOU.

The limited warranty on a Product may be transferred for the remaining term if the then
current owner transfers ownership of the Product and notifies LeCroy of the transfer. You
may notify LeCroy of the transfer by writing to Technical Support at LeCroy, 3385 Scott
Blvd., Santa Clara, CA 95054 USA or by email at: support@catc.com. Please include
the transferring owner's name and address, the name and address of the new owner, the
date of transfer, and the Product serial number.
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Appendix A: Specifications

Avalanche Systems

Connectors

Indicators

Host Requirements

Recording Memory Size
Power Requirements
Back Panel Connectors

Manual Trigger Switch
Basic Trigger Events

Traffic Summary Reports

Bus Utilization Reports

Two (2) 4-port MiniSAS

Initiator Status (1, 2, 3, 4)
Initiator Speed (1, 2, 3, 4)
Target Status (1, 2, 3, 4)
Target Speed (1, 2, 3, 4)

Trig/Err Right
Rec/Upload Right

Trig/Err Left
Rec/Upload Left

Windows 2000 or gretaer; Intel Pentium Il processor or
greater; USB port

4 GB for trace capture, timing and control information
100-250 VAC, 50-60 Hz (universal input), 480W max

AC Power connection, External trigger connections (TRIG
IN/OUT, SMA), USB type "B" host computer connection,
Breakout Board Data Output Connection

Forces a trigger event when pressed

Primitives, Bus Conditions, FISs, Errors, ATA Commands,
SATA Commands, External Signals, Vendor FIS, Data
Pattern SCSI Operations, SCSI Status, SSP IUs, SMP
Request/Response

Errors, Primitives, FIS, Frames, Transactions, SCSI
Operations, ATA Commands

Pending SCSI I0s, Pending ATA 10s, Response Time,
Latency Time, Throughput, Frame Length, Link
Utilization, Data Throughput, Frames Count

One MiniSAS connector supports up to four initiators, the
second connector supports up to four targets

Green when receiving frame, Mixed Green/Red during
OOB, Red on error

Green for 6 Gb/s, Mixed Green/Yellow for 3 Gb/s, Yellow
for 1.5 Gb/s

Green when receiving frame, Mixed Green/Red during
OOB, Red on error

Green for 6 Gb/s, Mixed Green/Yellow for 3 Gb/s, FYellow
for 1.5 Gb/s

Green when Channel 1 or 2 are triggered, Red on error

Red when Channel 1 or 3 are recording, Green when
uploading

Green when Channel 3 or 4 are triggered, Red on error

Red when Channel 3 or 4 are recording, Green when
uploading
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Physical Dimensions (W x H x D) 29.4 x 6.7 x 23.7 cm (11.6 x 2.6 x 9.3 inches)
g‘\gironmen Net Weight (Chassis) 3.4 Kg (7.5 Ibs)
tal Net Weight (Chassis + PS) 4.3 Kg (9.5 Ibs)

Temperature: Operating 0C to 55C (32F to 131F)

Temperature: Non-operating -20C to 80C (-4F to 176F)

Humidity: Operating 10% to 90% RH (non-condensing)

SASTracer/Trainer Systems

LeCroy SASTracer/ Trainer analyzers are hardware modules that install into the CATC
10K platform. The following specifications describe a combined SAS 10K based system.

Package
Dimensions: CATC 10K: 12.2 x 12.2 x 3.5 inches
(31.1x31.1x8.9cm)
Single-wide Plug-in: 4.5 x 6.7 x 1.3 inches
(11.3x17.0x 3.2 cm)
Double-wide Plug-in: 9.5 x 6.7 x 1.3 inches
(24.1x17.0x 3.2 cm)
Rear Connectors: CATC 10K:
AC power connection
External trigger connection (TRIG IN/OUT, BNC)
PC connection (USB 2.0 Hi-Speed, type "B")
Break-out board (type "D")
Weight: CATC 10K: 9.5 Ibs (4.3 kg)
Single-wide Plug-in: 1 1b 11.4 oz (.77 kg)
Double-wide Plug-in: 3 Ib 3 oz (1.45kg)
Power 90-254VAC, 47-63Hz (universal input), 120W maximum
Require-
ments
Environ-
mental Operating Range: 0 to 40 °C (32 to 104 °F)
Conditions  Storage Range: -20 to 80 °C (-4 to 176 °F)
Humidity: 10 to 90%, non-condensing
Operating Altitude: Up to 6.560 feet (2,000 meters)
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Probing
Character-
istics

Recording
Memory
Size

Host PC
Require-
ments

Switches

LEDs

Model SS002MAA & SS003MAA

Connector Type:

SASTrainer Connection

Type:

Model SS004MAA

Connector Type:

One Port Model - Single Pair of Internal Connectors (Initiator and
Target; Serial ATA Standard)

Two Port Model - Dual Pair of Internal Connectors (Initiator and
Target; Serial ATA Standard)

Four Port Model - Single Pair of Internal Connectors (Initiator and
Target; Serial ATA Standard)

Single Initiator and Target connectors
(for transmission only)

2 pairs SAS External 4 lane Connector:

Non-intrusive tap - samples the signal without re-driving the
differential lines (high value resistors contribute to reduction in
amplitude ~ 15%).

Repeater tap - re-drives the signal at either SAS (high swing) or
SATA (low swing) voltages; does not re-time the signal.

2 GBytes for trace capture, timing and control information.

Operating System:

Power:
Manual Trigger:

CATC 10K:
Status (STATUS):

Recording (REC):
Triggered (TRG):

UPloading (UPLD):

SASTracer Plug-in

Module:
Status (STATUS):

Windows 98SE, Windows 2000, Windows ME or Windows XP

On/off
When pressed, triggers the end of the recording

llluminated when the analyzer is powered on.
llluminates for approximately 25 seconds during

initialization/power up of the CATC 10K base unit. If this LED
blinks following initialization, this is an indication that initialization

failed.
llluminated when the analyzer is actively recording traffic data
llluminated during power-on testing and when the analyzer has

detected a valid trigger condition.
llluminated when the analyzer is uploading its recording memory

to the Host PC for displaying the CATC trace

llluminates when there is traffic on both the host and device
sides. Blinks when there is traffic on one side only.
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Basic SASTracer Trigger Events

Frames:

Primitives:

Errors:

SCSI Operations:

SSP Command, Data, Response, Task, X _RDY and Vendor
Unique, SMP Request, Response, Report, Discover and

Configure;
ACK, CREDIT_BLOCKED, DONE

(ACK/NAK TIMEOUT), NAK, RRDY, SOF, AIP,
BREAK, BROADCAST, CLOSE, OPEN_ACCEPT,

OPEN_REJECT, and more task management functions
Invalid 10b codes, CRC Errors, Running Disparity Errors,

Time-outs, Alignment errors, Code Violation
Pending SCSI 1/0s, SCSI I/0 Response, SCSI I/O Latency,

SCSI I/O Throughput, Frame Length, Data Throughput,
Link Utilization (%), Frame Count

SASTracer Traffic Summary Reports

Data Frames

Primitives

Connects/Disconnects

Errors

SCSI Commands

Read Response (min, max, avg.)
Write Response (min, max, avg.)
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Miscellaneous Information

The following tables are supplied in compliance with China’s Restriction of Hazardous
Substances (China RoHS) requirements:

BEEHEWEHN TE

s B iR FireE EHEE E
EF 1B FE (Fb) (Hg) (Cd) (cr™y (PEB) (PEDE)
PCBAs X 0 X X X X
AR 0 o X o 0 0
zER 0 o X 0 0 0
IR 0 o ) o X X
ERL{E X X X 0 X X
GRS X 0 X o X X
RiFAFEE) 0 0 ) 0 X X
BRI (20 X o X o X X
FLE®E) X 0 X 0 X X
AT IBE BRI AL T () X 0 X 0 0 0
SHERERE () X X X o X X
FE(INE) X 0 X 0 X X
O: FRIEFFSFE SN RTIESFMARRITE P REEHTE SITU6 2006 iRELE HIFEER T T.
X EHIEFEEEEPRZ TR FRE RSP RS BT sIT11363-2006 FrEE FIE EEF .

EFUP (B RATH) EH AT (@) A &% FRAFFM “0ME" SomEnsmugst.

Toxic or Hazardous Substances and Elements
Hexavalent Polybrominated Polybrominated
Lead Mercury Cadmium Chromium Biphenyls Diphenyl Ethers

Part Name (Ph) (Hg) (Cd) (Cr') (PBB) (PBDE)
PCBAs X 8] X X X X
Mechanical Hardware 8] 8] X 8] O [8]

Sheet Metal O O X 8] O 8]
Plastic Parts 0 0 ] 0 X X
Power Supply X X X 8] X X

Power Cord X 0] X O X X
Protective Case (if present) 0 o 8] 0 X X

Cable Assemblies (if present) X O X O X X

Fans (if present) X 0 X ) X X

AC Filter/Fuse Assy (if present) X 8] X 8] O 8]

Ext Power Supply (if present) X X X 8] X X
Probes (if present) X O X 0 X X

O: Indicates that this toxic or hazardous substance contained in all of the homogeneous materials for this part is below the

limit requirement specified in SJ/T11363-2006.
X: Indicates that this toxic or hazardous substance contained in at least one of the homogenous materials used for this part
is above the limit requirement specified in SJ/T11363-2006.

EFUP (Environmental Friendly Use Period) Use Conditions: refer to the environmental conditions stated in the specifications

section of this Manual.
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Index

A

AC Connector 11

Action Pop-up Menu 95

Actions 75

Actions Tab 100, 112

Adding Comments 40

Address Frames Properties Dialog 103
Address FramesDecl.inc 216
Adjusting Timestamps 200
Altering Channel Layout 201
Analyzer Network Chat 202
AND Condition 115

Assigning Actions 113

ATA Application Layer 137

ATA Command Event 69

ATA Commands 101, 108
ATAPI Commands 101, 109
AutoAlign 213

Autodetect Link Rate 50, 87, 261
Avalanche Front Panel 7
Avalanche LED Descriptions 8

Beep Action 76

Beep on Trigger 46, 82

Beep When Trigger Occurs 46, 82

BNC Connectors 11

BNC External Trigger 165

BNC Output Action 76

Branch to Existing State Action 75
Branch to New State Action 76

Breakout Board 7, 10, 110, 165, 168, 170
Breakout Board Input Trigger Event 71
Breakout Board Output Trigger Action 76
Buffer Size 47, 83

Bus Conditions 109

Bus Utilization 35, 176

Bus Utilization Buttons 177

Byte Value in 10b Raw Bits 141

C

Cascaded Multiple Analyzer 192
Cascading 191

CATC 10K Platform 9

Changing Display Levels 135
Changing Field Formats 130
Changing the BusEngine 256
Changing the Color of the Data Fields 37
Channel Names 77

Channel Settings 50, 87, 262
Channels 77, 123

Clear Marker 43

Collapse Data 37

Collapsing Data Fields 143

Color Display Options 129

Command Completion Time 264
Command End Events 255
Command Fragments 255

Command Log File 255, 256, 263, 265
Command Start Events 255
Comments 40

Compact View 149, 265

Complex "Wait For" Conditions 252
Complex Searches 161

Configuring Input Signaling 170
Connected Remotely over an IP Network 191
Connecting Devices 13

Connectors 10

Contact LeCroy 279

Conventional Recording 82, 83
Counters 94, 116

Counting Events 116

CRC Calculations 216

Creating a Traffic Generation File 205
Ctrl-Q Keyboard Shortcut 149
Custom Channel Names 77, 123

Data Block Window 145
Data In/Out Connector 169
Data Output Connector 10
Data Pattern Event 70
Data Payload 144

Decode Buttons 35, 258
Decode Toolbar 36
Descrambling 50, 87
Dimensions 284

Disparity Error 142

Display Options 34, 127, 131, 132, 139
DWORD Display 4, 5

LeCroy Corporation

289



Version 6.25 SASSuite User Manual
E Go to Marker 41, 158
. Go to Trigger 157
Edit Comment 40 Graph Areas Menu 179
Environmental Conditions 284 Graphs 179
Error Event 71
Error Report 35 H
Error Summary 175
Errors Properties Dialog 110 Hardware Description 7
Event Properties Dialog Box 101 Hardware Warranty 279

Event Sequences 117

Event Trigger 46, 82

Events 65

Exerciser Hardware 203

Expand Data 37

Expanders 140, 143

Expanding Data Fields 143

Export 29

Export Options 152

Export Packets to EAS Format 153
Export Packets to Text 153

Export to CSV Format 154

Export to Generator File Format 153
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